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Chapter 1 

Introduction 

Welcome to WebLOAD, the premier performance, scalability, and reliability testing 

solution for internet applications.  

WebLOAD is easy to use and delivers maximum testing performance and value. 

WebLOAD verifies the scalability and integrity of internet applications by generating a 

load composed of Virtual Clients that simulate real-world traffic. Probing Clients let 

you refine the testing process by acting as a single user that measures the performance 

of targeted activities, and provides individual performance statistics of the internet 

application under load. 

This section provides a brief introduction to WebLOAD technical support, including 

both documentation and online support. 

WebLOAD Documentation 

WebLOAD is supplied with the following documentation: 

WebLOAD™ Installation Guide 

Instructions for installing WebLOAD and its add-ons. 

WebLOAD™ IDE User’s Guide 

Instructions for recording, editing, and debugging load test Agendas to be 

executed by WebLOAD to test your Web-based applications. 

WebLOAD™ Console User’s Guide 

A guide to using WebLOAD console, RadView’s load/scalability testing tool to 

easily and efficiently test your Web-based applications. This guide also includes a 

quick start section containing instructions for getting started quickly with 

WebLOAD using the RadView Software test site. 

WebLOAD™ Analytics User’s Guide 

Instructions on how to use WebLOAD Analytics to analyze data and create 

custom, informative reports after running a WebLOAD test session. 
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WebRM™ User’s Guide 

Instructions for managing testing resources with the WebLOAD Resource 

Manager. 

WebLOAD™ Scripting Guide 

Complete information on scripting and editing JavaScript Agendas for use in 

WebLOAD and WebLOAD IDE. 

WebLOAD™ JavaScript Reference Guide 

Complete reference information on all JavaScript objects, variables, and functions 

used in WebLOAD and WebLOAD IDE test Agendas. 

WebLOAD™ Extensibility SDK 

Instructions on how to develop extensions to tailor WebLOAD to specific working 

environments. 

WebLOAD™ Automation Guide 

Instructions for automatically running WebLOAD tests and reports from the 

command line, or by using the WebLOAD plugin for Jenkins  

The guides are distributed with the WebLOAD software in online help format. The 

guides are also supplied as Adobe Acrobat files. View and print these files using the 

Adobe Acrobat Reader. Install the Reader from the Adobe website 

http://www.adobe.com. 

Icons and Typographical Conventions 

Before you start using this guide, it is important to understand the terms, icons, and 

typographical conventions used in the documentation. 

For more information on specialized terms used in the documentation, see Glossary 

(on page 339). 

http://www.adobe.com/
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The following icons appear next to the text to identify special information. 

Table 1: Icon Conventions 

Icon Type of Information 

 
Indicates a note. 

 

Indicates a feature that is available 

only as part of a WebLOAD Add-on. 
 

The following kinds of formatting in the text identify special information. 

Table 2: Typographical Conventions 

Formatting 
convention 

Type of Information 

Special Bold Items you must select, such as ribbon options, command buttons, 

or items in a list. 

Emphasis Use to emphasize the importance of a point or for variable 

expressions such as parameters. 

CAPITALS Names of keys on the keyboard. for example, SHIFT, CTRL, or 

ALT. 

KEY+KEY Key combinations for which the user must press and hold down 

one key and then press another, for example, CTRL+P or ALT+F4. 

Where to Get More Information 

This section contains information on how to obtain technical support from RadView 

worldwide, should you encounter any problems. 

Online Help 

WebLOAD provides a comprehensive on-line help system with step-by-step 

instructions for common tasks. 

You can press the F1 key on any open dialog box for an explanation of the options or 

select Help  Contents to open the on-line help contents and index. 

Technical Support Website 

The technical support pages on our website contain: 
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 FAQ (Frequently Asked / Answered Questions) 

 Agenda Center 

 Documentation 

 RadView’s Product Resource Center, where you can find prepared test scripts, 

product information, and industry related news. 

 http://www.radview.com/support/index.asp 

Technical Support 

For technical support in your use of this product, contact: 

North American Headquarters International Headquarters 

e-mail: support@RadView.com 

Phone: 1-888-RadView  

 (1-888-723-8439) (Toll Free) 

 908-526-7756 

Fax: 908-864-8099 

e-mail: support@RadView.com 

Phone: +972-3-915-7060 

Fax: +972-3-915-7683 

Note: We encourage you to use e-mail for faster and better service. 

When contacting technical support please include in your message the full name of the 

product, as well as the version and build number. 

 

http://www.radview.com/support/index.asp
mailto:support@RadView.com
mailto:support@RadView.com
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Chapter 2 

Overview of the WebLOAD Integrated 

Development Environment 

This section provides a brief overview to the WebLOAD Integrated Development 

Environment. 

About WebLOAD IDE 

WebLOAD IDE (Integrated Development Environment) is an easy-to-use tool for 

recording, creating, and authoring protocol test scripts for the WebLOAD 

environment.  

WebLOAD IDE is a visual environment for creating protocol test scripts (referred to as 

Agendas) that provides the following features: 

 Recording Agendas 

 Editing Agendas 

 Running and Debugging Agendas 

WebLOAD IDE records your action in a Web browser and saves it as a JavaScript 

Agenda. WebLOAD IDE provides two editing modes, the Visual Editing mode and the 

JavaScript Editing mode, that enable you to edit your JavaScript Agenda. 

WebLOAD IDE enables you run and play back the Agenda in a number of ways, such 

as full playback without any breakpoints, with breakpoints, or step-by-step. After the 

Agenda is run, WebLOAD IDE returns response data from the Web server. WebLOAD 

IDE provides various views of the response data to help you debug and edit the 

Agenda. These views include a Web Page view, HTTP Header view, JavaScript view, 

DOM view, and HTML view.  

The Agenda can then be used in the WebLOAD environment to test the performance of 

your Web application. 
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The User Flow 

As you develop a Web application, you and your organization will usually do the 

following: 

1. Plan your session to include the basic tasks that you want the test to perform.  

2. Create the Test Agenda in WebLOAD IDE. 

3. Test the application in WebLOAD using the Agenda created in WebLOAD IDE. 

You do not need to modify the test Agenda as it can run from WebLOAD IDE to 

WebLOAD seamlessly. 

WebLOAD emulates multiple users on a network or server, testing to be sure the 

application scales as needed. These tests ensure that your application operates 

“normally” under load and stress, and your application appears as per your 

specifications and to your visitors’ expectations. 

The Agendas are executed during WebLOAD test sessions by multiple Virtual Clients 

in parallel, achieving simultaneous access to the SUT and generating the load burden 

necessary for effective testing. Each execution of the Agenda generates an independent 

instance running in parallel during your WebLOAD test session. 

Note: Refer to the WebLOAD documentation for more information about using 

WebLOAD. 

Agenda Creation 

You create a JavaScript Agenda in WebLOAD IDE so that you can test applications by 

running the JavaScript Agenda in WebLOAD to simulate the actions of real users.  

An Agenda is a test script written in JavaScript code that is used to test the functionality 

of a Web application under a load. It contains a sequence of HTTP protocol calls sent 

by Virtual Clients to your System Under Test (SUT). For example, if you want to test 

the performance of your Web application when clients access a certain page, your 

Agenda must contain the code for accessing the page.  

An Agenda can be generated automatically using the recording tools supplied with 

WebLOAD IDE, or it can be created manually by writing a script. This guide describes 

the recording tools supplied with WebLOAD IDE for developing test Agendas 

automatically and provides instructions for developing test Agendas manually.  

Before creating an Agenda, you should consider and plan which actions you want to 

include in a test session. 
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Create an Agenda by carrying out the following steps: 

1. Recording the Agenda. 

2. Editing / enhancing the Agenda. 

3. Running and debugging the Agenda. 

The first step of creating an Agenda is recording. As you execute a typical sequence of 

activities, WebLOAD IDE records your accesses, creating a precise, detailed record of 

all your activities and application responses that occur during a recording session. 

WebLOAD IDE operates in conjunction with a Web browser, such as Microsoft’s 

Internet Explorer. The basic ‘Building Blocks’ of a test session are your actions. As you 

work with a test application in the browser, (navigating between pages, typing text 

into a form, clicking the mouse, and so on), WebLOAD IDE stores information about 

you actions in an Agenda file. Externally, your activities are represented in WebLOAD 

IDE by a set of icons arranged in a Visual Agenda Tree. Internally, WebLOAD IDE 

records these actions and automatically creates Agendas that act as scripts, recreating 

the actions and verifying the functionality of Web sites under realistic conditions.  

The second step of creating an Agenda is editing the code of the recorded Agenda. This 

can be done in Visual Editing mode and/or JavaScript Editing mode. For example, if 

you want an Agenda to vary a sequence of accesses, submit randomized data read 

from a file, or work with Java or COM components, a certain degree of programming is 

required. This guide describes how to edit the code in your Agendas to add more 

complex functionality to your testing sessions. 

The last step is to run your Agenda in WebLOAD IDE to perform testing so you can 

emulate how your Agenda will run when executed in WebLOAD. You can then use the 

debugging tools to correct or modify your Agenda so that it acts as you expected. 

After completing these basic steps, you can incorporate your Agenda into a WebLOAD 

test. 

Note: For examples of basic Agendas, see the WebLOAD Scripting Guide. 

The Recording Tool 

WebLOAD IDE is supplied with a recording tool to perform the following: 

 Recording on any site, including sites that use SSL security. 

 Recording in any browser that supports a configurable proxy. 

The recording tool runs independently of the WebLOAD IDE. It runs under Microsoft 

Windows 2000, XP, 2003 and 2007. 
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For detailed instructions on using WebLOAD IDE to record Agendas, see Recording 

Agendas (on page 33). 

The Editing Modes 

WebLOAD IDE provides two modes in which to write lines of code: 

 Visual Editing mode 

 JavaScript Editing mode 

You can switch between modes while customizing Agendas. 

Visual Editing Mode 

In Visual Editing mode, rather than writing numerous lines of code to describe the 

actions you want to test, you simply record the actions in a browser without 

programming. Your interactions with your Web application are captured, recorded, 

and presented graphically in the Agenda Tree. 

When editing an Agenda, you can also drag and drop items from the WebLOAD IDE 

toolboxes into the Agenda Tree. This makes programming easier by building the code 

behind an intuitive drag-and-drop interface.  

 

Figure 1: Agenda Tree 

Each node in the Agenda Tree is a graphical representation of the JavaScript code. 

JavaScript code that cannot be edited appears grayed out. 
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Figure 2: Agenda Tree with JavaScript Code 
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JavaScript Editing Mode 

WebLOAD IDE provides complete testing flexibility with the JavaScript Editor, 

enabling you to add your own code into the recorded Agenda or import a JavaScript 

file. Each block of code is presented graphically in the Agenda Tree. 

 

Figure 3: JavaScript Editor 

WebLOAD IDE provides the following programming assistance to manually edit an 

Agenda: 

 IntelliSense Editor mode for the JavaScript View pane. 

 Insert menu with commonly used functions and commands.  

 Syntax Checker that checks the syntax of the code in your Agenda file and catches 

simple syntax errors before you spend any time running a test session. 

 Import JavaScript files. 

Note: For detailed information about the JavaScript language, see The Core JavaScript 

Language in the Netscape JavaScript Guide. This guide is supplied in Adobe Acrobat 

format with the WebLOAD software. You may also learn the elements of JavaScript 

programming from many books on Web publishing. Keep in mind that some specific 

JavaScript objects relating to Web publishing do not exist in the WebLOAD test 

environment. 
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The Run Mode 

WebLOAD IDE enables you to run the Agenda and view the results. You can then 

debug the Agenda. 

WebLOAD IDE provides a debugger that enables you to correct or modifying your 

Agenda so that is acts as you expected. It includes a variety of tools to help with the 

task of debugging your Agenda, such as setting breakpoints and specifying watch 

variables and expressions. 
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Chapter 3 

Before You Begin using WebLOAD IDE 

This section provides information before you begin using WebLOAD IDE. 

Before You Begin 

Before you begin recording Agendas using WebLOAD IDE, there are configuration 

steps that you may have to complete, depending on the Web application you want to 

test. 

If you plan to record an Agenda that includes retrieving a page that you accessed 

previously during that Agenda, you should clear the cache and cookies in the browser. 

See Clearing the Cache and Cookies in Your Browser (on page 13). 

When you have completed these startup steps, you can either start working with 

WebLOAD IDE immediately, or you can configure the recording options first. For 

more information about configuring the recording options, see Configuring the 

Recording and Script Generation Options (on page 161). 

Clearing the Cache and Cookies in Your Browser 

If your browser is set to use a cache file, steps such as loading a page that you have 

already visited are bypassed when you record an Agenda. 

If your browser loads a page from the cache file, that action is not recorded because 

retrieving a file from the cache is not an HTTP protocol call. Typically this behavior is 

appropriate because you want to emulate the behavior of an actual browser during a 

test. However, if you want each visit to a page during a test to connect through an 

actual GET statement, you must work without a cache file when you record an 

Agenda. 

When you start recording, WebLOAD automatically changes the browser’s proxy 

settings to clear the cache and cookies, according to the definitions in the Recording 

and Script Generation dialog box (see Configuring the Recording and Script Generation 

Options on page 161). This enables WebLOAD IDE to record all HTTP traffic. If you do 
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not want to clear the cache and cookies automatically, you can manually clear the 

cache and cookies in your browser by following the instructions provided by your 

browser. 

Configuring the Proxy Value for Your Browser 

Before you begin recording Agendas using WebLOAD IDE, your browser must be 

configured to use a specific proxy setting. This is usually done automatically when 

opening WebLOAD IDE, but can also be done manually in the browser. 

Note: If your system is already configured to use a proxy setting, WebLOAD will 

preserve this setting for internal use, and will restore the setting after recording is 

complete. 

The procedures described here describe how to configure the proxy server for Internet 

Explorer, Netscape Navigator, and Mozilla Firefox. If you are using a different 

browser, read through the proxy setting procedures and modify them as necessary for 

configuring your browser. 

Note: If your system is already using the WebLOAD IDE default port (9884) for 

another application, you may designate an alternate port number (see Setting the Proxy 

Options on page 186). 

When recording is finished, reset the browser proxy to its original setting. 

Configuring the Proxy Value in Internet Explorer 

To configure the proxy value in Internet Explorer: 

1. Open WebLOAD IDE (see Starting WebLOAD IDE on page 34). 

2. Locate the Proxy Port number in the Recording and Script Generation Options 

dialog box – Proxy Options tab – Recording Proxy Options frame. Usually this port 

number is 9884 (see Setting the Proxy Options on page 186). 

3. Determine if your organization has a Proxy Server that must be used to access the 

Internet when you record Agendas. 

4. If your organization has a Proxy Server: 

a. Determine the proxy name and port number. 

b. If the proxy port that it uses is not the proxy port number found in the 

Recording and Script Generation Options dialog box – Proxy Options tab – 

Recording Proxy Options frame, go to step 6. 
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c. If the proxy port number is the proxy port number found in the Recording and 

Script Generation Options dialog box – Proxy Options tab – Recording Proxy 

Options frame, go to step 7. 

5. If your organization does not use a Proxy Server, go to step 7. 

6. Configure your organization’s proxy as the application proxy in WebLOAD IDE:  

a. Open WebLOAD IDE. 

b. Click Recording and Script Generation Options in the Tools tab of the ribbon 

and then select the Proxy Options tab. 

c. Select the Use the following definitions for the application’s proxy server 

option. 

d. In the HTTP Proxy/Port fields, type the name and port number of your 

organization’s proxy. 

e. Click OK. 

7. Open Internet Explorer. 

8. Select Tools  Internet Options and then select the Connections tab. 

9. Click LAN Settings. 

10. In the Local Area Network LAN Settings dialog box, select the Use a proxy server 

option. 

11. In the Address field, type localhost. 

12. In the Port field, type the proxy port number found in the Recording and Script 

Generation Options dialog box – Proxy Options tab – Recording Proxy Options 

frame. 

13. Verify that the Bypass proxy server for local addresses checkbox is cleared. 

14. Click OK. 

You are finished configuring your proxy value. 

Configuring the Proxy Value in Netscape Navigator 

To configure the proxy value in Netscape Navigator: 

1. Open WebLOAD IDE (see Starting WebLOAD IDE on page 34). 

2. Locate the Proxy Port number in the Recording and Script Generation Options 

dialog box – Proxy Options tab – Recording Proxy Options frame. Usually this port 

number is 9884 (see Setting the Proxy Options on page 186). 

3. Determine if your organization has a Proxy Server that must be used to access the 

Internet when you record Agendas. 

4. If your organization has a Proxy Server: 
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a. Determine the proxy name and port number. 

b. If the proxy port that it uses is not the proxy port number found in the 

Recording and Script Generation Options dialog box – Proxy Options tab – 

Recording Proxy Options frame, go to step 6. 

c. If the proxy port number is the proxy port number found in the Recording and 

Script Generation Options dialog box – Proxy Options tab – Recording Proxy 

Options frame, go to step 7. 

5. If your organization does not use a Proxy Server, go to step 7. 

6. Configure your organization’s proxy as the application proxy in the WebLOAD 

IDE: 

a. Open WebLOAD IDE. 

b. Click Recording and Script Generation Options in the Tools tab of the ribbon 

and then select the Proxy Options tab. 

c. Select the Use the following definitions for the application’s proxy server 

option. 

d. In the HTTP Proxy/Port fields, type the name and port number of your 

organization’s proxy. 

e. Click OK. 

7. Open Netscape Navigator and do one of the following: 

 If you are using Navigator 3.x, select Options  Network Preferences. 

 If you are using Navigator 4.x, select Edit  Preferences. 

8. Within Netscape Navigator, do one of the following: 

 If you are using Navigator 3.x, in the Preferences dialog box, select the Proxies 

tab. 

 If you are using Navigator 4.x, in the Preferences dialog box, under Category, 

expand Advanced and then select Proxies. 

9. Select the Manual Proxy Configuration option. 

10. In the Manual Proxy Configuration dialog box, in the HTTP Address field, type 
localhost. 

11. In the corresponding Port Number field, type the proxy port number found in the 

Recording and Script Generation Options dialog box – Proxy Options tab – 

Recording Proxy Options frame.  

12. Click OK to close the Manual Configuration dialog box. 

13. Click OK to close the Preferences dialog box. 

You are finished configuring your proxy value. 
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Configuring the Proxy Value in Mozilla Firefox 

To configure the proxy value in Mozilla Firefox: 

1. Open WebLOAD IDE (see Starting WebLOAD IDE on page 34). 

2. Locate the Proxy Port number in the Recording and Script Generation Options 

dialog box – Proxy Options tab – Recording Proxy Options frame. Usually this port 

number is 9884 (see Setting the Proxy Options on page 186). 

3. Determine if your organization has a Proxy Server that must be used to access the 

Internet when you record Agendas. 

4. If your organization has a Proxy Server: 

a. Determine the proxy name and port number. 

b. If the proxy port that it uses is not the proxy port number found in the 

Recording and Script Generation Options dialog box – Proxy Options tab – 

Recording Proxy Options frame, go to step 6. 

c. If the proxy port number is the proxy port number found in the Recording and 

Script Generation Options dialog box – Proxy Options tab – Recording Proxy 

Options frame, go to step 7. 

5. If your organization does not use a Proxy Server, go to step 7. 

6. Configure your organization’s proxy as the application proxy in the WebLOAD 

IDE: 

a. Open WebLOAD IDE. 

b. Click Recording and Script Generation Options in the Tools tab of the ribbon 

and then select the Proxy Options tab. 

c. Select the Use the following definitions for the application’s proxy server 

option. 

d. In the HTTP Proxy/Port fields, type the name and port number of your 

organization’s proxy. 

e. Click OK. 

7. Open Mozilla Firefox. 

8. Select Tools  Options. 

9. Click Advanced and then click the Network tab. 

10. In the Connection area, click Settings. 

11. Click Manual proxy configuration. 

12. In the HTTP Proxy field, type localhost. 
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13. In the Port field, type the proxy port number found in the Recording and Script 

Generation Options dialog box – Proxy Options tab – Recording Proxy Options 

frame. 

14. Select the Use this proxy for all protocols checkbox. 

15. Click OK. 

You are finished configuring your proxy value. 
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Chapter 4 

WebLOAD IDE Quick Start 

Welcome to WebLOAD IDE, part of the premier load testing tool that helps you 

quickly and easily test the functionality of your application under load. WebLOAD 

IDE serves as the recorder for WebLOAD. Using an intuitive visual interface, 

WebLOAD IDE helps you create, edit and debug your own test scripts, or Agendas, 

and prepare them for automatically testing your Web based applications. 

WebLOAD IDE’s visual environment gives you easy-to-use editing tools. Once you 

understand the components of the product and a few basic techniques, you can use 

these methods throughout WebLOAD IDE. 

This Quick Start explains how to start the program and the use the features of the 

WebLOAD IDE interface. 

Getting Started 

This section shows you how you can get started quickly, using the RadView Software 

test site at www.webloadmpstore.com. 

You will be working with an Agenda, or test script. The basic steps are: 

1. Recording your Agenda – describes the steps in recording a basic Agenda (see 

Creating an Agenda on page 20). 

2. Editing your Agenda – explains how to edit and modify your script, insert new 

items into your Agenda, and parameterize form data to create data driven tests 

(see Editing Your Agenda on page 26). 

3. Running and debugging your Agenda – explains run and debug your Agenda (see 

Running and Debugging Your Agenda on page 29). 

Note: We recommend that you follow the steps in order. All examples are interrelated 

and dependent on earlier steps. 
 

http://www.webloadmpstore.com/
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Creating an Agenda 

The first step in creating an Agenda is to record your actions as you interact with your 

Web application. 

To create an Agenda: 

1. Start WebLOAD IDE by selecting Start  Programs  RadView  WebLOAD  

WebLOAD IDE. 

WebLOAD IDE opens. 

 

Figure 4: WebLOAD IDE Startup Dialog Box 

2. Select Create a new project. 

The WebLOAD IDE main window opens in Visual Editing Mode, for you to begin 

creating your Agenda.  

When the WebLOAD IDE main window first opens, it opens in Visual Editing 

Mode. In this mode, there are several active panes. The Agenda Tree appears on 

the left, and various view panes appear on the right: JavaScript View, Page View, 

HTML View, and HTTP headers View. 

In Visual Editing mode, you can simply record the actions in a browser without 

programming. Your interactions with your Web application are captured, 

recorded, and presented graphically in the Agenda Tree. 

Each node in the Agenda Tree is actually a visual representation of JavaScript 

code. You can view the contents of the nodes in the JavaScript view pane. 

To the left of the Agenda Tree are WebLOAD IDE toolboxes that can be used to 

edit an Agenda by dragging and dropping items from the WebLOAD IDE 

toolboxes into the Agenda Tree. This makes programming easier by building the 

code behind an intuitive drag-and-drop interface. 
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To the right of the View panes is the Assistant pane, which contains simple 

instructions to help you create your load test agenda. Click a link in the Assistant 

to go to the relevant item. 

 

Figure 5: WebLOAD IDE Main Window in Editing Mode 

3. In the main window, in Visual Editing Mode, click Start Recording in the Home 

tab of the ribbon to begin recording. 
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The following dialog appears: 

 

Figure 6: Recording Dialog Box 

4. Click OK. 

WebLOAD IDE begins recording all of the actions you perform in the browser, as 

indicated by the recording notification in the WebLOAD IDE status bar. 

 

Figure 7: Status Bar 

A blank browser window opens. 

5. In the address bar, enter the Web address www.webloadmpstore.com to go to the 

WebLOAD test site. 

http://www.webloadmpstore.com/
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Figure 8: WebLOAD Test Site 

6. Navigate through the site, performing the actions you want to test. 

For example: 

a. Click a product to view the product details. 

b. Click Add to Cart. 

Your actions are recorded and appear in the Agenda Tree as you navigate the site. 

(If you see more nodes in the Agenda Tree with different URLs, this may be traffic 

generated by browser plug-ins or extensions, for example, third-party toolbars.) 

 

Figure 9: Agenda Tree 

7. Click Stop Recording in the Home tab of the IDE ribbon to stop the recording. 

8. Click Save in the Home tab of the IDE ribbon to save your Agenda. 

9. Type in QuickStart for the name of the Agenda in the Save As dialog box and 

click Save. 

The Agenda is saved with the extension *.wlp. 
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You now have a basic Agenda that can be used in a WebLOAD template. For complete 

information on creating, editing, modifying Agendas, and adding functionality to your 

Agenda, see the rest of the WebLOAD IDE User’s Guide. 

Viewing Your Agenda 

You can view the recorded Agenda in four views: 

 JavaScript View 

When the WebLOAD IDE main window first opens, it opens in Visual Editing 

Mode. In this mode, there are several active panes. The Agenda Tree appears on 

the left, and various view panes appear on the right: JavaScript View, Page View, 

HTML View, and HTTP headers View. 

When recording, your interactions with your Web application are captured, 

recorded, and presented graphically in the Agenda Tree. 

Each node in the Agenda Tree is actually a visual representation of JavaScript 

code. You can view the contents of the nodes in the various View panes. 

In the JavaScript view pane, you can do the following: 

 Display the code for each node individually. 

 View code for the entire Agenda as a whole. 

 View the code for different sections in the Agenda, by clicking the Agenda root 

node in the Agenda Tree and selecting a section from the Function Name list at 

the top of the JavaScript view pane. 
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Figure 10: Function Name List in JavaScript View Pane 

 HTTP Headers View 

Each node in the Agenda Tree also has a visual representation of response headers. 

These response headers were received when the Agenda was recorded. You can 

view the headers of the nodes in the HTTP Headers view pane. Since each node 

has a correlated response header, but not all nodes contain HTTP methods, some 

headers will not have a response header. These nodes will have the message “This 

object does not have HTTP Headers” associated with them. 

In the HTTP Headers view pane, you can do the following: 

 Display the header for each node individually. 

 View headers for the entire Agenda as a whole.  
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Figure 11: HTTP Headers View Pane 

 HTML View – See Viewing the Recorded Agenda in the HTML View Pane (on page 54). 

 Page View – See Using the Page View to View Results (on page 125). 

Editing Your Agenda 

To edit your Agenda: 

1. Edit the runtime settings using the Default and Current Project Options. 

2. Toggle between Visual Editing mode and JavaScript Editing mode. The default 

setting is the Visual Editing mode. 

3. In Visual Editing mode, you can edit the Agenda Tree: 

a. Drag and drop items from the WebLOAD IDE toolbox into the Agenda Tree. 

b. Right-click to insert new items. 

4. In JavaScript Editing mode: 

a. Modify the JavaScript code. 

Important: Each block of code starts with a comment that contains “WLIDE”, 

description, and ID number. The ID number is automatically generated by WebLOAD 

IDE and is the connection between the Agenda node and the specific header. It is 

recommended that you do not change the contents of this comment. If you do, 

important data might be lost. 

b. Right-click to insert functions and commands. 

c. Use the Syntax Checker to check the syntax of the code in your Agenda file. 

d. Import JavaScript files. 

Note: For complete reference information on all JavaScript objects, variables, and 

functions used in WebLOAD IDE Agendas, see the WebLOAD JavaScript Reference 

Guide. 
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Toggling Between Edit Modes 

You can toggle between Visual Agenda mode and Full Script mode. The default setting 

is the Visual Editing mode. 

To toggle between Edit Modes: 

 Click Visual Agenda in the Home tab of the ribbon,  

-Or- 

Click the Full Script in the Home tab of the ribbon. 

Basic Editing Techniques 

WebLOAD IDE is designed for you to be able to create and edit your Agenda easily, 

using the visual interface. Once you understand the basic techniques, you can use them 

throughout the WebLOAD IDE interface. 

Here are some simple techniques, described in this section, that you can use in 

WebLOAD IDE: 

 Drag and drop items into your Agenda Tree. 

 Right-click within the Agenda and select an available option from the Insert menu. 

Drag and Drop 

WebLOAD IDE enables you to drag Agenda items from the WebLOAD IDE toolbox 

and drop them into your Agenda Tree. 

To drag and drop items into your Agenda: 

1. Place the mouse pointer over the item in the WebLOAD IDE toolbox that you want 

to add to your Agenda, such as a Message. 

2. Press and hold the left mouse button. 

3. Drag the item into the Agenda Tree, and place the mouse pointer at the step in the 

Agenda after which you want to add the item. 

4. Release the mouse button. 

A dialog box to enter the parameters opens or the item appears in the Agenda 

Tree. 

5. Click the Agenda item in the Agenda Tree to view and/or edit the JavaScript code 

in the JavaScript view pane. 
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Right-Click Menus 

Throughout WebLOAD IDE, context-sensitive menus appear when you click the right 

mouse button, giving you the appropriate options to select at that point. 

You can also right-click any Agenda item in the Agenda Tree to display a menu. 

To insert a new item: 

1. Right-click the Agenda item and click Insert from the menu. 

2. Select an item from the options available. 

Adding Agenda Items 

You can drag and drop an item, such as Message, from the WebLOAD IDE toolbox. 

For the list of toolboxes, see The WebLOAD IDE Toolbox Items (on page 217). 

In the following instructions, adding a Message is used as an example. While running a 

test session, WebLOAD IDE and WebLOAD IDE’s Log windows display information 

about session execution. You can include Message nodes in your Agenda, defining 

points at which to send error and/or notification messages to the Log window. 

To add a Message Agenda item: 

1. Place the mouse pointer over the Message  icon in the WebLOAD IDE toolbox. 

2. Press and hold the left mouse button. 

3. Drag the Message item into the Agenda, and place the mouse pointer after the Web 

page to which you want to add the message. 

4. Release the mouse button. 

The Message dialog box opens. 
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Figure 12: Message Dialog Box 

5. Enter the text you want to appear in the message. 

6. To add a global variable to the message text, click the globe icon ( ) to the right of 

the input text box and select a global variable from the drop-down list.  

Note: When entering a string value to the message, the string must be enclosed in 

quotation marks, for example, “Sample Message”. 

7. Select a severity level for the message from the drop-down list. The following 

severity levels are available: 

 Information message (WLInfoMessage) 

 Minor error message (WLMinorError) 

 Error message (WLError) 

 Severe error message (WLSevereError) 

8. Click OK. 

The Message item appears in the Agenda Tree. 

Running and Debugging Your Agenda 

After your Agenda has been developed, you run it to test for errors in your application. 

You can then debug your Agenda. 

Running Your Agenda 

To run your Agenda: 

1. Click Run in the Debug tab of the ribbon. 
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As the Agenda is running: 

 A yellow arrow points to the node being executed in the Agenda Tree. 

 If the JavaScript View tab is open, you will also see the yellow arrow pointing 

to the script. 

 If the Page View tab is open, you will see the pages that return from the Web 

server. 

 Nodes are added to the Execution Tree as they occur. 

 The GET and POST HTTP protocol commands are displayed in the HTTP 

Headers view pane. 

 Messages and errors generated by the test appear in the Log Window at the 

bottom of the screen. 

2. At the prompt: Save Changes to WebLOAD IDE Project, click Yes and enter a file 

name to save your Agenda file. 

Note: If there is more than one tester and the tests are to be shared between testers, the 

root directory (test plans and the results of the test plans) and the tests must be saved 

to a network drive. 

Debugging Your Agenda 

WebLOAD IDE provides an integrated debugger with a variety of tools to help locate 

bugs in your Agenda. The debugger provides special menus, windows, dialog boxes, 

and grids of fields for debugging. You can pause the debugger and trigger WebLOAD 

IDE to wait for user input before proceeding with running the Agenda. In the Agenda, 

you can set breakpoints and step into / over / out. You can also abort the debugger 

without executing the TerminateClient and TerminateAgenda functions, as 

opposed to stopping it completely. 

To debug your Agenda: 

 Click Step Into or click Run in the Debug tab of the IDE ribbon, 

-Or- 

Add breakpoints by clicking Toggle Breakpoint in the Debug tab of the IDE 

ribbon, and then clicking Run to run the Agenda. 

Note: If you stop the debugger prematurely (for example, by closing the IDE or 

returning to edit mode), you can instruct WebLOAD, in the Settings dialog box, to 

prompt you to save the debugging session file. For more information about the 

Settings dialog box, see Configuring the Settings (on page 194). 

 

 



  

WebLOAD IDE User's Guide  31  

Debugging Using the Watch Window 

You can use the Watch window to specify variables and expressions that you want to 

watch while debugging your program. 

To debug using the Watch window: 

1. Start debugging. 

2. Select the Watch Window checkbox in the Debug tab 

 

Figure 13: Watch Window 

In the Name column, plus sign (+) or minus sign (-) boxes may appear. These 

appear if you added an array or object variable to the Watch window. Use these 

boxes to expand or collapse your view of the variable. 

Debugging Using the Variables Window 

The Variables window provides quick access to variables that are important in the 

Agendas current context. 

To debug using the Variables Window: 

1. Start debugging. 

2. Check the Variables Window checkbox in the Debug tab of the ribbon. 

 

Figure 14: Variables Window 



 

 32  Chapter 4. WebLOAD IDE Quick Start 

The Variables window displays variables used in the current statement and in the 

previous statement. It also displays return values when you step over or out of a 

function.  

The Variables window contains a grid with fields for the variable name and value. The 

debugger automatically fills in these fields. You cannot add variables or expressions to 

the Variables window. The Context dropdown list displays the current scope of the 

variables displayed. 

Debugging Using the Call Stack Window 

The Call Stack window lists the function calls that led to the current statement, with 

the current function on the top of the stack. 

To debug using the Call Stack Window: 

1. Start debugging. 

2. Select the Call Stack checkbox in the Debug tab of the ribbon. 

 

Figure 15: Call Stack Window 

This Quick Start has shown you an example of how to record, create, edit, run, and 

debug an Agenda in WebLOAD IDE. For more information about all the options 

available in WebLOAD IDE, see the rest of the WebLOAD IDE User’s Guide and the 

WebLOAD IDE Online Help.
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Chapter 5 

Recording Agendas 

This section provides instructions for recording Agendas with WebLOAD IDE. 

About Recording Agendas with WebLOAD IDE 

Use WebLOAD IDE to create test scripts (Agendas) as a baseline for testing your Web 

application in the WebLOAD Console. As you navigate through a Web application, 

WebLOAD IDE records your actions, automatically generating an Agenda that reflects 

your actions in JavaScript. WebLOAD IDE creates your Agendas for you, writing GET 

and POST HTTP protocol commands automatically. 

As your actions are recorded, WebLOAD IDE displays them in the Agenda Tree, 

which is a tree hierarchy with visual indications of the information recorded. 

WebLOAD IDE records only HTTP protocol calls that place a load on the System 

Under Test (SUT). Activities that are not relevant to the Agenda, such as moving 

windows for a more comfortable display or opening another application, are not 

recorded. While your Agenda is being recorded, you can edit it with the WebLOAD 

IDE Toolbox set. For information on editing your Agenda using the WebLOAD IDE 

Toolbox set, see Editing your Agenda Using the WebLOAD IDE Toolbox Set (on page 83). 

This process creates the basic Agenda. You can then view the recorded Agenda as 

JavaScript code in the JavaScript view pane, revise the Agenda to test more objects in 

more detail, and run and debug the Agenda. For information on editing your Agenda, 

see Editing Agendas (on page 67). For information on running and debugging your 

Agenda, see Running and Debugging Agendas (on page 107). 

The Agenda can then be used with WebLOAD for load and scalability testing of your 

application. 
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Starting WebLOAD IDE 

To start WebLOAD IDE: 

1. Select Start  Programs  RadView  WebLOAD  WebLOAD IDE. 

WebLOAD IDE opens. 

  

Figure 16: WebLOAD IDE Startup Dialog Box 

2. Check or uncheck Don’t ask me again. 

3. Click one of the following options: 

 Create a new project – Opens a new project. WebLOAD supports several types 

of projects, the default project being Internet Protocol Project. The new project 

type is set according to the type of project which was last open. To create a 

different type of project, select New Project in the File tab of the IDE ribbon 

and select the desired project type.  

 Open an existing project – Browse to the project. 

 Open a saved session – Browse to the session. 

The WebLOAD IDE main window opens in Editing Mode (Figure 5), enabling you 

to begin creating or editing your Agenda. 

Recording an Agenda 

You can either start working with WebLOAD IDE immediately, or you can configure 

the recording options first. For more information about configuring the recording 

options, see Configuring the Recording and Script Generation Options (on page 161). 

When you record an Agenda, WebLOAD IDE displays the Agenda being created in 

real time. You can watch WebLOAD IDE record your actions as you navigate in the 

Web browser. 
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If you start and stop recording more than once during a single recording session (for 

example, to skip an irrelevant step in the application you plan to test) each subsequent 

set of JavaScript commands is appended to the end of the Agenda. If you open an 

existing Agenda and start recording new Web activity, WebLOAD IDE also appends 

the new JavaScript commands to the end of the Agenda. 

To record an Agenda: 

1. Start WebLOAD IDE (see Starting WebLOAD IDE on page 34), 

-Or-  

Start WebLOAD IDE from your Explorer by double-clicking the WebLOAD IDE 

project file (.wlp) or session WebLOAD IDE session file (.wls). 

The WebLOAD IDE main window opens in Editing Mode, enabling you to begin 

recording your Agenda. 

2. To create a new Agenda, click New Project in the File tab of the ribbon. 

3. To open an existing Agenda: 

a. Click Open in the File tab of the ribbon. 

b. Select a file. 

4. Click Start Recording in the Home tab of the ribbon. 

By default, the Recording dialog box appears. 

 

Figure 17: Recording Dialog Box  

The Recording dialog box enables you to quickly define the basic settings for the 

default Web browser which you will be using during the recording. 
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Note: Any changes to the settings in the Recording dialog box affect the settings of the 

Browser Settings tab of the Recording and Script Generation Options dialog box 

(Figure 107). For more information, see Configuring the Default Browser (on page 172). 

5. Optionally change the browser settings: 

Table 3: Recording Dialog Box Options 

Field Description 

Open Browser Select one of the following options as your default browser: 

 Microsoft Internet Explorer. 

 Mozilla Firefox. 

 Google Chrome. 

 Native Mobile Recording. For further explanations, refer to Recording 

Mobile Applications (on page  331). 

 None – No default browser. 

If you selected Mozilla Firefox as your browser, and Mozilla Firefox was 

installed on the machine after WebLOAD IDE was installed, a message 

appears recommending that you install the Firefox extension responsible 

for setting the proxy definitions automatically. If you accept, the extension 

is installed. 

Clear browser 

cache 

Select this option to clear the browser cache before recording. This option 

is selected, by default. 

Clear cookies Select this option to clear the browser’s cookie history before recording. 

This option is selected, by default. 

Identify as Select this option to simulate a mobile web application. 

Browser Select the browser type you wish to simulate.  

Version Select the browser version you wish to simulate. Alternatively, click the 

Change button  to edit the browser version definition. See Editing 

Browser Version Definitions (on page 151). 

Don’t show this 

message again 

Select this checkbox if you do not wish to see this dialog box every time 

you select Start Recording. 

In addition, you can optionally click More Record Options to open the Browser 

Settings tab of the Recording and Script Generation Options dialog box 

(Figure 112) and define the default browser settings in full detail. 

6. Click OK. The Recording dialog box closes. 

A floating WebLOAD Recording toolbar appears. Throughout any recording 

session, the WebLOAD Recording toolbar always appears on top of the active 

window. 

 



  

WebLOAD IDE User's Guide  37  

 

Figure 18: WebLOAD Recording Toolbar 

The following table describes the function of each button in the WebLOAD 

Recording toolbar: 

Table 4: WebLOAD Recording Toolbar Buttons 

Button Purpose 

 Start recording. 

 End recording. 

 Pause or resume recording. 

 Insert message. 

 Insert comment. 

 Begin transaction.  

Adds named transactions to the Agenda to measure the 

performance of logical actions in your Agenda, such as a 

Login process. By inserting named transactions into your 

Agenda, you can take a series of simple actions, define 

them as a single transaction, and set success or failure 

criteria for the complete transaction. 

 End transaction. 

 Define concurrent. 

Defines a starting point after which the WebLOAD engine 

collects all Post and Get HTTP requests, but does not 

execute them until an Execute Concurrent function is 

run. 

 Execute concurrent. 

Defines a starting point after which the WebLOAD engine 

stops collecting and begins executing all the Post and Get 

HTTP requests that were defined since the last Define 

Concurrent function, concurrently (using 

multithreading). 

WebLOAD IDE begins recording all actions you perform in the browser, as 

indicated by the recording notification in the WebLOAD IDE status bar. 

 

Figure 19: Status Bar 
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If this is the first time that you are recording after WebLOAD IDE was launched, 

the default browser opens automatically with its predefined home page. This 

enables you to start recording and then access a page. 

 

Figure 20: Default Web Browser 

7. In the Web browser window, access the System Under Test (SUT). 

8. Perform the steps that you want to test, retrieving and submitting information 

found on different site pages and locations. Try to emphasize the actions whose 

performance you need to measure in your test sessions. 

Watch how WebLOAD IDE adds nodes to the Agenda as you work. Your actions 

are recorded and appear in the Agenda Tree as you navigate the site. (If you see 

more nodes in the Agenda Tree with different URLs, this may be traffic generated 

by browser plug-ins or extensions, for example, third-party toolbars.) 



  

WebLOAD IDE User's Guide  39  

 

Figure 21: Agenda Tree Node 

a. Click the JavaScript View tab to watch the JavaScript of the pages as they are 

being recorded. 

Note: During recording, the InitAgenda and TerminateAgenda sections of the script 

are not generated and therefore are not visible. 

b. Click the HTTP Headers View tab to watch the response headers of the pages 

as they are being recorded. 

c. Click the HTML View tab to watch the HTTP data as it is being recorded. 

Note: When switching between the JavaScript, HTTP Headers, Browser, and HTML 

Views, the new view displays the node that is selected in the Agenda Tree (during edit 

mode) or Execution Tree (during debug mode). These views are available during 

recording, after the recording is finished, and after opening a saved Agenda. 

9. When you are finished, select WebLOAD IDE. 

10. Click Stop Recording in the IDE recording floating toolbar or in the Home tab of 

the IDE ribbon. 

WebLOAD IDE stops recording. 

11. Click Save in the File tab of the IDE ribbon. 

12. In the File name field in the Save As dialog box, type a descriptive name for the 

Agenda, and then click Save. 

Your Agenda is saved with the file extension *.wlp. 

13. Close the Browser window to work in WebLOAD IDE. 

The Recording Complete dialog box opens. 
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Figure 22: Recording Complete Dialog Box 

14. Select one of the following: 

 Automatically discover rules and correlate script to run the correlation engine 

using the existing rules, and apply auto-discovery correlation to find potential 

correlation rules. For more information, see Automatic Discovery of Correlation 

Rules (on page 92.) 

 Correlate script using only the existing rules to run the correlation engine 

using the existing defined rules. For more information, see Configuring the 

Correlation Rules (on page 96). 

 Don’t correlate now to view the recorded Agenda without correlating the 

script. You can manually correlate the script later. 

Notes: Although by default the Recording Complete dialog box appears, this depends 

on your settings in the Correlation Options tab of the Recording and Script Generations 

options dialog box. For more information, see Setting the Default Correlation Action (on 

page 91). 

You can customize the Agenda in a variety of ways or you can run your Agenda as 

recorded. For information on editing your Agenda, see Editing Agendas (on page 67). 

For information on running your Agenda, see Running and Debugging Agendas (on 

page 107). 

Notes: If actions that you are interested in were not recorded, check the cache settings 

in your browser. WebLOAD IDE may be skipping steps that you want to record 

because your browser is using a system cache file. For more information, see Clearing 

the Cache and Cookies in Your Browser (on page 13). 

When you stop the recording, if no actions were recorded (that is, the Agenda is 

blank), WebLOAD IDE automatically displays the recording troubleshooting 

information. 
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Pausing a Recording 

WebLOAD IDE enables you to pause a recording so that you can edit the script. 

To pause a recording: 

1. Click  from the WebLOAD Recording toolbar, 

-Or- 

Click Pause Recording in the Home tab of the ribbon. 

The recording pauses. 

2. To restart the recording, click  from the WebLOAD Recording toolbar, 

-Or- 

Click Start Recording in the Home tab of the ribbon. 

The recording restarts. 

Inserting Messages in a Recording 

WebLOAD IDE enables you to insert messages while recording, defining points at 

which to send error and/or notification messages to the Log window. 

To insert a message: 

1. Click  from the WebLOAD Recording toolbar at the desired location in the 

recording. 

The Message dialog box opens. 

 

Figure 23: Message Dialog Box 
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2. Create a text message by typing the text you want to appear in the message in the 

input text box. 

Note: When you enter a string value in the message, you must enclose it in quotation 

marks; for example, “Sample Message”. 

3. To add a global variable to the message text, click the globe icon to the right of the 

input text box, and select a global variable from the drop-down list. 

4. Select a severity level for the message from the drop-down list. 

The following severity levels are available: 

 Information message (WLInfoMessage) 

 Minor error message (WLMinorError) 

 Error message (WLError) 

 Severe error message (WLSevereError) 

 Debug message (WLDebugMessage) 

5. Click OK. 

The Message item appears in the Agenda Tree, and the JavaScript code is added to 

the Agenda. To see the new JavaScript code, view the Agenda in JavaScript Editing 

mode. 

Inserting Comments in a Recording 

WebLOAD IDE enables you to insert comments while recording to describe an activity 

or provide information about a specific operation. 

To insert a comment: 

1. Click  from the WebLOAD Recording toolbar at the desired location in the 

recording. 

The Comment dialog box opens. 

 

Figure 24: Comment Dialog Box 
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2. Enter the text you want to appear in the comment. 

3. Click OK. 

The Comment item appears in the Agenda Tree, and the JavaScript code is added 

to the Agenda. To see the new JavaScript code, view the Agenda in JavaScript 

Editing mode. 

Inserting Begin and End Transactions in a Recording 

In addition to the automatic transactions provided by WebLOAD, you can add named 

transactions during a recording to measure the performance of logical actions in your 

Agenda, such as a Login process. By inserting named transactions into your Agenda, 

you can take a series of simple actions, define them as a transaction, and set success or 

failure criteria for the transaction. Each transaction can be a simple action, such as a 

query, or a complex action that may include several steps. 

To measure transactions, you must mark the beginning and end of the transaction in 

your Agenda. During runtime, WebLOAD measures the time it takes to complete the 

transaction and reports the results in the WebLOAD Integrated reports, Statistics 

reports, and Data Drilling report. 

Note: You can add an unlimited number of transactions into your Agenda. Each 

transaction must have a different name. 

To mark the beginning of a transaction: 

1. Click  from the WebLOAD Recording toolbar just before the first action you want 

to include in the transaction. 

The Begin Transaction dialog box opens. 

 

Figure 25: Begin Transaction Dialog Box 

2. Enter a logical name for the transaction; for example, “Login”. 

3. Click OK. 
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The Begin Transaction item appears in the Agenda Tree, and the JavaScript code is 

added to the Agenda. To see the new JavaScript code, view the Agenda in 

JavaScript Editing mode. 

To mark the end of a transaction: 

1. Click  from the WebLOAD Recording toolbar directly after the last action you 

want included in the Agenda. 

The End Transaction dialog box opens. 

 

Figure 26: End Transaction Dialog Box 

2. Select the transaction to end from the Select Opened Transaction drop-down list. 

3. Select a return value for the transaction from the Select Return Value drop-down 

list. 

You can select from the return values provided, or select Custom Function to 

create your own verification function to call when the transaction is complete. 

For information on creating custom functions, see the WebLOAD Scripting Guide. 

4. To set WebLOAD to save the results of all transaction instances, successes, and 

failures for later analysis with Data Drilling, select true in the Save transaction 

information for Data Drilling field. Select false (default) to save only results of 

failed transaction instances that triggered some sort of error flag. 

5. Optionally, enter a text string to specify a possible reason for a transaction failure 

within your transaction verification function in the Failure Reason field. This 

reason will also appear in the Statistics Report. 

6. Click OK. 
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The End Transaction item appears in the Agenda Tree, and the JavaScript code is 

added to the Agenda. To see the new JavaScript code, view the Agenda in 

JavaScript Editing mode. 

Defining Concurrent in a Recording 

WebLOAD IDE enables you to collect Post and Get HTTP requests and simultaneously 

execute them by two or more threads, as defined in the MultiThread Virtual Clients 

number. This is configured in the Browser Parameters tab in WebLOAD Console’s 

Agenda Options dialog box. 

Note: WebLOAD IDE does not perform the Post and Get HTTP requests concurrently. 

To simultaneously execute Post and Get HTTP requests, you must define where in the 

Agenda to begin collecting the requests and where to stop collecting and begin 

executing them. The HTTP requests are collected until the engine encounters an 

Execute Concurrent function in the Agenda. For more information about the 

Execute Concurrent Building Block, see Executing Concurrent Definition in a Recording 

(on page 45). 

To define when to start collecting HTTP requests in an Agenda: 

 Click  from the WebLOAD Recording toolbar at the desired location in the 

recording. 

The Define Concurrent Building Block is added to the Agenda Tree. The JavaScript 

code is added to the Agenda. To see the new JavaScript code, view the Agenda in 

JavaScript Editing mode. 

Executing Concurrent Definition in a Recording 

WebLOAD IDE enables you to define the Execute Concurrent function. Then in 

WebLOAD Console, you can simultaneously execute all the Post and Get HTTP 

requests that were defined since the last Define Concurrent function by two or more 

threads, as defined by the MultiThread Virtual Clients number. This is configured in 

the Browser Parameters tab in WebLOAD Console’s Agenda Options dialog box. 

Note: The Execute Concurrent function can only be inserted in your Agenda after a 

Define Concurrent function. For more information about the Define Concurrent 

function, see Define Concurrent (on page 231). 

When the engine encounters the Execute Concurrent function, it stops collecting 

the HTTP requests in the Agenda and starts their execution.  
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To insert concurrently executing HTTP requests in an Agenda: 

 Click  from the WebLOAD Recording toolbar at the desired location in the 

recording. 

The Execute Concurrent Building Block is added to the Agenda Tree. The 

JavaScript code is added to the Agenda. To see the new JavaScript code, view the 

Agenda in JavaScript Editing mode. 

Viewing the Recorded Agenda 

WebLOAD IDE creates Agendas by recording your actions as you interact with your 

Web application or System Under Test (SUT). Your recorded Agenda serves as a 

baseline, which is subsequently used in the WebLOAD environment to test the 

performance of your Web application. 
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WebLOAD IDE presents each recorded action visually in the Agenda Tree and as code 

in the JavaScript View pane. 

  

Figure 27: Recorded Actions in JavaScript View Pane 
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Viewing the Recorded Agenda in the Agenda Tree 

As you navigate through a Web application, WebLOAD IDE records your actions. 

  

Figure 28: Agenda Tree with Nodes 

WebLOAD IDE displays the following as nodes in the Agenda Tree: 

 Pages accessed 

 Sleep time 

 Messages 

 Comments 

 Begin Transaction 

 End Transaction 

 Define Concurrent 

 Execute Concurrent 
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When navigating to a new page in the Web application, WebLOAD IDE inserts a node 

with the URL into the Agenda Tree. 

 

Figure 29: Page Access Node 

When you pause while navigating in the Web application, WebLOAD IDE inserts a 

Sleep node into the Agenda Tree. The Sleep node represents your thinking time. 

 

Figure 30: Sleep Node 

When you insert a message while recording, WebLOAD IDE inserts a Message node 

into the Agenda Tree. 

 

Figure 31: Message Node 

When you insert a comment while recording, WebLOAD IDE inserts a Comment node 

into the Agenda Tree. 

 

Figure 32: Comment Node 

When you begin a transaction while recording, WebLOAD IDE inserts a 

BeginTransaction node into the Agenda Tree. All actions that occur during the 

Transaction appear on a lower hierarchical level in the Agenda Tree. You can collapse 

or expand this node by clicking  or  respectively. 

 

Figure 33: BeginTransaction Node 

When you end a transaction while recording, WebLOAD IDE inserts an 

EndTransaction node into the Agenda Tree. 

 

Figure 34: EndTransaction Node 

When you define concurrent while recording, WebLOAD IDE inserts a 

DefineConcurrent node into the Agenda Tree. 
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Figure 35: DefineConcurrent Node 

When you define concurrent while recording, WebLOAD IDE inserts an 

ExecuteConcurrent node into the Agenda Tree. 

 

Figure 36: ExecuteConcurrent Node 

After the Agenda is recorded, you can edit the Agenda (see Editing an Agenda in the 

Agenda Tree on page 68). 

After your Agenda has been developed, you can run and debug it. While the Agenda is 

running, you can view it in the Agenda Tree (see Viewing the Execution Sequence in the 

Agenda Tree on page 108). 
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Viewing the Recorded Agenda in the JavaScript View 
Pane 

Each node in the Agenda Tree is actually a visual representation of JavaScript code. 

You can view the contents of the nodes in the JavaScript view pane. 

 

Figure 37: Node Contents in JavaScript View Pane 

In the JavaScript view pane, you can do the following: 

 Display the code for each node individually. 

 View code for the entire Agenda as a whole. 
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 View the code for different sections in the Agenda, by clicking the Agenda root 

node in the Agenda Tree and selecting a section from the Function Name list at the 

top of the JavaScript view pane. 

Each block of code starts with a header that contains “WLIDE”, description, and ID 

number, and ends with the “END WLIDE” closing comment. The ID number is 

automatically generated by WebLOAD IDE and is the connection between the Agenda 

node and the specific header. The comments in the Agenda are a light grey color. 

 

Figure 38: Block of JavaScript Code 

After the Agenda is recorded, you can edit the Agenda (see Editing an Agenda in the 

JavaScript View Pane on page 71). 

After your Agenda has been developed, you can run and debug it. While the Agenda is 

running, you can view it in the JavaScript View pane (see Viewing the Execution 

Sequence in the JavaScript View Pane on page 109). 

Viewing the Recorded Agenda in the HTTP Headers View 

Pane 

Each node in the Agenda Tree is also a visual representation of response headers. You 

can view the headers of the nodes in the HTTP Headers view pane. 

 

Figure 39: HTTP Headers View Pane 

In the HTTP Headers view pane, you can do the following: 

 Display the header for each node individually. 

 View headers for the entire Agenda as a whole. 
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When you click a node in the Agenda tree, you can view the header for that node. 

 

Figure 40: Node Header 

You can expand the header to view all of the gets and posts for that node. 

 

Figure 41: Expanded Header 

For an object that does not have a header, such as a Sleep node, the following is 

displayed: 

 

Figure 42: Display for Objects without Headers 

The Post command involves sending data to the HTTP server, as opposed to the Get 

command, which is used only for retrieving data. In the HTTP Headers View, the Post 

command also includes the actual data that was sent to the server. This part of the 

HTTP message is marked by a special icon: 

 

Figure 43: Event Header 

After the Agenda is recorded, you can edit the Agenda (see Editing an Agenda in the 

JavaScript View Pane on page 71). 

After your Agenda has been developed, you can run and debug it. While the Agenda is 

running, you can view it in the JavaScript View pane (see Viewing the Execution 

Sequence in the JavaScript View Pane on page 109). 
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Viewing the Recorded Agenda in the HTML View Pane 

Each node in the Agenda Tree is actually a visual representation of HTML code. You 

can view the HTML preview of each page and frame requested in the Agenda in the 

HTML view pane. 

 

Figure 44: Node Contents in HTML View Pane 

In the HTML view pane, you can display the code for each node individually. 

After your Agenda has been developed, you can run and debug it. For more 

information on debugging with the HTML View, see Using the HTML View to View 

Results (on page 126). 

Performing Script Regeneration 

When an Agenda is recorded, all of the HTTP traffic is saved even if not all of it is used 

to generate the Agenda’s script (the recorded traffic is saved to the .wle file of the 

Agenda). The Agenda is created according to the settings defined in the Script 

Generation tab in the Record and Script Generation Options dialog box. You can 

regenerate the Agenda any time after recording, to include additional traffic 

information that was originally recorded. This is done by modifying the settings in the 

Script Generation tab and then regenerating the Agenda. 
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For example, by default when an Agenda is recorded, the HTTP headers settings for 

the HTTP requests are not displayed in the Agenda’s script even though they are 

recorded. After selecting the Generate All Headers checkbox in the Script Generation 

tab and regenerating the Agenda, the script includes the wlHttp headers property. For 

more information on the script content that can be regenerated, see Specifying the Script 

Content to be Generated on page 163. 

In addition, script regeneration is affected by changes in the settings defined in the 

Post Data tab in the Record and Script Generation Options dialog box. You can record 

a script with content type x in the DATA list, DATAFile list, or not in any list, (which 

means it will be recorded as FORMDATA) and then change the settings and regenerate 

the script and it will play back according to the new settings. 

To perform script regeneration: 

1. Click Correlation in the Home tab of the ribbon and select Regenerate Script from 

the drop-down list. 

-Or-  

Right-click a node in the Agenda Tree and select Regenerate Script from the 

pop-up menu. This regenerates only the selected node. 

Note: If your Agenda was created manually, and not recorded, WebLOAD informs 

you that your Agenda does not contain any recorded nodes and cannot regenerate the 

script. When performing script regeneration, any modifications to the Agenda’s 

originally recorded nodes are lost. Any nodes that were added after the recording will 

remain in the Agenda after the script is regenerated. 

The Perform Script Regeneration dialog box appears. 

 

Figure 45: Perform Script Regeneration Dialog Box 

2. Click Save and Continue to save the changes in your Agenda and regenerate the 

script. 

-Or- 

Click Don’t Save and Continue to regenerate the script without saving the 

changes in your Agenda. 
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-Or- 

Click Cancel to close the Perform Script Regeneration dialog box without 

regenerating the script in your Agenda. 

Note: Click Edit  Undo to discard the newly regenerated script and revert back to the 

previous script. 

Saving an Agenda 

You must save your Agendas so that you can use them in test sessions. 

To save an Agenda: 

1. Click Save in the File tab of the ribbon and select Save or Save As. 

The Save As dialog box appears. 

2. Type the Agenda name in the File name field. 

3. Click Save. 

Your Agenda is saved with the file extension *.wlp. You may now run a test 

using the Agenda. 

Saving Additional Project Information 

The Additional Information dialog box provides details about the project that help 

identify it; for example: 

 A descriptive title 

 The author name 

 The subject of the test 

 The system under test 

 Other important information about the project 

Use the Additional Information dialog box to save information about the project. 

To save additional information properties for the project: 

1. Select Additional Information from the IDE System button. 

The Project Additional Information dialog box opens. 
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Figure 46: Project Additional Information Dialog Box 

2. Fill in the fields to save additional information, useful for later reference, with the 

project. 

3. Click OK. 

The following table describes the fields of the Project Additional Information dialog 

box. 

Table 5: Project Additional Information Dialog Box Fields 

Field Description 

Title Provides a space for you to type a title for this project. The title can 

be different then the project file name. 

Subject Provides a space for you to type a description of the subject of the 

project. Use this property to group similar projects together. 

Created by Provides a space for you to type the name of the person who 

authored this project. 

Test description Provides a space for you to type a description of the test objectives 

and what the project is designed to test. 

Version and build of the 

System Under Test 

Provides a space for you to type the name, version and build 

number of the System Under Test (SUT). 

Comments Provides a space for you to type any comments regarding the 

project. 
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Field Description 

Custom Provides a space for you to type any comments you want saved 

with this project. 

Recording Desktop Web Applications 

Desktop web applications, such as Rich Internet Applications (RIAs), are web based 

applications that have the features and functionality of local desktop applications. A 

desktop web application can run either in a web browser or in software that is installed 

and run locally on the user’s desktop (for example, Adobe AIR applications). 

Recording desktop web applications in Agendas using WebLOAD IDE, involves 

configuring the web applications to use a specific proxy setting. This proxy setting is 

usually configured automatically when opening WebLOAD IDE for browser-based 

applications in Internet Explorer or Mozilla Firefox. To record any other web 

application that does not run within the browser, configure the web application to pass 

the traffic to the server through the WebLOAD IDE proxy server, using one of the 

following methods: 

 Recording WebLOAD Agendas Using the Client’s Proxy Setting (on page 58). 

 Recording WebLOAD Agendas Using the LAN Settings (on page 58). 

 Recording WebLOAD Agendas Using Proxy Tunneling (on page 60). 

Recording WebLOAD Agendas Using the Client’s Proxy 

Setting 

Web applications that support working through a proxy server can be configured to 

pass the traffic to the server through the WebLOAD IDE proxy server. Follow the web 

application’s proxy setting instructions to specify the WebLOAD IDE proxy server as 

the application’s proxy server. 

WebLOAD IDE’s default proxy server settings are: 

 Host: localhost. 

 Port: 9884. 

Recording WebLOAD Agendas Using the LAN Settings 

Some operation systems provide the ability to configure the proxy setting of the LAN 

connection. The following example demonstrates configuring the Internet application’s 

proxy setting of the LAN connection in Windows XP: 
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To configure the proxy setting in Windows XP: 

1. From the Start menu, select Settings  Control Panel. 

The Control Panel dialog box appears. 

2. Select Internet Properties and then select the Connections tab. 

The Internet Properties – Connections tab appears. 

 

Figure 47: Internet Properties – Connections Tab 

3. In the Local Area Network (LAN) settings, click LAN settings. 

The Local Area Network (LAN) Settings dialog appears. 
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Figure 48: Local Area Network (LAN) Settings 

4. In the Proxy server area check Use a proxy server for your LAN. 

5. In the Address and Port fields enter WebLOAD IDE’s proxy server setting. By 

default, this is localhost:9884. 

Note: This setting is necessary for the recording process only and should be removed 

before the load test execution. 

6. Click OK. 

The proxy setting of the LAN connection in Windows XP is configured. 

Recording WebLOAD Agendas Using Proxy Tunneling 

Proxy tunneling is a general method to handle desktop web applications that do not 

support working through a proxy server. Proxy tunneling involves using an external 

utility to redirect the outgoing web traffic on the client machine. The redirection 

enforces the traffic to pass through WebLOAD’s proxy recorder, which is listening on 

port 9884, during the recording stage. 

To record Agendas using Proxy Tunneling: 

1. Enable a port interception service on the client machine. Configure the service to 

redirect the outgoing traffic from the application to pass through WebLOAD’s 

proxy. The following are possible methods for intercepting web application traffic: 

 Use an external utility that is capable of controlling and rerouting HTTP traffic. 

For example, the Proxifier application, which is available at: 

http://www.proxifier.com. 

 

http://www.proxifier.com/
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 Configure your firewall. Some firewalls provide advanced services of traffic 

manipulation. 

 Configure your hardware. Four to seven layer switches may be used for 

controlling and routing web based traffic. 

2. Configure WebLOAD IDE’s recording options as follows: 

a. Click Recording and Script Generation Options in the Tools tab of the ribbon. 

The Recording and Script Generation Options dialog appears (see Figure 107). 

b. Select the Browser Settings tab. 

The Browser Settings tab appears (see Figure 112). 

c. In the Automatic Browser Settings area, uncheck Set the Proxy definitions 

automatically. 

d. Select the Proxy Options tab. 

The Proxy Options tab appears (see Figure 118). 

e. In the Recording Proxy Options area, check Use Transparent Proxy. This 

enables WebLOAD IDE to record from any Web client that does not support 

proxy configurations. 

3. Start recording your Agenda. 

4. Run the web application. While the web application is running, all the http traffic 

generated on the client machine is directed to WebLOAD IDE. WebLOAD handles 

this traffic as if it is received from a browser client and generates the appropriate 

Agenda. 

5. Stop recording the Agenda when the application is finished running. 

6. Disable the interception service. 

Note: Before starting the test and running the generated Agenda, the interception 

service must be stopped. Otherwise, the load traffic generated by the Console will be 

directed back to the recorder. 

The Agenda is recorded successfully. You can now run the test in WebLOAD Console. 

In certain cases, the WebLOAD Proxy Recorder may timeout during recording. This 

may be due to a slow network and/or SUT. The default timeout is 60. To avoid this 

situation, you can increase the default timeout. 

To change the default timeout: 

1. Right-click the wlproxyinclude.js file in <RadView directory>\Include and 

select Edit. 

2. Add the following line to the file: 

ProxyObject.RProxyCOptConnectionTimeOut = 300 
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3. Save the file. 

Troubleshooting 

Refer to the following table if you are having recording related problems. Before 

assuming the problem is with WebLOAD, make sure that your internet settings are 

correct and that you can access the internet without recording. 

Table 6: Troubleshooting 

Problem Possible Options Solution 

Agenda is not 

created while 

recording 

Make sure browser 

opens while 

recording. 

Click Recording and Script Generation Options in the 

Tools tab of the ribbon and select the  Browser Settings 

tab. Ensure that the settings are correct for your browser. 

See Configuring the Default Browser (on page 172) for more 

information. 

 Check browser proxy 

settings. 

For Internet 

Explorer: 

1.  From your browser’s menu, select 

Tools  Internet Options and select the 

Connections Options tab. 

2. Click Lan Settings. 

3. If none of the checkboxes are selected, 

you have a direct connection to the 

internet and the browser proxy settings 

are not the problem. 

If Automatically detect settings and/or 

Use automatic configuration script are 

checked, you must disable the automatic 

settings. Before disabling the automatic 

settings, contact your system 

administrator for your proxy server 

information. 

If Use a proxy server for your LAN is 

checked, copy the Address and Port 

field’s current proxy settings. In 

WebLOAD, click Recording and Script 

Generation Options in the Tools tab of 

the ribbon and select the Proxy Options 

tab. Check Use the following 

definitions for the application’s proxy 

server and enter the current proxy 

information into the HTTP Proxy/Port 

and SSL Proxy/Port fields. 
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Problem Possible Options Solution 

For Mozilla 

Firefox: 

1. From your browser’s menu, select 

Tools  Options. 

2. At the top of the Options dialog box, 

select the Advanced icon and select the 

Network tab. 

3. In the Connection area, click Settings. 

4. If Direct connection to the internet is 

selected, the browser proxy settings are 

not the problem. 

If Auto-detect proxy settings for this 

network or Automatic proxy 

configuration URL are selected, you 

must disable the automatic settings. 

Before disabling the automatic settings, 

contact your system administrator for 

your proxy server information. 

If Manual proxy configuration is 

selected, copy the HTTP Proxy and Port 

field’s current proxy settings. In 

WebLOAD, click Recording and Script 

Generation Options in the Tools tab of 

the ribbon and select the Proxy Options 

tab. Check Use the following 

definitions for the application’s proxy 

server and enter the current proxy 

information into the HTTP Proxy/Port 

and SSL Proxy/Port fields. 

 Recording with a 

browser other than 

Internet Explorer or 

Mozilla Firefox. 

1. Click Recording and Script Generation Options in the 

Tools tab of the ribbon and select the Browser Settings 

tab. Select Other browser or None as the default 

browser setting.  

2. While recording, you must manually change the client’s 

proxy setting. In your browser, manually configure the 

proxy settings to use WebLOAD’s default port: 9884. 

This points the browser’s proxy settings to the 

WebLOAD recorder enabling WebLOAD to record the 

browser’s HTTP clients. 

 LAN settings options 

for IE are disabled by 

IT Group Policies 

Request that your Network Administrator change the 

policies for the specific machine on which you are 

recording. For more information about Group Policy see 

the Microsoft TechNet Library. 

http://technet.microsoft.com/en-us/library/bb457072.aspx
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Problem Possible Options Solution 

 Advanced options 1. While recording, open the task manager and ensure 

that a single proxynator.exe process is active. If 

there is no proxynator.exe process or there is more 

than one proxynator.exe process contact RadView 

support for further assistance. 

2. WebLOAD uses ports 9884, 9010, and 9000. Enter 

netstat -a -p tcp in the command line to ensure 

that the ports are not being used by another application 

on your machine. A list of the unavailable ports 

appears. 

If port 9884 is unavailable, click Recording and Script 

Generation Options in the Tools tab of the ribbon and 

select the Proxy Options tab. In the Recording Proxy 

Options frame, modify the Proxy Port value from 9884 

to an available port number. 

If port 9010 or port 9000 are unavailable, open the 

WebLOAD.ini file in <RadView directory>\bin 

and locate the following lines: 

TESTTALK_CLIENT_PORT=“9010” 

TESTTALK_NETWORK_PORT=“9001” 

Modify the port value of the unavailable port from 9010 

and/or 9000 to an available port number. 

Local sites are not 

recorded in the 

Agenda 

Proxy settings are set 

to bypass local 

addresses 

1. From your browser’s menu, select Tools  Internet 

Options and select the Connections Options tab. 

2. Click Lan Settings. 

3. Check Bypass proxy server for local addresses to 

ensure that the proxy settings are not set to bypass local 

addresses or any other server that you want to record. 

 WebLOAD does not 

record from 
http://localhost 

For Internet Explorer: 

Use any of the following instead of http://localhost: 

 http://<your machine name> 

 http://<your IP address> 

 http://localhost./ 

For Mozilla Firefox: 

1. From your browser’s menu, select Tools  Options. 

2. Select the Advanced  Network tab and click Settings. 

3. Clear the No proxy for property checkbox. 

http://localhost/
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Problem Possible Options Solution 

Secured sites are 

not recorded in the 

Agenda 

Proxy settings do not 

point to the recorder. 

For Internet Explorer: 

1. From your browser’s menu, select Tools  Internet 

Options and select the Connections Options tab. 

2. Click Lan Settings. 

3. Ensure that Use a proxy server for your LAN is 

checked and modify the port setting to 9884. 

For Mozilla Firefox: 

1. From your browser’s menu, select Tools  Options. 

2. At the top of the Options dialog box, select the 

Advanced icon and select the Network tab. 

3. In the Connection area, click Settings. 

4. Ensure that Manual proxy configuration is selected 

and modify the port setting to 9884. 

 A different proxy is 

needed for SSL 

You must configure an SSL proxy. For instructions, see 

Setting the Proxy Options on page 186. 

Certificate Error is 

displayed in the 

browser during 

recording 

 The browser correctly detects the recorder and warns the 

user. You can safely ignore the warning and continue. 

Note: You can prevent the warning if you configure 

WebLOAD to use the server’s certificate. Set the proxy 

certificate options in the Recording and Script 

Generation Options dialog box. For more information 

see Setting the Proxy Certificates (on page 190).  

A partial Agenda is 

created while 

recording 

Browser cache needs 

to be cleared.  

For Internet Explorer or Mozilla Firefox:  

1. In WebLOAD IDE, click Recording and Script 

Generation Options in the Tools tab of the ribbon. 

2. Select the Browser Settings tab. 

3. In the Automatic Browser Settings area, check Clear the 

browser cache and click OK. 

For any other browser: 

 From your browser’s menu, select the command that 

clears the browser’s cache.  
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Problem Possible Options Solution 

 Proxy settings need to 

be modified 

Modify the proxy setting’s file extensions and content types 

to record specific extensions, since WebLOAD by default 

only records top-level URLs, such as HTML, XML, and 

text. 

1. Click Recording and Script Generation Options in the 

Tools tab of the ribbon. 

2. In the Recording and Script Generation Options dialog 

box select the Content Types and File Locations tabs. 

3. Add the specific extension and content types that are 

not being recorded. 

For more information see Configuring the Content Types to 

Record (on page 184) and Setting File Locations (on page 196). 

The Internet 

Explorer proxy 

settings are locked 

 1. Click Start  Run. 

2. Type Regedit and click OK. 

3. Select HKEY_CURRENT_USER  Software  Policies 

 Microsoft  Internet Explorer  Control Panel. 

4. Set the data value for each key in this directory to 0. 
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Chapter 6 

Editing Agendas 

This section provides instructions for editing Agendas with WebLOAD IDE. 

About Editing Agendas with WebLOAD IDE 

WebLOAD IDE is both flexible and extendable to fit all of your Agenda editing needs, 

from the most basic to the most advanced. On the simplest level, you use the 

WebLOAD IDE GUI to record your basic Agenda. You can edit your Agenda either 

while it is being recorded or after it has finished recording to add functionality through 

the options available in the GUI. In most cases, the options available through the GUI 

meet all testing needs. For advanced functionality where programming is required, the 

JavaScript Editor is available to add further functionality to your Agenda. 

In the Agenda, each request and event is based on previous input, tying the entire 

Agenda into a whole, making many actions interdependent. Items such as JavaScript 

Objects, Comments, Messages, and Sleeps can be added to the Agenda, but changing 

the sequence of items in effect means changing the sequence of activities, and may 

destroy the functionality of the Agenda. For more information on recording Agendas, 

see Recording Agendas (on page 33). 

When editing your Agenda, you can work at whatever level you prefer. 

The following Agenda editing tools are discussed: 

 Editing an Agenda in the Agenda Tree (on page 68) describes how to add Agenda 

items and JavaScript Objects, and edit an Agenda by right-clicking in the Agenda 

Tree. 

 Editing an Agenda in the JavaScript View Pane (on page 71) describes how to use 

JavaScript objects to create Agenda scripts with the full functionality of JavaScript 

code programs. The WebLOAD IDE JavaScript Editor includes a set of context-

sensitive prompts that help you code your Agenda more effectively. 

 Editing your Agenda Using the WebLOAD IDE Toolbox Set (on page 83) describes 

how to use the WebLOAD IDE toolbox that contains drag-and-drop items to create 

a script with minimal coding. 
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Note: The technical support pages on our Web site contain the Agenda Center, which 

is a test script library. The library contains code fragments and samples that can help 

you work with WebLOAD IDE and WebLOAD. Each example contains a full 

description of the code fragment or file, with an explanation of how the code works. 

We also include tips and suggestions and downloadable copies of the files, to get you 

up and running faster. 

To view the Agenda Center, navigate to http://www.webload.org/phpbb/index.php?c=3 

and select WebLOAD Script Libraries. 

Editing an Agenda in the Agenda Tree 

This section describes how to edit an Agenda in the Agenda Tree. If you are editing 

your Agenda while it is being recorded, you can focus on any specific node in the 

Agenda Tree and edit its JavaScript in the JavaScript view pane. 

Note: You must be in Visual Editing mode. 

Adding Agenda Items and JavaScript Objects to an 

Agenda 

WebLOAD IDE contains shortcuts to frequently performed actions. This section 

describes how to place Agenda items and JavaScript Objects from the Insert menu into 

an Agenda. For guidelines for replacing the placeholder variables with your own, see 

Guidelines for Editing JavaScript Code (on page 81). 

To add items and JavaScript Objects to an Agenda: 

1. In the main window, click Open in the File tab of the ribbon and open the Agenda 

you want to edit. 

2. Make sure that you are in Visual Editing mode. 

3. Right-click the Agenda root node or the Agenda item where you want to place the 

new Agenda item. 

A pop-up menu appears. 

4. From the pop-up menu, click Insert. 

The following list of shortcuts appears. 

 

 

http://www.webload.org/phpbb/index.php?c=3
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Figure 49: Insert Menu 

5. Select an Agenda item or JavaScript Object. 

The Agenda item or JavaScript is inserted on a new line in the Agenda, 

immediately after the selected node. 

The Agenda Items and JavaScript Objects that you can insert are also available 

through the WebLOAD IDE toolbox, see Editing your Agenda Using the WebLOAD 

IDE Toolbox Set (on page 83).  

Editing an Agenda by Right-Clicking in the Agenda Tree 

You can edit directly in the Agenda Tree using the right mouse button. When you 

right-click an Agenda item, a menu gives you options that vary according to the 

Agenda item selected and the mode. 

To right-click menus in Edit mode: 

1. In the main window, click Open in the File tab of the ribbon and open the Agenda 

you want to edit. 

2. Make sure that you are in Visual Editing mode. 

3. In the Agenda Tree, right-click the Agenda root node or right-click an Agenda item 

in the tree. 

A pop-up menu appears. The menu for the Agenda root differs slightly from the 

menu for an Agenda item, as described in Table 7. 
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The following table describes the menu options: 

Table 7: Menu Options 

Right-Click Menu Option Purpose 

Synchronize 

(Agenda root menu only) 

Synchronize the Agenda tree, with the edits made to the 

JavaScript code in Visual Editing mode In most cases, 

synchronization is performed automatically. 

Only available at the Agenda root level. 

Insert Insert an Agenda Item or JavaScript Object into the Agenda 

(see Adding Agenda Items and JavaScript Objects to an Agenda on 

page 68). 

The Agenda items and JavaScript Objects that you can insert 

are also available through the WebLOAD IDE toolbox, 

described in Editing your Agenda Using the WebLOAD IDE 

Toolbox Set (on page 83).  

Paste Paste the Agenda item you cut or copied, after the current 

Agenda item. 

Note: If you copied an Agenda item, you can paste it 

more than once. Each time you paste, the node ID 

automatically changes. 

If you cut an Agenda item, you can paste it only once, and 

the node ID does not change. 

Cut 

(Agenda item menu only) 

Cut the Agenda item from the tree to paste elsewhere. 

Copy 

(Agenda item menu only) 

Copy the Agenda item from the tree to paste elsewhere. 

Delete 

(Agenda item menu only) 

Delete the Agenda item from the tree. 

Toggle Breakpoint Add or remove a breakpoint at the selected Agenda item in the 

Agenda Tree. For more information, see Setting Breakpoints (on 

page 114).  

Current Project Options Display the Current Project Options dialog box. Only available 

at the Agenda level. For more information, see Configuring the 

Default and Current Project Options (on page 143). 

Regenerate Script Regenerate the Agenda. For more information, see Performing 

Script Regeneration (on page 54). 

Response Validation Add response validation to the Agenda. For more information, 

see Validating Responses (on page 132) 
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Editing an Agenda in the JavaScript View Pane 

You can edit directly in the JavaScript View pane using the right mouse button. When 

you right-click an Agenda item, a menu gives you options that vary according to the 

mode. 

Editing the JavaScript Code for an Agenda Item 

You can edit the JavaScript code generated by WebLOAD IDE for any item in the 

Agenda. 

Note: When you select the Agenda root node, the entire Agenda appears in the 

JavaScript View pane as read only. To edit the entire Agenda, see Using the JavaScript 

Editor (on page 73). 

To edit the JavaScript code for an Agenda item: 

1. In the main window, click Open in the File tab of the ribbon and open the Agenda 

you want to edit. 

2. Make sure that you are in Visual Editing mode. 

3. Select the JavaScript View checkbox in the View tab to open the JavaScript View 

pane. 

4. Select the item in the Agenda Tree. 

The JavaScript Agenda code for that item appears in the JavaScript View pane. 

 

Figure 50: JavaScript View Pane 

5. Edit the Agenda (see Editing the JavaScript Code on page 77). 

Important: The ID number is automatically generated by WebLOAD IDE and is the 

connection between the Agenda node and the specific header. It is recommended that 

you do not change the contents of this comment. If you do, important data might be 

lost. 
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Editing the JavaScript Code Functions 

An Agenda includes a few sections of code, including functions. At the Agenda root 

node only, you can select these sections from the Function Name drop-down list. 

When you select the NodeScript for the Agenda root node, the entire script appears 

in the JavaScript View pane as read only. You can only edit the Agenda as a whole file 

when in JavaScript Editing mode (see Using the JavaScript Editor on page 73). 

When you select a section other than NodeScript for the Agenda root node, the code 

appears in the JavaScript View pane. In the JavaScript View pane, you can edit the 

JavaScript code for functions called in the Agenda. By default, WebLOAD IDE calls the 
InitAgenda(), InitClient(), TerminateClient(), and 

TerminateAgenda() functions for each Agenda. 

Table 8: WebLOAD Functions 

Function Description 

InitAgenda Optional. Creates a JavaScript function InitAgenda to begin the 

script. InitAgenda is typically where global variables are defined. 

InitClient Optional. Creates a JavaScript function InitClient to begin a 

client process. 

Usually there will be only one client in a WebLOAD IDE session; 

WebLOAD uses multiple clients. 

TerminateClient Optional. Creates a JavaScript function TerminateClient to end a 

client process. 

Usually there will be only one client in a WebLOAD IDE session; 

WebLOAD uses multiple clients. 

TerminateAgenda Optional. Creates a JavaScript function TerminateAgenda to end 

the script. 

 

The function properties do not need to be edited unless you want to make special 

customizations, such as including a function from a different file and using the 

IncludeFile() function. 

To edit the JavaScript code for functions: 

1. In the main window, click Open in the File tab of the ribbon and open the Agenda 

you want to edit. 

2. Make sure that you are in Visual Editing mode.  

3. Select the JavaScript View checkbox in the View tab to open the JavaScript View 

pane. 
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4. Select the Agenda item in the Agenda Tree.  

The JavaScript Agenda code for the Agenda item appears in the JavaScript View 

pane. The JavaScript for the Agenda root node will include the whole Agenda. 

5. From the Function Name drop-down list, located at the top of the JavaScript View 

pane, select the name of the function. 

The JavaScript code for the function appears in the JavaScript View pane. 

 

Figure 51: JavaScript View Pane 

6. Type the JavaScript code to include in the InitClient, InitAgenda, 

TerminateClient, or TerminateAgenda (see Editing the JavaScript Code on 

page 77). 

For guidelines for replacing the placeholder variables with your own, see 

Guidelines for Editing JavaScript Code (on page 81). 

Note: You cannot add a WebLOAD IDE protocol block in the middle of a function. 

When in Visual Editing mode, this option is disabled. 

Using the JavaScript Editor 

Although represented visually, all Agendas are written in JavaScript. The JavaScript 

code within an Agenda is created from the actions you record and the verification tests 

you place in the Agenda. You can add JavaScript Objects to your recorded Agenda, 

allowing you to add additional written code directly to your Agenda. The JavaScript 

Editor is both a viewer and an editor for adding and editing JavaScript code in the 

Agenda. 

WebLOAD IDE provides the following features for manually editing an Agenda: 

 Import JavaScript Files 

WebLOAD IDE enables you to import JavaScript files into your Agenda. 
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 WebLOAD IDE Protocol Block 

WebLOAD IDE enables you to add code to your Agenda which is then represented 

visually in the Agenda Tree. 

 An IntelliSense Editor mode for the JavaScript View pane 

Add new lines of code to your Agenda or edit existing JavaScript functions 

through the IntelliSense Editor mode of the JavaScript View pane. The IntelliSense 

Editor helps you write the JavaScript code for a new function by formatting new 

code and prompting with suggestions and descriptions of appropriate code choices 

and syntax as programs are being written. IntelliSense supports the following 

shortcut keys: 

 Period (“.”) – Enter a period after the object name, to display a drop-down list 

of the object’s available properties that can be added to the Agenda (see 

Figure 52).  

 <CTRL> <Space> – While typing the name of an object, you can type <CTRL> 

<Space> to display a drop-down list of the available objects that begin with the 

letters that you entered. For example, if you type wl the IntelliSense Editor 

displays a drop-down list of all of the objects that begin with wl (such as 

wlhttp). 

In addition, the IntelliSense Editor gives a structure to the code with the outline bar 

and line numbering. 

Collapsing the code enables you to view the heading of the section, without seeing 

the code within the section. To expand or collapse different sections of the code: 

 Click the plus sign (+) or minus sign (-) on the outline bar, 

-Or- 

 Right-click within the IntelliSense Editor and select Outlining from the pop-up 

menu. The available outlining options are: 

 Toggle outline – collapses or expands the section at the mouse location. 

 Toggle all outline – collapses or expands all outlines. 

 Collapse to definition – collapses all outlines. 

You can enable or disable both the outline bar and line numbering features by: 

 Right-clicking within the IntelliSense Editor and selecting Enable Outlining or 

Line Numbers from the pop-up menu. 

When these features are enabled, a checkmark appears next to the name in the 

pop-up menus. By default, these features are enabled, but WebLOAD opens with 

the settings that were saved during the previous WebLOAD session. During 

playback and debug modes, all outlines are expanded. 
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Use WebLOAD IDE’s predefined delimiters to keep your code structured and 

organized. The available delimiters include: 

 For JavaScript functions, use “{“ as the start delimiter and “}” as the end 

delimiter. 

 For Agenda tree nodes, insert a WLIDE comment from the General IDE 

toolbox. This automatically inserts a start delimiter “//” and end delimiter “End 

WLIDE”. 

For more information, see the WebLOAD Scripting Guide. 

 

Figure 52: IntelliSense Editor Mode for JavaScript View Pane 

 A selection of the most commonly used functions and commands, available 

through the Insert menu. 

You can choose to program your own JavaScript Object code within your Agenda 

and take advantage of the WebLOAD IDE GUI to simplify your programming 

efforts. Rather than manually typing out the code for each command, with the risk 

of making a mistake, even a trivial typographical error, and adding invalid code to 

the Agenda file, you may select an item from the Insert menu, illustrated in the 

following figure, to bring up a list of available commands and functions for the 

selected item. WebLOAD IDE automatically inserts the correct code for the 

selected item into the JavaScript Object currently being edited. You may then 

change specific parameter values without any worries about accidental mistakes in 

the function syntax. 
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Figure 53: Insert Menu 

In addition to the Insert menu, you may select an item from the Insert Variable 

menu, to add system and user-defined parameters to the Agenda. This eliminates 

the need for manual coding. For more information about adding user-defined 

parameters to the Agenda, see Inserting User-Defined Parameters in an Agenda (on 

page 214). 
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Figure 54: Insert Variable Menu 

 A Syntax Checker that checks the syntax of the code in your Agenda file and 

catches simple syntax errors before you spend any time running a test session. 

While standing in the JavaScript View pane of the WebLOAD IDE desktop, click 

Syntax Checker in the Edit tab of the ribbon, or right-click and select Check 

Syntax from the pop-up menu to check the syntax of the code in your Agenda file. 

Important: WebLOAD IDE Agendas should be edited only within the confines of 

WebLOAD IDE, not within an external editor. If you use an external editor to modify 

the JavaScript code in an Agenda file generated by WebLOAD IDE, your visual 

Agenda will be lost. 

Editing the JavaScript Code 

Note: Any part of the code that is edited in the JavaScript Editing mode is inserted into 

the Agenda as a JavaScript block, which cannot be edited in the Visual Editing mode. 

To edit the JavaScript code for the Agenda: 

1. In the main window, click Open in the File tab of the ribbon and open the Agenda 

you want to edit. 
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2. Select Full Script in the Home tab of the ribbon to open the Agenda in JavaScript 

Editing mode. 

The entire Agenda appears. 

3. Position the cursor where you want to edit the JavaScript code. 

Note: To add a new JavaScript node, place the cursor after the END WLIDE comment 

of the previous node before you start writing your JavaScript code. When you switch 

back to Visual Editing mode a JavaScript node is automatically created, containing 

your code.  

4. Type the JavaScript code that you want this item to contain. 

5. Add functions and commands from the Insert menu (see Adding Commands and 

Functions to an Agenda on page 80). 

6. Import a JavaScript file: 

a. Right-click in the Agenda. 

b. Click Import JavaScript File from the pop-up menu. 

The JavaScript code is added to the Agenda. 

7. Add a WebLOAD IDE protocol block from the pop-up menu (see Adding 

WebLOAD IDE Protocol Blocks on page 78). 

8. Perform a syntax check: 

a. Right-click in the Agenda. 

b. Select Check Syntax from the pop-up menu. 

WebLOAD IDE performs a syntax check and displays the errors. 

9. Toggle a breakpoint (for more information, see Setting Breakpoints on page 114). 

Note: To clear the JavaScript View pane, click Clear JavaScript Editor in the Edit tab of 

the ribbon. 

Adding WebLOAD IDE Protocol Blocks 

To add WebLOAD IDE Protocol Blocks to an Agenda: 

1. In the main window, click Open in the File tab of the ribbon and open the Agenda 

you want to edit. 

2. Click Full Script in the Home tab to edit the Agenda in full screen editing mode. 

3. In the JavaScript View pane, position the cursor where you want to place the 

WebLOAD IDE protocol block. 

4. Right-click in the Agenda, and click Add WebLOAD IDE Block from the pop-up 

menu. 
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A WebLOAD IDE protocol block header is inserted on a new line in the Agenda, 

immediately after the line where the cursor is located, and an Agenda item is 

added to the Agenda Tree. 

 

Figure 55: WebLOAD IDE Protocol Block Header 

5. Replace the placeholder <Block Type> with a description. 

For example: Replace <Block Type> with URL. 

6. Add the JavaScript code after the WebLOAD IDE protocol block header. 

The code is added to the Agenda. 
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Figure 56: JavaScript Code added to WebLOAD IDE Protocol Block Header 

Adding Commands and Functions to an Agenda 

WebLOAD IDE contains shortcuts to frequently performed actions. This section 

describes how to place Commands, and functions from the Insert menu in an Agenda. 

For guidelines for replacing the placeholder variables with your own, see Guidelines for 

Editing JavaScript Code (on page 81). 

To add commands and functions to an Agenda: 

1. In the main window, click Open in the File tab and open the Agenda you want to 

edit. 

2. In the JavaScript View pane, position the cursor where you want to place the 

command or function. 

3. Right-click in the Agenda and click Insert. 

The list of shortcuts appears. 
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Figure 57: Shortcuts List 

4. Select a command or function. 

The command or function selected is inserted on a new line in the Agenda, 

immediately after the line where the cursor is located. 

Guidelines for Editing JavaScript Code 

Use the following guidelines to edit commands and functions you have placed in an 

Agenda through the JavaScript Editor: 

 Placeholders between brackets < > that appear in generic examples must be 

replaced with the literal name of a variable. 

For example, the generic example: 

wlHttp.PassWord = “<Password>“ 

must be replaced with the string: 

wlHttp.PassWord = “Blue” 

 Placeholders between square brackets within parentheses ([ ]) are optional 

function parameters. It is not mandatory to include them in the command. 
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For example, the generic example: 

<Line_Array> = GetLine(“<File_Name>“ [,”<Separator>“]) 

can be replaced with the string: 

MyFile = GetLine(“C:\\InputFile.txt”) 

 Placeholders between square brackets [ ] are array variables and must be replaced 

with the literal name of a variable, enclosed with square brackets. 

For example: 

wlHttp.Header[“<Key>“]= “<Value>“ 

must be replaced with the string: 

wlHttp.Header[“proxy-connection”]=“Keep-Alive” 

 In a WebLOAD IDE protocol block, replace the placeholder <Block Type> with a 

description. 

For example: 

<Block Type> 

can be replaced with: 

SSL Certificate 

See the WebLOAD Scripting Guide for more information. 
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Editing your Agenda Using the WebLOAD IDE 

Toolbox Set 

The WebLOAD IDE provides a set of objects, such as Sleep, that you can drag and 

drop to add Agenda items in the Agenda Tree while recording or viewing your 

Agenda. The WebLOAD IDE bar is referred to as the toolbox. 

 

Figure 58: WebLOAD IDE Toolbox 

Use the WebLOAD IDE toolboxes to add the following items to your Agenda: 

 General objects, such as Message or Sleep timers. These objects are used in all test 

Agendas, run in both WebLOAD IDE and WebLOAD. General toolbox tools are 

described in The WebLOAD IDE General Toolbox (on page 219). 

 Load objects, such as transactions and synchronization points used in WebLOAD 

tests. Load toolbox tools are described in The WebLOAD IDE Load Toolbox (on 

page 223). 

 IPP functionality, such as downloading data from an FTP site for a WebLOAD IDE 

test. IPP Building Blocks are described in The WebLOAD IDE IPP Toolbox (on 

page 232). 
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 Database actions, such as opening and getting data from a database for a 

WebLOAD IDE test. Database Building Blocks are described in The WebLOAD IDE 

Database Toolbox (on page 286). 

 Verification functionality, such as verifying specific elements within HTTP 

responses in your Agenda. Verifications Building Blocks are described in The 

WebLOAD IDE Verifications Toolbox (on page 315). 

Adding Agenda Items from a WebLOAD IDE Toolbox 

To drag and drop a WebLOAD IDE toolbox item into your Agenda: 

1. Place the mouse over the item in the WebLOAD IDE toolbox that you want to add. 

2. Press and hold the mouse button (just “clicking” has no effect). 

3. Drag the item into the Agenda tree, highlighting the item after which you want to 

add the new item. 

4. Release the Agenda item you have inserted. 

5. For many of the items, such as Message, Comments, and Sleep objects, additional 

dialog boxes are used to prompt you for the information necessary to add 

messages, comments, and pause times. Enter the necessary information, and click 

OK. 

The item with its toolbox icon appears in the Agenda Tree at the point where you 

placed the item. 

6. For JavaScript Objects, add JavaScript code to the Agenda (see Using the JavaScript 

Editor on page 73). 

Working with JavaScript Files 

WebLOAD IDE enables you to open a JavaScript file and convert it to a WebLOAD 

IDE project file or continue working with the file as a JavaScript file. 

You may want to save it as a JavaScript file if it is an Include file (component of a 

whole Agenda) and not the main Agenda. 

We recommend that you convert the JavaScript file to a WebLOAD IDE project file for 

the following reasons: 

 The project file is better suited to the WebLOAD IDE visual environment. 

 Enables you to save additional information to the script, such as the Current 

Project options. 



  

WebLOAD IDE User's Guide  85  

Note: When you convert a JavaScript file to a WebLOAD IDE project file, the original 

JavaScript file is not deleted. If you convert it to the new format, you can always save it 

as a regular JavaScript file, using the Save As option. 

To work with a JavaScript File: 

1. In the main window, click Open in the File tab. 

2. Select a JavaScript file. 

The Open message appears. 

 

Figure 59: Open Message Box 

3. Click Yes to convert the JavaScript file to a WebLOAD IDE project file, 

-Or- 

Click No to continue working with the file as a JavaScript file. 

If you continue working with the file as a JavaScript file, the file appears in the 

JavaScript View pane as a JavaScript file, and the WebLOAD IDE block shows that 

it is a JavaScript file. 

 

Figure 60: JavaScript File in JavaScript View Pane 

Important: If you save the file as a JavaScript file, the next time you open the file, the 

Open message will not appear. 
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Chapter 7 

Correlating Agendas 

This section provides instructions for correlating Agendas with WebLOAD IDE. The 

WebLOAD correlation engine helps you overcome one of the main challenges of 

recording or replaying Web application load tests: dynamic data. 

Dynamically generated data changes every time you run a Web application. For 

example, the session ID that uniquely identifies a user’s active session is allocated by 

the Web server or the application every time such a session is initiated. (The session ID 

is also used for session management. For more information, see Session Management on 

page 104.) Such dynamic data cannot simply be recorded as is and played back, 

because the playback will inevitably fail. 

WebLOAD enables you to correlate the most common methods used to pass dynamic 

data between a server and a client. The methods are: 

 Cookies – This method is mostly used for session management, but cookies may 

also contain additional dynamic data sent from a server. In most situations, the 

browser returns the sent cookie in subsequent requests. This scenario is handled 

automatically by WebLOAD and no additional correlation activities are required. 

WebLOAD also supports cases where a value received in a cookie is sent as 

request data or a cookie is created in the client-side JavaScript. 

 URL rewriting – This method is most commonly resolved by assigning the 

returned Session ID to a local variable and using this variable throughout the rest 

of the Agenda. 

 Hidden form fields – This method is most commonly used for passing localized 

dynamic data that is not necessarily within the scope of the full session. 

 Any response content – Some applications return dynamic data within various 

types of HTTP responses, including client-side JavaScript and XML content. 
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About Correlating Agendas with WebLOAD IDE 

WebLOAD contains a powerful rule based correlation engine. You can define rules that 

describe how dynamic values should be extracted in their application. 

WebLOAD also provides automatic discovery of potential correlation rules. Using 

auto-discovery of rules eliminates the need to manually define correlation rules in 

some common cases. 

WebLOAD IDE identifies dynamic data using correlation rules. These rules can be 

configured to suit your correlation needs. For more information on correlation rules, 

see Configuring the Correlation Rules (on page 96). 

The WebLOAD correlation engine enables you to: 

 Automatically discover potential correlation rules – WebLOAD can automatically 

suggest correlation rules for common scenarios, based on the values sent and 

received in the Agenda, or for a specific value. 

 Reuse correlation logic – Once the rules are defined or discovered, the correlation 

engine uses the rules to make all necessary changes to the Agenda. The rules can 

be used unchanged in all future Agendas with the same scenarios. 

 Re-run correlation at any time – You can run the correlation process multiple 

times on previously recorded Agendas. For example, if you perform correlation 

based on a particular set of rules, you can correlate that Agenda another time 

based on a different set of rules, without re-recording the Agenda. 

 Add comments to your JavaScript – When dynamic data is correlated according to 

the correlation rules you define, WebLOAD IDE can add comments to your 

JavaScript to help you keep track of the changes made by the correlation engine. 

 Keep a detailed correlation log – The correlation engine can keep track of all the 

correlation operations performed on your Agenda in the form of a textual log file. 

You can determine the location of this log file as well as the level of information it 

stores. Either you or RadView Technical Support can use the correlation log file to 

identify, investigate, and solve correlation problems. 

Correlating To and From Cookies 

WebLOAD enables correlating to and from cookies. 

Most cookies get their values from a previous response’s Set-Cookie header, 

originating from the server. These values are handled automatically by WebLOAD and 

do not require any action. They do not appear in the Agenda. 

Client-side cookies are created by the client using JavaScript in response to a user 

preference, client-side generated content, such as a random number, or for some other 
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reason. These cookies appear in the Agenda as wlCookie.Set() commands. The 

values of these cookies can be correlated like any other dynamic data. 

Performing Correlation 

Correlation is performed on your Agenda, based on the correlation rules. Correlation 

rules are defined in one of the following ways: 

 Auto-discovery of correlation rules – When performing correlation with 

auto-discovery of correlation rules, the correlation engine compiles a list of the 

suggested correlation rules, enabling you to select the rules that are applicable to 

your application. For more information, see Approving the Correlation Engine Rules 

(on page 92). 

 In the Correlation Rules Editor – Before running the correlation engine, you can 

use the correlation rules editor to add and edit the rules. 

Note: You can turn discovered rules into permanent rules and then edit the rules in the 

correlation rules editor. 

For more information, see Configuring the Correlation Rules (on page 96). 

Note: Correlation cannot be performed on Agendas that were not recorded. 

Performing Auto-discovery Correlation 

To perform correlation with auto-discovery of rules: 

1. Click Correlation in the Home tab of the ribbon and select Correlate Script and 

Discover Rules from the drop-down list. 

The Perform Script Correlation dialog box appears. 

 
Figure 61: Perform Script Correlation Dialog Box 

2. Click Save and Continue to save the changes in your Agenda and perform 

correlation. 

-Or- 
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Click Don’t Save and Continue to perform correlation without saving the changes 

in your Agenda. 

-Or- 

Click Cancel to close the Perform Script Correlation dialog box without performing 

correlation in your Agenda. 

Performing Auto-discovery Correlation for Specific Values 

WebLOAD enables you to perform correlation with auto-discovery of rules for any 

value you select in an Agenda. This provides correlation when normal auto-discovery 

is not sufficient. Auto-discovery correlation for specific values can be used instead of 

normal auto-discovery in the following cases: 

 Partial values – Since auto-discovery only searches for exact matches, if the 

dynamic value you wish to correlate is part of the sent value, it is not found. For 

example, in wlHttp.FormData[“data”]=”session*1234” or 

wlHttp.FormData[“data”]=”<xml><data sessionid= 1234/><xml>”, if 

only 1234 is dynamic, normal auto-discovery does not find this value. 

Note: The only exception is in POST and GET commands, where the parameter name 

or values are replaced. 

 Dynamic URLs – Similar to partial values, if a URL contains a dynamic value, it is 

not found. For example, in 

http://www.mydomain.com/2131231/something.asp, if only 2131231 is 

dynamic, normal auto-discovery does not find this value.. 

 Non-standard query strings – Similar to partial values and dynamic URLs, if a 

value appears to be a URL but uses a different encoding method, it is not found. 

For example, in 

http://www.domain.com;strange=4342?normal=44&other=222, normal 

auto-discovery finds normal=44 and other=222, but does not find strange=4342. 

 Using the referer header – When available, auto-discovery uses the referer header 

and only searches for values there. Values that need to be correlated may be 

elsewhere. 

 Filter noise – By default, auto-discovery filters out values that are too short or have 

a low score. In some cases, required rules may also be filtered out. 

To perform correlation with auto-discovery of rules for a specific value: 

1. Select the value you wish to correlate in the Agenda. 

2. Click Correlation in the Home tab of the ribbon and select Correlation Script for 

Specific Value from the drop-down list. 
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-Or- 

Right-click and select Correlate Specific Value. 

The Correlation Specific Value dialog box appears, displaying the selected value. 

3. Click OK. 

WebLOAD performs a regular correlation with auto-discovery of rules. The 

Perform Script Correlation dialog box appears (Figure 61). 

4. Click Save and Continue to save the changes in your Agenda and perform 

correlation. 

-Or- 

Click Don’t Save and Continue to perform correlation without saving the changes 

in your Agenda. 

-Or- 

Click Cancel to close the Perform Script Correlation dialog box without performing 

correlation in your Agenda. 

Setting the Default Correlation Action 

You can control the default correlation action that WebLOAD should perform after 

recording. 

To control which correlation action is performed after recording: 

1. Click Recording and Script Generation Options in the Tools tab of the ribbon. 

The Recording and Script Generation Options dialog box appears (Figure 107). 

2. Select the Correlation Options tab. 

The Correlation Options tab moves to the front of the dialog box (Figure 113). 

3. In the Correlation level drop-down, select one of the following: 

 Do not run – When recording is complete, go directly to the Agenda without 

performing correlation. You can run the correlation engine at a later time. 

 Use existing rules – Run the correlation engine once the Agenda recording is 

complete, only using the existing rules (do not try to auto-discover new rules). 

 Discover rules – Run the correlation engine using existing rules and try to 

discover new rules. 
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 Prompt – A dialog that provides you with all of the options is displayed when 

the recording is complete. This is the default setting. For more information on 

using the Recording Complete dialog box, see Recording an Agenda (on page 34). 

Automatic Discovery of Correlation Rules 

WebLOAD enables you to automatically discover potential correlation rules. 

The discovery process is based on reverse scanning of the agenda. The auto-discovery 

module searches for the sent values in previous responses and tries to formulate rules 

to extract the values. 

Notes: 

 Not all of the suggested rules are usually needed. Select the rules that are 

appropriate for your application. You can run auto-discovery as many times as 

needed, and try different rules. 

 There are some rule types that are not automatically discovered and you must 

manually define a rule for them. 

When running correlation with auto-discovery, the correlation engine uses the existing 

defined rules and does not discover them again. Inactive rules are also not 

rediscovered or used. Making a rule inactive can be used to prevent discovering rules 

that you already know are unneeded. 

When the correlation process is complete, a review form is displayed for the user to 

choose which rules to use. For more information see Approving the Correlation Engine 

Rules on page 92. 

Approving the Correlation Engine Rules 

When performing Auto-discovery correlation, the correlation engine compiles a list of 

the suggested correlation rules according to the dynamic values that were recorded in 

the Agenda. This enables you to determine which rules to approve and use during the 

correlation. 

To approve the correlation engine rules: 

1. After running correlation with auto-discovery of rules, the Correlation engine 

results dialog box appears. 
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Figure 62: Correlation Engine Results Dialog Box 

2. Edit the rules in the Correlation Engine Results dialog box according to the 

following table and click OK. 

Table 9: Correlation Engine Results Dialog Box Options 

Column / Field Description 

Use Select the rules to use in this agenda. You can click Check All to select all 

of the rules in the Use and Add as permanent columns or Uncheck All to 

deselect all of the rules in both columns. 

Note: You can use the rule in the current Agenda, without adding 

it as a permanent rule. 

Field Name The field name that was used to send the value in the request. 

This field may be empty if it is defined in the rule. 

Value The value extracted or replaced. 

Node ID The node ID in the Agenda. Each Agenda node is marked with a 

comment indicating the node ID, for example: 

/***** WLIDE - URL : http://ww.mydomain.com/ - ID:42 

*****/ 

Node URL The GET or POST request of the value extracted or replaced. 

Rule Group The name of the group to which the correlation rule belongs. 

Rule Name The name of the correlation rule. 
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Column / Field Description 

Add as 

permanent 

Select the rules to add to the list of permanent correlation rules. You can 

click Check All to select all of the rules in the Use and Add as permanent 

columns or Uncheck All to deselect all of the rules in both columns. 

Rule details  

Rule Type The method used to find the dynamic data to be correlated, according to 

the selected rule’s definition. To modify the rule, see Defining Correlation 

Rules on page 99.  

Possible values are: 

 All body text 

 Form field values 

 User defined 

 Replace with expression 

 Search in cookies 

… Additional rule type fields. These fields change according to the rule 

type. 

Description A summary of the selected rule’s details. 

 

Resolving Conflicts between Manual Changes and 

Correlation Changes 

Starting from WebLOAD 10.1, when you run correlation all the manual changes you 

may have made in the original JavaScript code are preserved by default (see 

Configuring the Correlation Options on page 175). However, the process of correlation 

also introduces some changes into the original JavaScript. Sometimes your manual 

changes conflict with the correlation changes. When this happens, a Conflict 

Resolution window appears in which you are asked to resolve the conflict. 

Figure 63 shows a sample Conflict Resolution window. 
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Figure 63: Conflict Resolution Window 

The left side of the Conflict Resolution window displays the correlated version without 

any user changes, and the right side displays the user version without any correlation 

changes. You must do one of the following: 

 Click Use correlated version – This keeps all correlation changes and discards all 

user changes. 

 Click Use user version – This keeps all user changes and discards all correlation 

changes. 

 Click Edit conflict – This enables editing the JavaScript to your satisfaction. When 

you select this option, a WinMerge window appears by default. For information, 

refer to Editing Conflicts between Manual Changes and Correlation Changes below. 

When you finish editing, click Resolved in the Conflict Resolution window.  

Editing Conflicts between Manual Changes and 
Correlation Changes 

When you select to edit conflicts between manual changes and correlation changes, a 

merge tool is automatically launched, displaying the two conflicting versions.  
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The default merge tool is the WinMerge application. Note that you can optionally 

specify a different merge tool, as described in Defining the Merge Tool Application (on 

page 198). 

 

Figure 64: WinMerge Conflict Resolution Window 

1. Select the lines you wish to edit, and edit them as desired. 

2. Save your changes. 

3. Exit the WinMerge application.  

Configuring the Correlation Rules 

WebLOAD IDE enables you to configure the correlation rules used to define the 

correlation actions in your Agenda with the Correlation Rules Editor. You can modify, 

create, and rename the correlation rules and groups. 

Opening the Correlation Rules Editor 

Open the Correlation Rules Editor to view the correlation rules. 

To open the Correlation Rules Editor: 

 Click Correlation in the Home tab of the ribbon and select Correlation Rules 

Editor from the drop-down list. 
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The Correlation Rules Editor opens, displaying application- and development 

framework-specific correlation rules by groups. 

 

Figure 65: Correlation Rules Editor 

The following table describes the options in the Correlation Rules Editor. 

Table 10: Correlation Rules Editor Options 

Field Description 

Default rule set Displays a tree of the correlation rules. Each node represents a correlation 

rule group. You can expand the group nodes to view the associated 

correlation rules. 

The order of the correlation rules in the tree determines the order of their 

execution. 

You can configure the correlation rules by selecting the checkbox adjacent 

to the rule that you want to apply in the correlation. You can expand or 

compress the tree using the +/- buttons. If an upper level component is 

selected, all of the subcomponents in that tree will be selected. If only 

some subcomponents in a tree are selected, the upper level component is 

selected and greyed. 

Description Displays a description of the correlation group or rule. The type of 

information displayed in this area depends on the node selected in the 

Default rule set area. 
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Field Description 

New Group Create a new correlation rule group below the selected group. If no group 

is selected, the new correlation rule group is created after the last group 

node. 

New Rule Create a new correlation rule below the selected rule. If no rule is selected, 

the new correlation rule is created after the last rule in the selected group. 

Move Up Move the selected correlation rule up inside its group or move the selected 

correlation group up in the tree. 

Move Down Move the selected correlation rule down inside its group or move the 

selected correlation group down in the tree. 

Delete Delete the selected correlation rule or group. 

Rename Rename the selected correlation rule or group. 

OK Accept your changes and close the Correlation Rules Editor dialog box. 

Cancel Discard your changes and close the Correlation Rules Editor dialog box. 

 

Creating Correlation Rules 

You can create correlation rules and groups to better suit your correlation 

requirements. 

To create a correlation rule: 

1. Click Correlation in the Home tab of the ribbon and select Correlation Rules 

Editor from the drop-down list.  

The Correlation Rules Editor dialog box opens (see Figure 65). 

2. In the Default rule set area, select the correlation rule under which you wish to 

create your correlation rule and click New Rule, 

-Or- 

Right-click the correlation rule under which you wish to create your correlation 

rule and select New Rule from the pop-up menu. 

A new rule is created in the tree, at the specified location. 

3. Modify the correlation rule parameters, as described in Defining Correlation Rules 

(on page 99). 

4. Click OK. The new correlation rule is added to the Default rule set. 
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To create a correlation group: 

1. Click Correlation in the Home tab of the ribbon and select Correlation Rules 

Editor from the drop-down list. 

The Correlation Rules Editor dialog box opens (see Figure 65). 

2. In the Default rule set area, select the correlation group under which you wish to 

create your group and click New Group, 

-Or- 

Right-click the correlation group under which you wish to create your group and 

select New Group from the pop-up menu. 

A new group is created in the tree, at the specified location. 

3. Click OK. 

Defining Correlation Rules 

You can modify the existing correlation rules and groups to better define your 

correlation requirements.  

To modify an existing correlation rule: 

1. Click Correlation in the Home tab of the ribbon and select Correlation Rules 

Editor from the drop-down list. 

The Correlation Rules Editor dialog box opens (see Figure 65). 

2. In the Default rule set area, expand a correlation rule group. 

The correlation rules belonging to the group are displayed. 

 

Figure 66: Correlation Rule Group – Expanded 

3. Click a correlation rule. The Correlation Rules Properties appear. 
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Figure 67: Correlation Rule Properties 

Note: The Match by fields vary according to the value selected in the Rule type field. 

4. Modify the correlation rule properties according to the information in the 

following table: 

Table 11: Correlation Rule Properties  

Field Search 
Scope Value 

Match by 
Field 

Description 

Description   A free text description of the selected rule. 

Rule type   Determines the method used to find the 

dynamic data to be correlated. Possible rule 

type values are: 

 All body text 

 Form field values 

 User defined 

 Replace with expression 

 Search in cookies 
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Field Search 
Scope Value 

Match by 
Field 

Description 

 All body text  Search for dynamic data in the entire body of 

the HTTP response, not only in the links and 

forms. The dynamic data is uniquely 

identified by a combination of the Prefix and 

Suffix parameters. 

For example, if the dynamic data you wish to 

correlate appears as follows: 

SessionID=1234&Day, 

then SessionID= should be defined as the 

Prefix and & should be defined as the Suffix. 

  Prefix A text string that is used together with the 

Suffix parameter to uniquely identify the 

dynamic data string. The dynamic string 

should start immediately after the Prefix 

parameter. 

  Suffix A text string that is used together with the 

Prefix parameter to uniquely identify the 

dynamic data string. The dynamic string 

should end immediately before the Suffix 

parameter. 

  Prefix 

Instance 

The occurrence instance of the Prefix in the 

search scope. That is, if the Prefix parameter 

appears multiple times in the body text and 

you want to correlate only the second 

instance, select 2. 

 Form Field 

values 

 Search for dynamic data in specific form 

fields, regardless of if they are hidden. You 

can specify either a form field name or ID. For 

example, if you specify a form field ID, then 

the correlation engine will only search for 

form field IDs and not for form field names. 

  By ID Specify a form field ID to be searched. 

  By Name Specify a form field name to be searched. 

 User defined  Search for dynamic data according to your 

own search criteria. 
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Field Search 
Scope Value 

Match by 
Field 

Description 

  JavaScript 

expression 

Specify a JavaScript expression to be used as 

an extraction logic. This can be a valid regular 

expression, DOM access function, or any other 

function call. For example: 

extractValue (“prefix”, “suffix”, 

document.wlSource ) 

To call a custom JavaScript function, the 

function must be accessible for both the 

execution engine and the correlation engine, 

so it should be included as an auto-discovered 

JavaScript code. 

For more information on the auto-discovery of 

JavaScript files, see JavaScript Language 

Extension, in the WebLOAD Extensibility SDK. 

  Save Source Select this option if your JavaScript expression 

refers to the response body 

(document.wlSource). 

 Replace with 

expression 

Expression Replace data according to the Field name, 

regardless of the value. Replace the value with 

the value in Expression. 

For example: 

Rule type = Replace with 

expression 

Expression = new Date().getTime() 

Field name = timestamp 

During correlation, the timestamp value is 

replaced with “newDate().getTime()” instead 

of the date on which the Agenda was 

recorded.  

 Search in 

cookies 

Cookie name Search for dynamic data among the received 

cookies, according to the Cookie name. 

Replace the dynamic data in the query string 

or post data request. 

Note: In most cases, cookies sent by the 

server (in a Set-Cookie header) are 

echoed back by the client (in a Cookie 

header). WebLOAD’s engine 

automatically handles these cases and 

they do not require correlation.  

Select this rule type when the value 

received in the cookie is used elsewhere 

in the request (using JavaScript) and 

correlation is necessary.  
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Field Search 
Scope Value 

Match by 
Field 

Description 

Correlation settings 

Minimum 

Length 

  Define the minimum length of the value to be 

considered for correlation. Shorter values, 

even if matched by a rule, are ignored. 

Correlate 

exact 

matches only 

  Select this option to replace the identified 

dynamic value with a variable only when the 

values are a complete match. If the value 

found is only a part of the sent value, the rule 

will be ignored.  

For example, if the dynamic value found is 

“1234”and the variable replacing the dynamic 

value contains “123”: 

 When Correlate exact matches only is 

unchecked, the value “1234” will be 

replaced by the variable and then a “4”.  

 When Correlate exact matches only is 

checked, the value will not be replaced 

since it is not an exact match. 

Note: The values within a query string 

are also considered a complete match. 

For example, if the dynamic value is 

found in the following string, 

wlHttp.Get(http://domain?field=123), the 

dynamic value “123” will be replaced by 

the variable regardless of whether the 

Correlate exact matches only is checked. 

By default this is selected. 

Field name   Replace the dynamic value only when the 

value is sent with this field name. 

Note: The Field name limits where the 

value can be replaced and is applicable to 

all rule types. Do not confuse this with 

the Search in: Form field values: by name 

field, which controls how the value is 

extracted 

This field is optional, unless Replace with 

Expression is selected, in which case, this field 

is mandatory.  

 

5. Click OK.  

The correlation rule is modified. 
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Renaming Correlation Rules 

You can rename correlation rules and groups to better organize the correlation rules 

according to your specific correlation requirements. 

To rename a correlation rule: 

1. Click Correlation in the Home tab of the ribbon and select Correlation Rules 

Editor from the drop-down list.  

The Correlation Rules Editor dialog box opens (see Figure 65). 

2. Expand the correlation group to which your correlation rule is associated. 

3. Slow double-click the correlation rule, 

-Or- 

Right-click the correlation rule and select Rename from the pop-up menu. 

The correlation rule’s name becomes editable. 

4. Rename the correlation rule and click anywhere in the Default rule set area. 

The correlation rule is renamed. 

To rename a correlation group: 

1. Click Correlation in the Home tab of the ribbon and select Correlation Rules 

Editor from the drop-down list. 

The Correlation Rules Editor dialog box opens (see Figure 65). 

2. Slow double-click a correlation group, 

-Or- 

Right-click a correlation group and select Rename from the pop-up menu. 

The correlation group’s name becomes editable. 

3. Rename the correlation group and click anywhere in the Default rule set area. 

The correlation group is renamed. 

Session Management 

The HTTP protocol has no built-in method of uniquely identifying or tracking a 

particular user or session within an application, without transmitting some data 
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between the client and the server. The most common method for an internet 

application developer to track a user’s interaction with a website is by providing the 

user with a unique session ID. This process is referred to as session management. Most 

Web servers generate such session IDs for internet application developers. In such 

cases, the Web servers can communicate the session IDs between the user’s internet 

browser and the server through: 

 Cookies – When a server receives a request to create a session, it creates a session 

object and associates this object with a session ID. The session ID is then 

transmitted back to the browser as part of a response header and is stored with the 

rest of the cookies in the browser. On subsequent requests from the browser, the 

session ID is transmitted as part of the request header, which enables the 

application to associate each request for a session ID with the previous requests 

from that user. The entire interaction between the browser, application server, and 

the application is transparent to the end user. 

 URL rewriting – The session ID information is embedded by the server in the URL 

and is then received by the application with the HTTP GET command (for 

example, when the client clicks on an embedded link within a page). 

 Hidden form fields – The session ID information is stored within the fields of a 

form and submitted to the application. Typically, the session ID information is 

embedded within the form as a hidden field and is submitted with the HTTP 

GET/POST command. 

The following sections provide information on how some of the most commonly used 

Web and application servers perform session management. 

IBM WebSphere Application Server 

The IBM WebSphere Application Server (WAS) supports all the session management 

methods listed in Session Management (on page 104), but works best with cookies 

(which is its default method). The WAS implementation of this method differs from a 

pure cookie-based method by using only one cookie, JSESSIONID, that contains only 

the session ID information. (A pure cookie-based method would use multiple cookies, 

containing possibly sensitive user state information, such as an account number or user 

ID.) JSESSIONID is used by the server to associate the request with the information 

already stored on the server for that session ID. 

In an HTTP session, all the attributes associated with a user’s request are stored on the 

server. Since the only information transmitted between the server and the browser is 

the session ID cookie, which has a limited lifetime, an HTTP session can provide a 

much more secure session management method than cookies, when configured in 

conjunction with SSL. 
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Microsoft ASP.NET 

Microsoft ASP.NET uses HTTP cookies to send a user a unique session key. For 

example, an ASP.NET application that uses sessions can respond to a user’s request 

with the following HTTP header: 

Set-Cookie: ASPSESSIONID=PUYQGHUMEAAJPUYL; path=/Webapp 

Any subsequent request made by this browser to the same server, in the virtual 

directory /Webapp, includes the following HTTP cookie header: 

Cookie: ASPSESSIONID=PUYQGHUMEAAJPUYL 

Each active ASP.NET session is identified and tracked using a 120-bit session ID string 

containing only the ASCII characters that are permitted in URLs. These session ID 

values are generated using an algorithm that guarantees a unique and random result. 

Such a guarantee is required to ensure that sessions do not collide and to prevent 

malicious user interference. These session ID strings are communicated between the 

client and server either by means of an HTTP cookie or a modified URL with the 

session ID string embedded, depending on how the application is configured. 

Apache Server 

An Apache server (version 1.3 onwards) uses cookies to identify a new user and then 

records access to the application identified by this unique ID, through the 

mod_usertrack module. When a user first visits the application, that user is sent a 

cookie with a unique ID. This unique ID is maintained until a predetermined timeout, 

thus enabling the server to track the user. This method enables the identification of 

different users even if they appear to originate from the same IP address. With Apache 

servers, the CookieName directive configures the name of the cookie that is stored. 
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Chapter 8 

Running and Debugging Agendas 

This section provides instructions for running and debugging Agendas with 

WebLOAD IDE. 

About Running and Debugging Agendas with 

WebLOAD IDE 

When you run your Agenda, WebLOAD IDE interacts with your Web application just 

as a real user would. WebLOAD IDE runs your Agenda line by line. As your Agenda 

executes, execution arrows are displayed in the left margin of the Agenda Tree and the 

JavaScript View pane, showing your progress. 

Unless otherwise configured in the project options, the test session will log and 

continue on Minor Errors encountered during runtime. Severe Errors will cause 

WebLOAD IDE to stop the entire test. If WebLOAD IDE encounters HTTP errors that 

are undefined by WebLOAD, the test session logs them and continues running. 

Messages, test failures, and differences are indicated by messages in the Log View 

Window. 

After running an Agenda, you can debug it. WebLOAD IDE enables you to check that 

the Agenda runs smoothly without errors, offers step controls to run through the 

Agenda step-by-step, breakpoints, and various view and windows to monitor 

variables. 

Running an Agenda 

This section provides instructions for running an Agenda. 

Before running an Agenda, you can do the following: 

 Set the number of iterations to run, see Setting Playback Options (on page 195). 

 Set the file locations for a test session, see Setting File Locations (on page 196). 
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 Set WebLOAD IDE to ignore the recorded sleep time, see Configuring Sleep Time 

Control Options (on page 147). 

Starting the Execution of an Agenda 

To execute the Agenda: 

1. In the main window, click Open in the File tab of the ribbon and open the Agenda 

you want to edit. 

2. Click Run in the Home or Debug tab of the ribbon, 

-Or- 

Click Step Into in the Debug tab of the ribbon to run the Agenda step-by-step. 

The Agenda runs and displays the following: 

 A sequence of the events generated by the Agenda in the Execution Tree. 

 The execution sequence in the JavaScript View pane and the Agenda Tree. 

 If the Page View tab is open, the pages returned from the Web site. 

Note: If you specified more than one playback iteration, you are returned to the 

beginning of the script (for information on playback iteration, see Setting Playback 

Options on page 195). 

Viewing the Execution Sequence in the Agenda Tree 

When you run your Agenda, WebLOAD IDE interacts with your Web application just 

as a real user would. WebLOAD IDE runs your Agenda line by line. Execution arrows 

are displayed in the left margin of the Agenda Tree. When you select a node in the 

Agenda tree, the corresponding information is displayed in each of the available views. 

For example, the Page View displays the page you have requested from the server, the 

HTML View displays the HTML of that page, and the HTTP Headers View displays 

the request and response’s headers. For more information, see Viewing and Analyzing 

the Test Results (on page 123). 

WebLOAD IDE enables you to do the following: 

 Run through the entire Agenda line by line, and add breakpoints (see Debugging an 

Agenda on page 114). 

 Display the Current Project Options by right-clicking the Agenda root node and 

clicking Current Project Options from the pop-up menu,  

-Or- 
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Click Current Project Options in the Tools tab of the ribbon (see Configuring the 

Default and Current Project Options on page 143). 

-Or- 

Select Current Project Options from the IDE System button (see Configuring the 

Default and Current Project Options on page 143). 

To view the Agenda Tree: 

 In the main window, click Visual Agenda in the Home tab.  

By default, the Agenda Tree pane appears at the top left of the main window, to 

the right of the WebLOAD IDE Toolbox pane.  

 

Figure 68: Agenda Tree Pane 

Viewing the Execution Sequence in the JavaScript View 
Pane 

JavaScript View displays the complete JavaScript of your Agenda with an execution 

arrow tracking its progress during runtime.  

WebLOAD IDE enables you to do the following: 

 Run through the entire Agenda line by line, add breakpoints, and add Watch 

variables (see Debugging an Agenda on page 114). 

 Check the syntax by right-clicking in the Agenda and clicking Check Syntax from 

the pop-up menu. 
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To view the JavaScript View: 

 In the main window, select the JavaScript View checkbox in the View tab. 

 

Figure 69: JavaScript View 

Viewing the Response Data in the Execution Tree 

As you execute an Agenda, WebLOAD IDE displays the actions performed during 

runtime in the Execution Tree. The Execution Tree is an interactive tree that you can 

use to examine the results. 

 

Figure 70: Execution Tree 
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Comparing Recorded Sequence Against Execution 
Sequence 

You can view the recorded sequence alongside the execution sequence using the side 

by side view feature. This can help you manually discover differences between the 

original recorded session and the playback. 

Side by side view is available for the Browser, HTTP Headers, and HTML Views. 

To view the recorded sequence side by side with the execution sequence: 

 Select Side by Side in the Session tab of the ribbon. 

The recorded sequence is displayed to the left of the execution sequence. 

Note: This feature is only available after complete running an execution sequence, not 

at the beginning of an execution sequence. 

 

Figure 71: Side by Side View 
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Stopping the Execution of an Agenda 

When debugging an Agenda using a Step Into or breakpoint, the playback session 

stops immediately upon completion of the current WebLOAD IDE protocol block.  

To stop the execution of an Agenda: 

 Click Stop in the Home tab of the ribbon, 

-Or- 

Use the hotkeys Shift + F5. 

The playback session is stopped. 

Debugging Agendas 

WebLOAD IDE provides an integrated debugger with a variety of tools to help locate 

bugs in your Agenda. The debugger provides special menus, windows, dialog boxes, 

and grids of fields for debugging. You can pause the debugger and trigger WebLOAD 

IDE to wait for user input before proceeding with running the Agenda. In the Agenda, 

you can set breakpoints and step into / over / out. While debugging your Agenda, you 

can abort the debugger without executing the TerminateClient and 

TerminateAgenda functions, as opposed to stopping it completely. 

Debug Tab Items 

Commands for debugging can be found on the Debug tab of the ribbon. 

 

The Debug tab contains commands to start the debugging process. 

The following options are available through the Debug tab. 
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Table 12: Debug Tab Options 

Tab Item Description 

Execution group 

Run Starts playback of the Agenda script from the current statement 

until a breakpoint or the end of the Agenda is reached. 

Stop Stops the playback of the Agenda script. 

Abort Stops the playback of the Agenda script without executing the 

TerminateClient or TerminateAgenda functions. 

Debug group 

Step Into  Starts the play back of the Agenda script, a step at a time, 

entering each function encountered. 

Step Over  Starts the playback of the Agenda, one step at a time. When a 

function is reached, it is executed without stepping through the 

function. 

Step Out  Plays through the remaining steps of the called function, and 

stops on the line in the Agenda immediately following the 

function call. Using this command you can quickly finish 

executing the current function after determining that a bug is not 

present in the function. 

Break Execution Stops the playback of the Agenda at that point. 

Toggle 

Breakpoint  

Defines a line in the Agenda where WebLOAD IDE suspends 

execution. 

Remove all 

Breakpoints  

Eliminates all breakpoints. 

Disable/Enable 

all Breakpoints  

Disable or enable all breakpoints. 

Edit Breakpoints Displays the Breakpoints dialog box, enabling the setting of 

breakpoints. 

Debug Windows group  

Watch Window Toggles the displays of the Watch window (available only during 

runtime in debug mode), which displays the names and values of 

variables and expressions.. 

Variables 

Window 

Toggles the display of the Variables window (available only 

during runtime in debug mode) which displays information 

about variables used in the current and previous statements and 

functions.. 

Call Stack Toggles the display of the Call Stack window which lists the 

function calls that led to the current statement, with the current 

function on the top of the stack.. 
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Debugging an Agenda 

When debugging an Agenda, you can set the Agenda to run in the following ways: 

 Step-by-step – The execution starts at the first line of the Agenda and stops at each 

subsequent line. 

 Breakpoints – The execution starts at the first line of the Agenda and stops when it 

reaches a breakpoint. 

 A combination of step-by-step and breakpoints. 

To debug an Agenda: 

1. Click Run or Step Into in the Debug tab of the ribbon. 

2. When you reach the end of the script you can: 

a. Click Step Into in the Debug tab to return to the beginning of the script. 

b. View results (see Viewing and Analyzing the Test Results on page 123). 

c. Add breakpoints (see Setting Breakpoints on page 114). 

3. Return to Edit mode and revise your Agenda. 

Starting the Debugger 

To start debugging: 

 Click Run in the Debug tab to run the Agenda continuously, 

-Or- 

Click Step Into in the Debug tab to run the Agenda step-by-step. 

Setting Breakpoints 

Use breakpoints to define places in the Agenda to suspend execution. Breakpoints can 

be set in Edit mode and in Debug mode. The breakpoints you set will be saved as a 

part of your WebLOAD IDE project. 

To set multiple breakpoints to an Agenda: 

1. Display the entire Agenda. 

2. Select the line of code. 

3. Click Edit Breakpoints in the Debug tab. 

The Breakpoints dialog box opens. 
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Figure 72: Breakpoints Dialog Box 

4. Click the arrow next to the Break at field. 

The Breakpoint options appear. 

 

Figure 73: Breakpoint Dialog Box Options 

5. Click the Line number. 

The Line number is added to the list of breakpoints. 

6. To add context to the breakpoint, click the arrow again, and click Advanced. 

The Advanced Breakpoint dialog box opens. 
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Figure 74: Advanced Breakpoint Dialog Box 

7. Fill in the fields, and click OK. 

To set a breakpoint in the Agenda Tree: 

1. Right-click an item in the Agenda Tree. 

2. From the pop-up menu, click Toggle Breakpoint. 

A red dot appears in the left margin of the JavaScript View pane adjacent to the 

selected code and in the Agenda Tree adjacent to the visual Agenda element for 

which the breakpoint is defined, indicating that the breakpoint is set. 

To set a breakpoint in the JavaScript View pane: 

1. Select the JavaScript View checkbox in the View tab to open the JavaScript View 

pane. 

2. In the Agenda Tree, click the Agenda root node to display the entire Agenda in the 

JavaScript View pane. 

3. In the JavaScript View pane, select the line of code where you want the Agenda to 

wait. 

4. Right-click and select Toggle Breakpoint from the pop-up menu, 

-Or- 

Click Toggle Breakpoint in the Debug tab. 

A red dot appears in the left margin of the JavaScript View pane adjacent to the 

selected code and in the Agenda Tree adjacent to the visual Agenda element for 

which the breakpoint is defined, indicating that the breakpoint is set. 

To set a breakpoint in Debug mode: 

1. Run the Agenda by clicking Step Into in the Debug tab. 

2. Continue stepping through the Agenda until reaching the point you want to insert 

the breakpoint. 
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3. In the JavaScript View pane, select the code where you want to insert in 

breakpoint. 

4. Click Toggle Breakpoint in the Debug tab. 

While in debug mode a red dot appears in the left margin of your Agenda code, 

indicating that the breakpoint is set. 

Running to a Breakpoint 

To run until a breakpoint is reached: 

1. Set a breakpoint (see Setting Breakpoints on page 114). 

2. Click Run in the Debug tab  

Click Step Into in the Debug tab to run the Agenda step-by-step. 

Removing Breakpoints 

You can remove individual breakpoints or remove all breakpoints in the Agenda. 

To remove a breakpoint: 

1. Select the JavaScript View checkbox in the View tab to open the JavaScript View 

pane. 

2. In the Agenda Tree, click the Agenda root node to display the entire Agenda in the 

JavaScript View pane. 

3. In the JavaScript View pane, select the line containing the breakpoint you want to 

remove. 

4. Click Toggle Breakpoint in the Debug tab. 

The red dot in the left margin disappears. 

To remove all breakpoints: 

1. Select the JavaScript View checkbox in the View tab to open the JavaScript View 

pane. 

2. In the Agenda Tree, click the Agenda root node to display the entire Agenda in the 

JavaScript View pane.  

3. Click Remove all Breakpoints in the Debug tab 

The red dot in the left margin disappears. 
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Disabling and Enabling All Breakpoints 

You can disable or enable all breakpoints in the Agenda. 

To disable or enable all breakpoints: 

1. Select the JavaScript View checkbox in the View tab to open the JavaScript View 

pane. 

2. In the Agenda Tree, click the Agenda root node to display the entire Agenda in the 

JavaScript View pane. 

3. Click Disable/Enable Breakpoints in the Debug tab. 

 When all of the breakpoints are disabled, the red dots in the left margin turn 

white. 

 When all of the breakpoints are enabled, the white dots in the left margin turn 

red. 

Stepping Into the Agenda 

To run the Agenda and execute one statement at a time (Step Into): 

1. Click Run or Step Into in the Debug tab. 

The debugger executes the next statement and then it pauses execution. If you step 

into a nested function call, the debugger steps into the most deeply nested 

function. 

2. Repeat step 1 to continue executing the Agenda one statement at a time.  

To step into a specific function: 

1. Set a breakpoint just before the function call or use the Step Into command to 

advance the Agenda execution to that point. 

For information on setting breakpoints see Setting Breakpoints (on page 114). 

2. Click Step Into in the Debug tab. 

Stepping Out or Over a Function 

To step over a function: 

1. Click Run or Step Into in the Debug tab. 

2. Execute the Agenda to the function call. 

3. Click Step Over in the Debug tab. 
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The debugger executes the next function, but pauses after the function returns. 

4. Continue executing the program. 

To step out of a function: 

1. Click Run or Step Into in the Debug tab and execute the program to some point 

inside the function. 

2. Click Step Out in the Debug tab. 

The debugger continues until it has completed execution of the return from the 

function, then pauses. 

Stopping the Playback of the Agenda 

You can stop the playback of the Agenda at a specific point. Stopping an Agenda 

executes the TerminateClient or TerminateAgenda functions. 

To stop the playback of the Agenda: 

1. Start debugging. Click Run or Step Into in the Debug tab. 

2. Click Break Execution in the Debug tab. 

The Agenda stops running. You can continue the playback from this point, at a 

later time. 

3. Click Stop in the Debug tab. 

The Agenda stops running. Continuing the playback from this point is not 

possible. 

Aborting the Playback of the Agenda 

You can abort the playback of the Agenda at a specific point. Aborting an Agenda does 

not execute the TerminateClient or TerminateAgenda functions. 

To abort the execution of an Agenda: 

 Click Abort in the Debug tab. 

The playback session is aborted. 

Using the Watch Window 

The Watch window is used for debugging your application, and is only available when 

you are running your Agenda. The Watch window displays the values of selected 
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variables or watch expressions that you specify while debugging your Agenda. The 

values of the variables and expressions in the Watch window are only updated when 

execution is stopped at a breakpoint. 

Use the Watch window to specify variables and expressions that you want to watch 

while debugging your program. You can also modify the value of a variable using the 

Watch window. To add a watch variable, see Adding a Watch Variable or Expression (on 

page 121). 

To open the Watch window: 

 Select the Watch Window checkbox in the Debug tab. 

 

Figure 75: Watch Window 

The Watch window contains four tabs: 

 Watch1 

 Watch2 

 Watch3 

 Watch4 

Each tab displays a user-specified list of variables and expressions in a grid field. You 

can group variables that you want to watch together onto the same tab. For example, 

you could put variables related to a specific page on one tab and variables related to 

second page on another tab. You could watch the first tab when debugging the first 

page and the second tab when debugging the second page. 

If you add an array variable to the Watch window, plus sign (+) or minus sign (-) boxes 

appear in the Name column. You can use these boxes to expand or collapse your view 

of the variable. 

Viewing the Value of a Variable in the Watch Window 

You can view the value of a variable in the Watch window. 

To view a variable or expression in the Watch window: 

1. Start debugging. Click Run or Step Into in the Debug tab of the ribbon. 

2. Select the Watch Window checkbox in the Debug tab to open the Watch window. 
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In the Name column, plus sign (+) or minus sign (-) boxes may appear. These 

appear if you added an array or object variable to the Watch window. Use these 

boxes to expand or collapse your view of the variable. 

Adding a Watch Variable or Expression 

You can add a watch variable or expression to the Watch window, while you are 

running your Agenda. Valid expressions accepted in the Watch window include any 

valid JavaScript expression that can be added to the Agenda. 

The Watch dialog box is equivalent to using the JavaScript eval function. Using the 

eval function you can define a variable and its value. In the same way, you can use 

the watch dialog box to define values for variables used throughout an Agenda.  

For example, if your Agenda contains the variable a, when you type a=10 in the Watch 

window, the engine evaluates the expression as though it were written within the 

Agenda. The result of the expression a=10 would be setting the variable a to 10. Then 

when you type a=a+1 in the watch window, the variable a would be set to 11. The 

value of the variable is always according to the last definition of the variable. So, if you 

type a=2, the variable a would be set to 2 regardless of what the variable’s value was 

beforehand. 

To add a Watch variable or expression in the JavaScript View pane: 

1. Start debugging. Click Run or Step Into in the Debug tab. 

2. Select the JavaScript View option in the View tab to open the JavaScript View 

pane. 

3. In the Agenda Tree, click the Agenda root node to display the entire Agenda in the 

JavaScript View pane. 

4. In the JavaScript View pane, select the line where you want to add the Watch 

variable or expression. 

5. Right-click the variable in the JavaScript View pane, and click Add Watch from the 

pop-up menu. 

The Add Watch dialog box opens. 

 

Figure 76: Add Watch Dialog Box 

6. In the Expression field, type a variable or expression. 

7. Click Add. 
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The variable or expression is added to the Watch window. The Watch window 

evaluates the variable or expression immediately and displays the value or an error 

message. 

If you added an array or object variable to the Watch window, plus sign (+) or 

minus sign (-) boxes appear in the Name column. Use these boxes to expand or 

collapse your view of the variable. 

8. You can optionally edit the name or value of the variable or expression by double-

clicking the name or value that you want to edit. 

Viewing the Variables Window 

The Variables window provides quick access to variables that are important in the 

Agendas current context. 

To open the Variables Window: 

1. Start debugging. Click Run or Step Into in the Debug tab. 

2. Select the Variables Window checkbox in the Debug tab. 

 

Figure 77: Variables Window 

The Variables window displays variables used in the current statement and in the 

previous statement. It also displays return values when you step over or out of a 

function. 

The Variables window contains a grid with fields for the variable name and value. The 

debugger automatically fills in these fields. You cannot add variables or expressions to 

the Variables window (you must use the Watch window, see Adding a Watch Variable or 

Expression on page 121), but you can expand or collapse the variables shown. You can 

expand an array, object, or structure variable in the Variables window if it has a plus 

sign (+) box in the Name field. If an array, object, or structure variable has a minus sign 

(-) box in the Name field, the variable is already fully expanded. 

The Variables window also has a Context dropdown list that displays the current scope 

of the variables displayed. To view variables in a different scope, select the scope from 

the drop-down list box. 
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Viewing the Value of a Variable 

You can view the value of a variable in the Variables window. 

To view a variable in the Variables window: 

1. Start debugging. Click Run or Step Into in the Debug tab. 

2. Select the Variables Window checkbox in the Debug tab to open the Variables 

window. 

Viewing the Call Stack Window 

The Call Stack window lists the function calls that led to the current statement, with the 

current function on the top of the stack. 

To open the Call Stack Window: 

1. Start debugging. Click Run or Step Into in the Debug tab. 

2. Select the Call Stack checkbox in the Debug tab. 

 

Figure 78: Call Stack Window 

Viewing and Analyzing the Test Results 

While recording, editing, and running your Agenda, WebLOAD IDE provides 

information on all major events that occurred during runtime such as failures and error 

messages. You can navigate through the Execution Tree to view the results of your test 

at increasing levels of detail. This technique lets you view detailed information on any 

errors. 

Using the Execution Tree to View Results 

As you execute an Agenda, WebLOAD IDE displays the Web pages accessed in the 

Web application in the Execution Tree. 
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When working with a file JavaScript file that has not been converted to a WebLOAD 

IDE project file, WebLOAD IDE displays a playback node for each HTTP request of the 

JavaScript. 

 

Figure 79: Execution Tree View 
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Using the Page View to View Results 

The Page View displays a visual representation of the baseline set of Web pages in 

your Agenda. This view is available while recording, editing, or running your Agenda. 

To open the Page View: 

1. Select the Page View checkbox in the View tab of the ribbon. 

2. Select the Page View tab. 

 

Figure 80: Page View 

Using the DOM View to View Results 

DOM View displays all of the objects and the structure of the Web page displayed in 

Page View, giving you access to objects not visible in the pages presentation layer.  

DOM View is available when Page View is open, while recording, editing, or running 

your Agenda. When an element is selected in the DOM View, the object is highlighted 

in the Page View. 
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To open the DOM View: 

1. Select the DOM View checkbox in the View tab of the ribbon. 

2. Select the DOM View tab. 

 

Figure 81: DOM View 

Using the HTML View to View Results 

HTML view displays an HTML preview of each page and frame requested in the 

Agenda. When switching between the JavaScript, HTTP Headers, Browser, and HTML 

Views, the new view displays the node that is selected in the Agenda Tree (during edit 

mode) or Execution Tree (during debug mode). These views are available while 

recording, after the recording is finished, and after opening a saved Agenda. 
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To open the HTML View: 

1. Select the HTML View checkbox in the View tab of the ribbon.  

2. Select the HTML View tab. 

 

Figure 82: HTML View 

3. To search for text: 

a. Right-click and click Find from-the pop-up menu. 

b. Type the text you want to find, and click Find Next. 

4. To copy text: 

a. Select the text you want to copy. 

b. Right-click and click Copy from-the pop-up menu. 

Using the HTTP Headers View to View Results 

The HTTP Headers View displays the GET and POST HTTP protocol commands. 

Other commands can also be displayed, such as CONNECT. When switching between 

the various views, the new view displays the node that is selected in the Agenda Tree. 

These views are available while recording, after the recording is finished, during 

playback and debugging, and after opening a saved Agenda. 
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To open the HTTP Headers View: 

1. Select the HTTP Headers View checkbox in the View tab of the ribbon.  

2. Select the HTTP Headers View tab. 

 

Figure 83: HTTP Headers View 

The headers are divided into groups of headers per playback request. For each 

request, only the relevant headers are displayed. 

You can expand the headers to show the form data and all other content. 

 

Figure 84: HTTP Headers 

3. To view all of the headers on the Agenda, click the Agenda root node. 

4. To view headers of a specific round, click the Round node in the Execution tree. 

5. To search for text: 

a. Right-click and click Find... from-the pop-up menu. 
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b. In the Find what field, type the text you want to find. 

The Find what field is case sensitive. 

c. Click Find Next. 

The entire text of the selected node is selected. 

6. To copy text: 

a. Select the text you want to copy. 

b. Right-click and click Copy from-the pop-up menu. 

The entire text of the selected node is copied. 

Using the Log View Window to View Results 

In addition to the results available through viewing the Agenda Tree and the Execution 

Tree, the Log View Window displays the errors encountered during playback and 

additional information about your test session results. 

An Info Message or a minor error will not cause the playback to stop. Similarly, a 

generic message, issued when WebLOAD IDE encounters HTTP errors that are 

undefined by WebLOAD, will not cause playback to stop. A higher level of severity 

(Error or Severe Error) ends the playback upon completion of the WebLOAD IDE 

protocol block. 

To open the Log View Window: 

 Select the Log View checkbox in the View tab of the ribbon. 

By default, the Log View pane appears at the bottom of the main window. 

 

Figure 85: Log View Pane 

The following information is displayed: 

 ! – The result and severity of each message: 

 Information message 

 Minor error message 
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 Error message 

 Severe error message 

 Time – The amount of runtime. 

 Description – The runtime action and information about failed actions, 

including the date and time the action occurred. 

Perfoming a Full Search in the Test Results 

You can search for a specific string in all views at once.  

To search for text in all views: 

1. Select Find All in the Edit tab of the ribbon.  

  

Figure 86: Find All Dialog Box 

2. In the Find what field, type the text you want to find. 

3. Under Look at, specify in which view you wish to search. You can select any 

combination of the following: 

 JavaScript 

 HTTP Headers 

 HTML 

4. Optionally check the Match case checkbox. 

5. Click Find. 

A results pane appears in the bottom half of the screen, displaying all the search 

results. 
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Figure 87: Search Results of the Find All Function 

 The icon to the left of each search result indicates in which page view the result 

appears.  

 Double clicking a search result highlights the result both in the Agenda Tree, and 

in the corresponding page view. 

Printing the Contents of the Log View Window 

To print the contents of the Log View Window: 

1. Right-click inside the Log View window. 

2. Select Print from the right-click menu. 

The Print Setup dialog displays. 

3. Select a printer and click OK. 
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Saving the Contents of the Log View Window 

To save the contents of the Log View Window: 

1. Right-click inside the Log View window. 

2. Select Save from the right-click menu. 

The Save As dialog displays. 

3. In the File Name field, type in the name for the file. 

4. Click Save. 

The file is saved with the extension *.log. 

You can view the saved log file with any text editor. 

Viewing a Log Message 

To view the complete log message: 

1. Right-click an entry in the Log View window. 

2. Select Display Message from the right-click menu. 

The Log Message window with detailed information on the selected entry appears.  

Validating Responses 

WebLOAD IDE enables you to validate a response in an Agenda by adding a response 

validation function. You can validate a Web page’s title, the maximum time taken to 

load the Web page, its content, and the length of its content. You can also determine 

WebLOAD’s behavior if validation fails. During playback, the results of the validation 

process (failure or success) are displayed in the Log View window. 

To add a response validation function: 

1. Select a node in the Agenda Tree. 

2. Click Response Validation in the Home tab of the ribbon. 

-Or- 

Right-click the node and select Response Validation. 

-Or- 

Perform the following: 
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a. Click the HTML View tab to view the node in HTML View. 

b. Select HTML text within the node. 

c. Right-click the selection and click Response Validation. 

The Response Validation dialog box appears. 

Note: When accessing the Response Validation dialog box from HTML View, the 

dialog box appears automatically configured with the selected content. 

 

Figure 88: Response Validation Dialog Box 

3. Configure the responses you wish to validate during playback, according to the 

information displayed in Table 13, and click OK. 

The Response Validation function is added to your Agenda. 
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Table 13: Response Validation Dialog Box Options 

Field Description 

Page Title 

Validate Select to validate the page title. 

Success if Page 

Title is 

The title of the Web page. During playback, if the title of the Web page 

matches the text entered in this field, the validation is successful. 

Recorded page 

title is 

The page title as defined in the HTML <title> tag. 

Page Time 

Validate Select to validate the page time. 

Page Time limit 

x sec 

The maximum number of seconds that may elapse while waiting for the 

Web page to open for the validation to be successful. 

Content length 

Validate Select to validate the content length. 

Equal to x bytes The size of the Web page content, in bytes, must equal the specified value 

for the validation to be successful. 

Greater than x 

bytes 

The size of the Web page content, in bytes, must be greater than the 

specified value for the validation to be successful. 

Lower than x 

bytes 

The size of the Web page content, in bytes, must be less than the specified 

value for the validation to be successful. 

Recorded 

Content Length 

is 

The size of the response, in bytes. 

Content 

Validate Select to validate the content. For a full explanation, refer to Performing 

Multiple Text Validations of Web Page Content (on page 135). 

Success if 

response 

contains/does 

not contain x 

For each JavaScript expression you include in your validation check, 

specify whether it must or must not appear in the Web page for the 

validation to be successful.  

Add Click this button to add a new JavaScript expression to the list of 

validations that must or must not appear in the Web page. 

The string "<text to find>" appears in the box above the button. Delete this 

string and instead do either or both of the following:  

 Enter a text string in quote marks. For example, "Welcome". 

 Enter a parameter without quote marks. For example, TodaysDate(). 

You can click Add Parameter and select a parameter from the list. 

Note that you can concatenate strings and/or parameters to create a 

JavaScript expression. For example: "Welcome" + params_user.getValue().  
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Field Description 

Remove Click this button to delete a selected JavaScript expression from the list of 

validations that must or must not appear in the Web page. 

Add Parameter Opens a list of parameters you can include in the contains/does not 

contain text. This list is identical to the list available in the Insert Variable 

menu (Figure 54). 

In case of validation failure 

Display 

warning and 

continue 

running 

Select to display a warning during playback and continue running the 

Agenda, if the verification fails. 

Display error 

and stop the 

round 

Select to display an error during playback and stop the round, if the 

verification fails. 

Display fatal 

error and stop 

test execution 

Select to display a fatal error and stop running the Agenda, if the 

verification fails. 

Call to JS 

function 

Select to run a specified JavaScript function, if the verification fails. 

Error message 

(Optional) 

Enter an error message to be displayed if the verification fails (optional). 

4. Click OK. The Response Validation function is added to your Agenda. 

Performing Multiple Text Validations of Web Page Content 

You can use the Response Validation feature to validate a Web page’s content.  

To validate the content of a Web page: 

1. Follow the instructions in Validating Responses (on page 132) to access the Response 

Validation dialog box (Figure 88). 

2. In the Content section, check the Validate checkbox. 

3. Click Add.  

The box above the Add button displays “<text to find>”. 
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Figure 89: Defining Content Validation 

4. Define a JavaScript expression and whether it must or must not appear in the Web 

page, as follows: 

a. Delete the string “<text to find>” and instead do either or both of the 

following:  

 Enter a text string enclosed in quote marks. For example, "Welcome". 

 Enter a parameter without quote marks. For example, TodaysDate(). 

Alternatively, you can click Add Parameter and select a parameter from 

the list of predefined parameters. 

Note that you can concatenate strings and/or parameters to create a JavaScript 

expression. For example: "Welcome" + params_user.getValue(). 

b. Select contains if the expression must appear in the Web page;  

select does not contain if it should not appear in the Web page.  

5. Repeat the previous step for every additional expression you wish to define. 

Figure 90 shows a content validation example. In this example, the page content will be 

validated only if it contains the string Welcome followed by a user name, and does not 

contain the string Error.  
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Figure 90: Content Validation Example 

Comparing an Agenda Recording to its Playback 

After running an Agenda test, you can perform a comparison of the original Agenda 

recording and its playback for each node in the Agenda.  

To compare an Agenda node’s recording to its playback: 

1. Select an Agenda node. 

2. Click Compare HTML in the Session tab of the ribbon. 

-Or- 

Right-click a node in the Agenda tree or the Execution Tree and select Compare 

html from the pop-up menu. 

The defined Difference Viewer application launches and automatically compares 

the selected node in the recording and in the playback. For information about 

defining the Difference Viewer application, see Defining the Difference Viewer 

Application (on page 197). 
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Editing an Agenda for Dynamic HTML Pages 

When you record an HTML page in the IDE, there can be dynamic values that 

WebLOAD adds to the Agenda, which are recorded in the IDE. Such dynamic values 

can contain state management information, such as the session-id, which is usually 

passed as URL encoded parameters or hidden form fields. The dynamic values that are 

recorded in the IDE are different during each run. Since the value that was recorded in 

the IDE and the dynamic value do not match, you will receive an error. 

To overcome this situation, you need to edit the Agenda and perform correlation. This 

can be done manually, or by using WebLOAD’s Smart Copy feature. This feature 

enables you to convert the dynamic value into the correct value for the specific session. 

Note: The Smart Copy feature supports converting the dynamic value of the following 

HTML objects: images, links, and form elements. 

Note: Editing the Agenda and performing correlation is not necessary for static HTML 

pages, since they do not contain dynamic values. In this case, the Agenda executes 

smoothly with no need for initial editing. 

To edit an Agenda using Smart Copy: 

1. After recording and running your Agenda, open the Page View with the DOM 

View. Select the DOM View checkbox in the View tab of the ribbon. 

The Page and DOM View appear. 

2. In the Execution Tree, select the first node. 

3. In the Page View, search for an error message. If there is no message, select the 

next node in the Execution Tree and search for a message there. 
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Figure 91: Page View Displaying Error Message 

4. Once you locate the message, open the JavaScript View. Select the JavaScript View 

checkbox in the View tab of the ribbon. 

The JavaScript View appears with the requested block of code selected. 

5. Within the selected block of code, locate the dynamic value (for example, the 

session-id field). This field must be retrieved from the previous block of code. 

 

Figure 92: Dynamic Value in the JavaScript View 
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6. Click the previous node in the Execution Tree to search for the element that 

contains the dynamic value. Make sure the Browser and DOM Views are open. 

Select the Page View and DOM View checkboxes in the View tab of the ribbon. 

7. In the DOM View, locate the element that contains the dynamic value. This is 

usually a hidden input field. 

 

Figure 93: Dynamic Value in DOM View 

Note: You cannot use the value recorded in the Agenda, since the value that was 

recorded was dynamic, and will not match the new value that is given when you run 

the Agenda. 

8. Right-click the element and select Smart Copy from the pop-up menu. 

 

Figure 94: Smart Copy Pop-up Menu 

The Smart Copy dialog box appears. 

 

Figure 95: Smart Copy Dialog Box 

9. Click Copy to clipboard and click OK. 

10. To edit the JavaScript, click Fulll Script in the Home tab of the ribbon. 

11. Create a variable for the dynamic field by typing the following at the end of the 

selected block of code: 

Session_id =  
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12. Paste the clipboard text (using Paste in the Edit tab of the ribbon) after the equal 

sign. 

For example: 

Session_id = document.forms[1].elements[2].value 

13. In the subsequent block of code, replace 

wlHttp.FormData[“session_id”] = <static session id> 

with 

wlHttp.FormData[“session_id”] = session_id 

The Agenda is edited. You can now run the Agenda successfully without receiving 

error messages. 
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Chapter 9 

Configuring the WebLOAD IDE Options 

You can set the following WebLOAD IDE configuration options:  

 Default Project Options – Settings for WebLOAD IDE that will be in effect for 

each Agenda you create. These options are for the playback. 

 Current Project Options – Settings that will override the Default Project Options 

settings. 

 Recording and Script Generation Options – Settings that define the behavior of 

WebLOAD IDE during the recording and script generation of a Web session. 

 Settings – Settings for WebLOAD IDE. 

 Customize – Settings for the toolbar. 

 Parameterization Manager – Settings for replacing a recorded static value in an 

agenda with a random value from a pool of values, or with a whole set of values 

from a file. 

Configuring the Default and Current Project Options 

The Project Options are settings for WebLOAD IDE that will be in effect for each 

Agenda you create.  

 Default Project Options are settings that will be in effect for each Agenda you 

create. Each Agenda created or edited in WebLOAD IDE is automatically assigned 

these defaults. You can modify these settings to your specifications.  

 Current Project Options are settings that will override the Default Project Options 

settings and affect only the currently open Agenda. You can modify these settings 

to your specifications.  

Notes:  

The Current Project Options dialog boxes are the same as the Default Project Options 

dialog boxes except for the title. 

 

You must be in Edit mode to modify the options. 
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Opening the Default and Current Project Options 

To open the Default Project Options dialog box: 

 Click Default Project Options in the Tools tab of the ribbon, 

-Or- 

Select Default Project Options from the IDE System button. 

The Default Project Options dialog box opens with the Sleep Time Control tab 

displayed. 

 

Figure 96: Default Project Option Dialog Box 

To open the Current Project Options dialog box: 

 Click Current Project Options in the Tools tab of the ribbon, 

-Or- 

Select Current Project Options from the IDE System button, 

-Or- 

Right-click the Agenda root node in the Agenda Tree and select Current Project 

Options.  
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The Current Project Options dialog box opens with the Sleep Time Control tab 

displayed.  

 

Figure 97: Current Project Options Dialog Box 

The following table describes the tabs in the Default and Current Project Options 

dialog box. 

Table 14: Default and Current Project Options Dialog Box Tabs 

Tab Description 

Sleep Time Control 

(default) 

Define the behavior of Sleep time during Agenda playback and debug. 

Sleep time is a pause to simulate the intermittent activity of real users. 

Pass/Fail Definition Define the test failure criteria in WebLOAD IDE. 

Browser Parameters Define the Virtual Client behavior. 

Authentication Define the Global and Proxy authentication settings. 

HTTP Parameters Define the HTTP Client behavior on the HTTP protocol level. 

Browser Cache Define the type of cache and when the cache is cleared. 

Diagnostic Define the Diagnostic options that can be enabled while developing an 

Agenda or for tracking problems in existing Agendas.  

Java Options Define the Virtual Machine to be used. 
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Setting Pass/Fail Definitions 

Use the Pass/Fail Definition options to define test failure criteria in WebLOAD IDE. 

To set the Pass/Fail Definition options: 

1. Click Default/Current Project Options in the Tools tab of the ribbon. 

The Default/Current Project Options dialog box opens. 

2. Select the Pass/Fail Definition tab. 

The Pass/Fail Definition tab moves to the front of the dialog box. 

 

Figure 98: Pass/Fail Definition Tab 

3. Set test failure criteria. By default, WebLOAD IDE will fail a test if a severe error 

occurs during the test run. You can also set WebLOAD IDE to fail the test if a set 

numbers of errors or warnings are encountered. 

4. Click OK. 
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Configuring Sleep Time Control Options 

Sleep time is a pause to simulate the intermittent activity of real users. WebLOAD IDE 

enables you to control the sleep time during run-time and set an Agenda to execute 

with the sleep times recorded in the Agenda, random sleep times, or no sleep times.  

To configure Sleep Time Control options: 

1. Click Default/Current Project Options in the Tools tab of the ribbon. 

The Default/Current Project Options dialog box opens. 

2. Select the Sleep Time Control (default) tab. 

The Sleep Time Control tab moves to the front of the dialog box. 

 

Figure 99: Sleep Time Control Tab 

3. Specify the type of sleep to use when playing the Agenda. 

There are four options: 

 Select Sleep time as recorded to run the Agenda with the delays corresponding 

to the natural pauses that occurred when recording the Agenda. 

 Select Ignore recorded sleep time (default) to eliminate any pauses when 

running the Agenda and run a worst-case stress test. 
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 Select Set random sleep time and set the range of delays to represent a range of 

users. 

 Select Set sleep time deviation and set the percentage of deviate from the 

recorded value to represent a range of users. 

4. Click OK. 

Setting the Browser Parameters 

The Browser Parameters option enables you to define Virtual Client behavior.  

To set the Browser Parameters options: 

1. Click Default/Current Project Options in the Tools tab of the ribbon. 

The Default/Current Project Options dialog box opens. 

2. Select the Browser Parameters tab. 

The Browser Parameters tab moves to the front of the dialog box. 

  

Figure 100: Browser Parameters Tab of Default/Current Project Options Dialog Box 
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3. To set the Browser and Version: 

a. Select the browser from the Select the browser drop-down list. An appropriate 

version automatically appears in the Select the version field.  

b. You can select an alternative version from the drop-down list, or click the 

Change button  to edit the version definition (see Editing Browser Version 

Definitions (on page 151)). 

4. To simulate specific cache behaviors, select the DNS cache checkbox and SSL 

cache checkbox. 

5. To set Redirection limits: 

a. Select the Enable redirection checkbox. 

b. In the Redirection limit field, type or select the desired redirection limit. The 

default limit is 10. 

6. To enable a persistent connection to the server, select the Persistent connection 

checkbox. 

7. To set Gzip, select the Gzip support checkbox. 

8. To set character encoding: 

a. Select a character encoding type from the drop-down list. 

b. To enforce character encoding, select the Enforce character encoding 

checkbox. 

9. Click OK. 

The following table describes the fields and buttons in the Browser Parameters tab. 

Table 15: Browser Parameters Tab Fields and Buttons 

Field Description 

Browser Type The browser type and user-agent setting specify the type of browser 

the Virtual Clients should emulate. By default, all Virtual Clients 

use the WebLOAD IDE default browser agent. 

Select the browser  You can set WebLOAD IDE to emulate any of the standard 

browsers. 

Select the user-agent You can specify any specific application by supplying a custom 

user-agent that is included in all HTTP headers. 

Cache The types of cache to simulate. 

DNS Cache Caches the IP addresses received from the domain name server, 

reducing the domain name resolution time.  

Disable DNS caching if you want to include the time for domain 

name resolution in the WebLOAD performance statistics.  
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Field Description 

SSL Cache Caches the SSL decoding keys received from an SSL server, so that 

WebLOAD IDE only receives the key on the first SSL connection in 

each round. In subsequent connections, WebLOAD IDE retrieves 

the key from cache. Enabling SSL Cache also reduces transmission 

time during SSL communication.  

Disable SSL caching if you want to measure the transmission time of 

the decoding key in the WebLOAD performance statistics for each 

SSL connection.  

Redirection 

Enable redirection Enables the redirection. 

Redirection limit Sets the redirection limit. 

Persistent Connection 

Persistent connection  

(keep-alive) 

When enabled, WebLOAD IDE keeps an HTTP connection alive 

between successive accesses in the same round of the main script. 

Keeping a connection alive saves time between accesses. WebLOAD 

attempts to keep the connection alive unless you switch to a 

different server. However, some HTTP servers may refuse to keep a 

connection alive. You should not keep a connection alive if 

establishing the connection is part of the performance test. 

HTTP properties 

Gzip support Sets the wlGlobals.AcceptEncodingGzip flag. 

When this flag is set, WebLOAD IDE behaves as follows: 

1. For each request, sends the header “Accept-Encoding: gzip, 

deflate”. This informs the server that the client can accept 

zipped content. 

2.  When this header is turned on, the server MAY send a response 

with the header “content-encoding: gzip” or “content-encoding: 

deflate”. If either of these headers is sent, it means that the 

response is zipped/deflated and WebLOAD IDE will 

unzip/inflate the content.  

Note: Most servers will work correctly even if the client does 

not send the “Accept-Encoding: gzip, deflate” header. 

Therefore, unless needed, it is recommended not to set the 

wlGlobals.AcceptEncodingGzip flag because it is 

performance heavy. However, some servers will fail if it is not 

sent. Microsoft Internet Explorer/Mozilla sends it by default. 

You can manually code the Agenda to send the “Accept-Encoding: 

gzip, deflate” header even if the 

wlGlobals.AcceptEncodingGzip flag is not set. In this case, if 

the server returns zipped content, WebLOAD IDE will not unzip it. 
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Field Description 

Character Encoding 

Select the character 

encoding value 

Contains the value corresponding to the character set being used. 

The default value is Default (0), the regional settings of the 

computer. 

Enforce character 

encoding 

Indicates whether the parser should use the character set it parses in 

the HTML pages or override it using the value specified in the 

Select Character Encoding drop-down list. The default value is 

false (use the encoding from the HTML pages). 

Editing Browser Version Definitions 

The available browser version list is appropriate for the browser type you select. You 

can add to the browser version list.  

Note: If you are working in the Current Project options dialog box, adding a browser 

version to the list only affects the current session. When you restart the application, the 

original browser version list is used. If you are working in the Default Project options 

dialog box, the updated browser version list is saved for future sessions as well. 

To add a browser version: 

1. Click the browse button in the Browser Type area on the Browser Parameters tab. 

The User Agent dialog box opens. 

 

Figure 101: User Agent Dialog Box 

2. Manually edit the version definition. 

3. Click OK. 

 



 

 152  Chapter 9. Configuring the WebLOAD IDE Options 

Setting the HTTP Parameters 

The HTTP Parameters option enables you to define HTTP client behavior on the HTTP 

protocol level.  

To set the HTTP Parameters options: 

1. Click Default/Current Project Options in the Tools tab of the ribbon. 

The Default/Current Project Options dialog box opens. 

2. Select the HTTP Parameters tab. 

The HTTP Parameters tab appears at the front of the dialog box. 

 

Figure 102: HTTP Parameters Dialog Box 

3. Set the HTTP version by clicking HTTP version 1.0 or HTTP version 1.1. 

4. Select one or more HTTP properties checkboxes. 

5. Click OK. 
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The following table describes the fields and buttons in the HTTP Parameters dialog 

box. 

Table 16: HTTP Parameters Dialog Box Fields and Buttons 

Field Description 

HTTP version The appropriate HTTP protocol version (for example “HTTP/1.1”). 

HTTP version 1.0 Sets the HTTP protocol version to 1.0. 

HTTP version 1.1 Sets the HTTP protocol version to 1.1. 

HTTP properties  

Multi IP support Sets the wlGlobals.MultiIPSupport flag to indicate that the 

HTTP protocol version supports more than one IP address. 

If this option is selected, WebLOAD takes all IP addresses defined on 

the Load Generator machine. However, you can exclude specific IP 

addresses by modifying the WebLOAD.ini configuration file. 

To exclude certain IP addresses, open the WebLOAD.ini file in 

<RadView directory>\bin and locate the following line: 

EXCLUDED_IPS=" "  

Enter the IP addresses you wish to exclude. If you enter multiple 

addresses, use a pipe delimiter between addresses as in the following 

example:  

EXCLUDED_IPS="127.0.0.1|192.168.113.16|10.254.8.88"  

Encode form data Sets the wlGlobals.EncodeFormdata flag.  

In general, when an HTTP client (Microsoft Internet Explorer/Firefox 

or WebLOAD IDE) sends a post request to the server, the data must 

be HTTP encoded. Special characters like blanks, “>“ signs, and so on, 

are replaced by “%xx”. For example, space is encoded as “%20”.  

This encoding can be performance heavy for large data, so WebLOAD 

IDE enables you to turn it off.  

This should ONLY be done if you are sure that the data does not 

contain special characters. If it does, and the customer wants to 

improve performance via this flag, then you should replace the special 

characters within the script or use wlHttp.EncodeFormdata to set 

the flag for specific requests. 

Accept language Sets the wlGlobals.AcceptLanguage flag. This flag defines a 

global value for the “Accept-Language” header which will be sent 

with each request. Some applications/servers will behave differently 

depending on the setting. It is a simple string and WebLOAD IDE 

does not enforce any checks on the values. It is similar to the property 

in the sense that it is a wlGlobals/wlHttp setting that affects the 

value of request headers. 
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Setting the Browser Cache 

WebLOAD IDE enables you to define the behavior of the cache that WebLOAD 

Console uses in order to simulate the behavior of a browser’s cache. WebLOAD can 

cache JavaScript files, style sheets, images, applets, and XML files.  

To define the browser cache behavior: 

1. Click Default/Current Project Options in the Tools tab of the ribbon. 

The Default/Current Project Options dialog box opens. 

2. Select the Browser Cache tab. 

The Browser Cache tab moves to the front of the dialog box. 

 

Figure 103: Browser Cache Tab 

The following table describes the fields in the Browser Cache tab. 
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Table 17: Browser Cache Tab Fields 

Field Description 

Browser cache types 

None All Virtual Clients simulate a browser with no available cache. 

Clear cache after each 

Request 

Defines that the cache will be cleared after each request. 

Check for newer version 

after each Request 

Defines that WebLOAD will check for a newer version of the 

cached item after every request.  

Whenever the engine has a request for a cached resource, the 

engine sends the request with an “if-modified-since” header. If 

the server responds with a 200 status, the engine will refresh 

the cache. 

Clear cache after each 

Round 

Defines that the cache will be cleared after each Agenda 

execution round. This is the default setting. 

Check for newer version 

after each Round 

Defines that WebLOAD will check for a newer version of the 

cached item after each round. 

Whenever the engine has a request for a cached resource, the 

engine sends the request with an “if-modified-since” header. If 

the server responds with a 200 status, the engine will refresh 

the cache. 

Never clear cache Defines that the cache will never be cleared. Each client 

maintains its own cache. 

Cache content You can select a filter, enabling you to indicate specific content 

types to be cached in the Agenda. The available filters are: 

 JavaScript files 

 Style sheets 

 Images 

 Applets 

 XML files 

 Dynamic 

Configuring Authentication Settings 

WebLOAD IDE enables you to define the global and proxy authentication settings. 

WebLOAD IDE enables you to configure a double proxy configuration, which instructs 

the recorder to use two application proxies, one for regular HTTP traffic and another 

for secure (SSL) traffic. To configure the two proxies, see Configuring a Double Proxy (on 

page 189). 
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To configure Authentication settings: 

1. Click Default/Current Project Options in the Tools tab of the ribbon. 

The Default/Current Project Options dialog box appears. 

2. Select the Authentication tab. 

The Authentication tab moves to the front of the dialog box. 

 

Figure 104: Authentication Tab 

3. Fill in the fields, as described in Table 18. 

4. Click OK. 

The following table defines all the fields and options in the Authentication tab. 

Table 18: Authentications Tab Fields and Options 

Field Description 

Global Authentication Settings 

User name and Password The user name and password that the Agenda should use 

to log onto restricted HTTP sites.  
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Field Description 

NT user name and 

NT password 

The user name the Agenda should use for Windows NT 

Challenge response authentication. 

SSL client certificate file and 

SSL client certificate password 

The file name (optionally including a directory path) of the 

certificate WebLOAD makes available to SSL servers and 

type the password. Click Browse to search for the file. 

Authentication method The authentication method supported by the server: 

 NTLM (default). 

 Kerberos.  

Kerberos server The Kerberos server Fully Qualified Domain Name 

(FQDN). For example, specify “qa4” rather than 

“qa4.radview.co.il”. This field is only enabled when the 

authentication method is set to Kerberos. 

Proxy authentication settings 

Proxy server: 

Proxy host and Proxy port 

The host name and port number for the proxy server. 

Proxy user name and Proxy 

password 

The user name and password for the proxy server.  

Setting Diagnostic Options 

Diagnostic options can be enabled while developing an Agenda or for tracking 

problems in existing Agendas.  

To set Diagnostic options: 

1. Click Default/Current Project Options in the Tools tab of the ribbon. 

The Default/Current Project Options dialog box opens. 

2. Select the Diagnostic tab. 

The Diagnostic tab moves to the front of the dialog box. 



 

 158  Chapter 9. Configuring the WebLOAD IDE Options 

 

Figure 105: Diagnostic Tab 

3. Set the Enable syntax check option, see Enabling Syntax Checking (on page 158). 

4. Set the Enable the enhanced RadView support diagnostic option, see Enabling 

RadView Support Diagnostic (on page 159). 

5. Click OK. 

Enabling Syntax Checking 

Enable syntax checking to perform the following tests on an Agenda while it is 

running.  

Table 19: While-Running Agenda Tests 

Test Description 

Type Inspection WebLOAD IDE checks that each property receives the correct type. For 

example, wlLocals.ParseForms = 14 prompts the following log 

message: 

“Wrong type for the property ParseForms. The correct 

type is Boolean. Legal values are: “Yes”/”No” or 

“true”/”false”. 
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Test Description 

Value Inspections WebLOAD IDE checks to ensure that each property is assigned a legal 

value. For example, wlHttp.Version = “2.1” prompts the 

following log message: 

“2.1 is an illegal value for the property Version. 

Legal values are: 1.0, 1.1.” 

Scope Inspections WebLOAD IDE checks to ensure that each property is assigned a 

permitted scope. For example, wlLocals.ConnectionSpeed = 

28800 prompts the following log message: 

“The property ConnectionSpeed is not valid for the 

object wlLocals.” 

Case Inspections WebLOAD IDE objects and properties are case sensitive. When syntax 

checking is enabled, WebLOAD IDE checks to ensure that all objects 

and properties are written correctly. For example, wlLocals.parse 

= “No” prompts the following message: 

“The property parse should be written Parse.” 

 

We recommend that syntax checking be run at least once while developing an Agenda. 

To enable syntax checking: 

1. Click Default/Current Project Options in the Tools tab of the ribbon. 

2. Select the Diagnostic tab. 

3. Select the Enable syntax check checkbox. 

Enabling RadView Support Diagnostic 

Enabling the RadView support diagnostic option creates large files in the 

WebLOAD IDE\User\Log directory that may affect Load Generator performance. 

To enable RadView Support diagnostic: 

1. Click Default/Current Project Options in the Tools tab of the ribbon. 

2. Select the Diagnostic tab. 

3. Select the Enable the enhanced RadView support diagnostic checkbox. 
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Configuring the Java Options 

The Java options enable you to define the Java Virtual Machine to be used by 

WebLOAD IDE, for executing Java classes. 

To configure Java Option settings: 

1. Click Default/Current Project Options in the Tools tab of the ribbon. 

The Default/Current Project Options dialog box appears. 

2. Select the Java Options tab. 

The Java Options tab moves to the front of the dialog box. 

 

Figure 106: Java Options Tab 

3. In the Select run-time JVM to be used drop down, select one of the available Java 

Virtual Machines. The default setting is the WebLOAD standard Java Virtual 

Machine.  



  

WebLOAD IDE User's Guide  161  

The selected value is passed to wlGlobals.JVMtype and is the key for 

WLJVMs.xml. This XML file (located on every WebLOAD Machine in the 

...\extensions\JVMs directory) contains the following parameters for each 

JVM: 

 Type (the value from the flag) 

 Path (should be machine-agnostic) 

 Options 

When Type is “Default”, the RadView default (installed) JVM will be used. The 

default JVM’s path is defined in webload.ini, as it depends on the WebLOAD 

installation path. 

4. Click OK. 

The Java Options are saved. 

Configuring the Recording and Script Generation 

Options 

The Recording and Script Generation Options enable you to define the behavior of the 

WebLOAD IDE during the recording and script generation of a Web session.  

Opening the Recording and Script Generation Options 

To open the Recording and Script Generation Options dialog box: 

 Click Recording and Script Generation Options in the Tools tab of the ribbon. 

Or- 

Select Recording and Script Generation Options from the IDE System button. 

The Recording and Script Generation Options dialog box opens with the File 

Extensions tab displayed. 
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Figure 107: Recording and Script Generation Options Dialog Box – File Extensions Tab 

The following table describes the tabs in the Recording and Script Generation Options 

dialog box. 

Table 20: Recording and Script Generation Options Dialog Box Tabs 

Tab Description 

Proxy 

Certificates 

Configure the Server Side and Client Side certificates. 

Script 

Generation 

Define how the WebLOAD IDE should handle various HTTP elements. 

Default 

Encoding Type 

Select the default encoding type. 

Browser 

Settings 

Select the default browser. 

If you selected either Microsoft Internet Explorer or Netscape Navigator, 

you can also request that the program configure the proxy value 

automatically (default). If you want to configure the proxy value 

manually, see Configuring the Proxy Value for Your Browser (on page 14). 
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Tab Description 

File Extensions 

(default) 

Select which file types should be recorded and which ones should not. 

Content Types Select which objects should be recorded and which ones should not.  

Post Data Define how the WebLOAD IDE should handle Post Data. 

Proxy Options Configure the proxy values for WebLOAD IDE and the application (if 

necessary).  

Correlation 

Options 

Define correlation and logging options. 

Auto 

Correlation 

Define the auto-discovery correlation options. 

URL Filtering Configure which types of URLs the WebLOAD IDE records. 

Specifying the Script Content to be Generated 

Use the Script Generation tab in the Recording and Script Generation Options dialog 

box to specify what the WebLOAD IDE should record in your Agenda. The Script 

Generation tab lists all the HTTP objects that can be automatically identified by the 

WebLOAD IDE and recorded in the Agenda so you do not have to enter them 

manually. For example, you can instruct WebLOAD IDE whether or not to record and 

display the headers. 

To specify the HTTP objects to be recorded: 

1. Select Recording and Script Generation Options from the IDE System button. 

The Recording and Script Generation Options dialog box appears (see Figure 107). 

2. Select the Script Generation tab. 

The Script Generation tab moves to the front of the dialog box. 
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Figure 108: Script Generation Tab 

3. Select or clear the options to specify what the WebLOAD IDE should record in 

your Agenda. 

4. Click OK. 

The following table describes the options in the Script Generation tab.  

Table 21: Script Generation Tab Options 

HTTP Object Description Example 

Generate 

Authentication 

Generates the name and 

password that appear in 

the header of a request. 

This option is selected 

by default. 

wlHttp.UserName=“John” 

wlHttp.Password=“Blue” 

Generate proxy Generates the proxy 

setting. 

This option is selected 

by default. 

wlHttp.Proxy=<ProxyName>.<ProxyPort> 
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HTTP Object Description Example 

Generate proxy 

authentication 

Generates the name and 

password used to 

identify you to the 

proxy. 

This option is selected 

by default. 

wlHttp.ProxyUserName=<UserName> 

wlHttp.ProxyPassword=<Password> 

Decode query 

string  

Records the query string 

that is the part of the 

URL after the “?” sign 

and is used for sending 

parameters for the 

specific server item 

which is targeted by this 

URL. 

When this option is not selected, the GET 

command will displayed as follows: 

wlHttp.Get(“http://localhost/netize

nbank/myAccountWelcome.asp?netizenS

ID=31341549426&ssn=1234&password=12

31&I1.x=21&I1.y=10”) 

That is all the parameters that will appear as 

part of the URL. 

When this option is selected, the URL will be 

parsed and displayed as follows: 

wlHttp.FormData[“netizenSID”] = 

“31341549618” 

wlHttp.FormData[“ssn”] = “124” 

wlHttp.FormData[“password”] = 

“3424” 

wlHttp.FormData[“I1.x”] = “29” 

wlHttp.FormData[“I1.y”] = “14” 

wlHttp.Get(“http://localhost/netize

nbank/myAccountWelcome.asp”) 

That is a block of parameters that will be easier 

to parameterize.  

Generate 

redirection path  

WebLOAD IDE records 

(in the Agenda) only the 

first GET statement; the 

rest of the URLs visited 

when redirected are 

inserted into the Agenda 

as comments. The 

Agenda does not revisit 

all the URLs during 

playback. 

wlHttp.Get 

(“http://www.abcdef.com”) 

// Redirections: 

http://www.ghijkl.com, etc. 
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HTTP Object Description Example 

Generate all 

headers 

Generates all HTTP 

headers.  

The headers 

If-Modified-Since, 

If-None-Matched, 

and Keep Alive will 

be commented out to 

overcome the situation 

where recorded links 

were fetched from the 

browser’s cache during 

the recording.  

The request header 
Accept-Encode: 

gzip will also be 

commented out, to 

ensure correct behavior.  

When Generate All 

Headers is selected, 

Generate Referer Header 

and Generate Custom 

Header are 

automatically checked 

and disabled so that 

they cannot be 

unchecked. 

wlHttp.Header[“user-agent”] 

=“Mozilla/4.04 [en] (WinNT; I)” 

wlHttp.Header[“accept-charset”] 

=“iso-8859-1,*,utf-8” 

wlHttp.Header[“proxy-connection”] 

=“Keep-Alive” 

wlHttp.Header[“accept-language”] 

=“en” 

Generate 

referer header 

Generates the referer 

header only. This header 

tells the server which 

URL submitted the 

request. For example, if 

you click a link from 

page xxx, the browser 

will send that url as the 

referer.  

This option is selected 

by default. 

This option is 

automatically selected 

and cannot be changed 

when Generate All 

Headers is selected. 

wlHttp.Header[“Referer”] = 

“http://www.easycar.com/” 



  

WebLOAD IDE User's Guide  167  

HTTP Object Description Example 

Generate 

custom headers 

Generates any headers 

that are not explicitly 

defined in the RFC, such 

as the SOAP Action 

header. This option is 

selected by default. 

 

Comment status Writes a comment about 

the status of your 

transactions (that is, any 

GET statement), 

including information 

about the contents of the 

pages. 

wlHttp.Get(“http://www.RadView.com/

”) 
//200 OK 

Comment 

request headers  

Writes a comment for 

each HTTP request. 

// Request Headers: 
// user-agent=Mozilla/4.0 

(compatible; MSIE 5.01; Windows NT) 
// accept-encoding=gzip, deflate 
// proxy-connection=Keep-Alive 

Comment 

response 

headers  

Writes a comment for 

each reply to HTTP 

request. 

// Response Headers: 
// content-type=text/html 
// server=Microsoft-IIS/4.0 
// date=Thu, 06 Jan 2000 16:12:44 

GMT 
// via=1.1 localhost 

(Jigsaw/1.0a5)// 200 OK 

Encode binary 

data 

Used to specify if the 

binary data should be 

encoded. By default this 

flag is not selected. 

If a mobile operator wants to simulate the 

sending of binary data from the browser 

(phone) to the server. Part of the binary data is a 

value (for example, phone number) that needs 

parameterization.  

When the EncodeBinaryData flag is selected, the 

binary form data “x0Ax0BAMIRx00” appears as 

“%0A%0BAMIR%00” in the script. 

Generate 

VIEWSTATE 

data 

Enables filtering the 

VIEWSTATE data while 

recording. When this is 

not selected, 

VIEWSTATE data will 

be commented out in the 

Agenda. 

 

Save all 

redirection 

headers 

Records the headers for all 

URL redirections. 
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HTTP Object Description Example 

Generate Client 

side cookies 

When unchecked, the 

web page sets cookies 

from the JavaScript and 

you must implement the 

cookies manually in the 

script. 

If selected, the cookies 

from the headers are 

compared to cookies 

that the server sends. If 

there is a difference, the 

correct SetCookie 

command is added to 

the script. This is 

performed during 

recording. The cookie 

value is obtained from 

the recorded traffic. 

WebLOAD 

automatically inserts a 

comment before the 

SetCookie command 

in the script to let the 

user know that the 

cookie was added 

automatically. 

 

Setting the WebLOAD IDE to Record Post Data Types 

Use the Post Data tab in the Recording and Script Generation Options dialog box to 

instruct the WebLOAD IDE how to treat different data types when it is recording. Data 

can be written in the Agenda as part of the command, as a data block, or in a data file. 

A data block is stored within the Agenda itself, and is useful when you prefer to see 

the data directly. A data file stores the data in a local text file, and is useful when you 

are working with large amounts of data which would be too cumbersome to store 

within the Agenda code itself, or binary data. When working with data files, only the 

name of the text file is stored in the Agenda itself. Data can also be recorded as 

FormData, in which the data is formatted in a tidy name-value format and is url 

encoded when sent to the server.  

While recording an Agenda, WebLOAD automatically identifies if there are no 

name-value pairs, checks if there is a valid content type (for example, text/plain), 

and records it accordingly (for example, as Data).  
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Note: The content type application/x-www-form-urlencoded (with or without a 

charset), should always be recorded as FORMDATA, unless you explicitly specify to 

record it as DATA or DATA FILE.  

For complete details on Post Data recording, see the WebLOAD Scripting Guide. 

To set the WebLOAD IDE to record data types: 

1. Click Recording and Script Generation Options in the Tools tab of the ribbon. 

Or- 

Select Recording and Script Generation Options from the IDE System button. 

The Recording and Script Generation Options dialog box appears (see Figure 107). 

2. Select the Post Data tab. 

The Post Data tab moves to the front of the dialog box. 

 

Figure 109: Post Data Tab 
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3. Fill in the fields, as described in Table 22, below.  

4. Optionally, you can double-click an item from the DATA block or DATAFILE 

block lists to display the item’s full text. 

 

Figure 110: Post Data Full Text Message Box 

5. Click OK to return to the Post Data tab. 

6. Click OK to save the record options settings. 

The following table defines all the fields and options in the Post Data tab. 

Table 22: Post Data Tab Fields and Options 

Field Description 

DATA block Lists the types of data that the WebLOAD IDE records as DATA 

blocks in the Agenda’s JavaScript. A DATA block is recorded without 

HTTP encoding and is not structured. During playback, the 

WebLOAD IDE makes this data into form data and sends it without 

any further modification. A DATA block is for posting data that is not 

meant to be HTTP encoded, for example Web service calls. 

DATAFILE block Lists the types of data that the WebLOAD IDE records as DATAFILE 

blocks (files with a name and a path). A DATAFILE block can store 

text and binary data. During playback, the WebLOAD IDE copies and 

then sends this file with multipart form data, using a MIME protocol. 

Remove Click this button to delete a selected DATA block or DATAFILE block 

from both lists. 

Add new type Type the name of a new type you want to be added to either of the 

lists. 

As DATAFILE Adds the new type you entered in the Add new type field to the 

DATAFILE block list. 

As DATA Adds the new type you entered in the Add new type field to the 

DATA block list. 

Record Unknown 

Post Types as  

Select to instruct the WebLOAD IDE to record any data type not 

defined on this tab as:  

 FORMDATA 

 DATA 

 DATAFILE 
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By default, the following content types are recorded as DATA blocks: 

 application/json; charset=utf-8 

 application/json-rpc 

 application/xml; charset=utf-8 

 text/xml 

 text/xml; charset=utf-8 

Note: The recorder searches for exact content types from this list. Therefore, text/xml 

and text/xml; charset=utf-8 are different content types even though the former 

is a subset of the latter. 

WebLOAD IDE deals specially with the following content types: 

 multipart/form-data – This content type is used for uploading files. The actual 

content type sent by the client is multipart/form-data;boundary=long-

string. The recorder searches for the multipart/form-data content type and 

then records the request as a From Data, although it appears in the DATAFILE 

block list.  

 multipart/text – This content type is similar to multipart/form-data, except 

that the multipart/text content type is not used for uploading files. The 

multipart/text content type is therefore handled as a DATA block, but since it 

contains a variable in the name (the value of boundary in 

multipart/text;boundary= …), the treatment of this content type is hard-

coded. For example, any content type that starts with multipart/text is 

recorded as a DATA block content type. 

 soap messages – This content type is always recorded as DATA blocks. 

Configuring the Default Encoding Type 

Use the Default Encoding Type tab in the Recording and Script Generation Options 

dialog box to set up the default encoding type.  

To configure the default encoding type: 

1. Click Recording and Script Generation Options in the Tools tab of the ribbon. 

Or- 

Select Recording and Script Generation Options from the IDE System button. 

The Recording and Script Generation Options dialog box appears (see Figure 107). 

2. Select the Default Encoding Type tab. 

The Default Encoding Type tab moves to the front of the dialog box. 
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Figure 111: Default Encoding Type Tab 

3. Select an option as the default encoding type. 

4. Click OK. 

Configuring the Default Browser 

Use the Browser Settings tab in the Recording and Script Generation Options dialog 

box to set up the default browser.  

To configure the default browser: 

1. Click Recording and Script Generation Options in the Tools tab of the ribbon. 

Or- 

Select Recording and Script Generation Options from the IDE System button. 

The Recording and Script Generation Options dialog box appears (see Figure 107). 

2. Select the Browser Settings tab. 
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The Browser Settings tab moves to the front of the dialog box.  

  

Figure 112: Browser Settings Tab 

3. Fill in the fields, as described in Table 23. 

4. Click OK. 

A message appears stating that in order for WebLOAD IDE to change your proxy 

definition automatically, you must close all instances of the browser before 

recording.  

After you close all instances of the browser, the WebLOAD IDE screen appears. 
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The following table defines all the fields and options in the Browser Settings tab. 

Table 23: Browser Settings Tab Fields and Options 

Field Description 

Default browser selection 

Web browser Select this option to define Google Chrome, Mozilla Firefox or Microsoft 

Internet Explorer as your default browser. 

If you selected Mozilla Firefox as your browser, and Mozilla Firefox was 

installed on the machine after WebLOAD IDE was installed, a message 

appears recommending that you install the Firefox extension responsible 

for setting the proxy definitions automatically. 

If you accept, the extension is installed.  

If you do not accept, the Set the proxy definitions automatically checkbox 

is automatically cleared, and you should configure the proxy value 

manually (see Configuring the Proxy Value for Your Browser on page 14). 

The next time you check the Set the proxy definitions automatically 

checkbox, WebLOAD IDE will show the installation message again. 

Other browser Select this option and browse to define a browser other than Google 

Chrome, Mozilla Firefox or Microsoft Internet Explorer as your default 

browser. 

Mobile native 

application 

Select this option to define a mobile native application as your default 

browser. This option is intended for recording from a mobile device. To do 

so, you must setup the device and the system as described in Recording 

Mobile Applications (on page  331). 

None Select this option to define that there is no default browser. 

Automatic browser settings 

Set the proxy 

definitions 

automatically 

If you selected either Mozilla Firefox or Microsoft Internet Explorer, you 

can also set WebLOAD IDE to configure their proxy settings automatically 

(default). If you want to configure the proxy value manually, see 

Configuring the Proxy Value for Your Browser (on page 14). 

Clear browser 

cache 

Select this option to clear the browser cache before recording. This option 

is selected, by default. 

Clear browser 

cookies 

Select this option to clear the browser’s cookie history before recording. 

This option is selected, by default. 

General browser settings 

Open a new 

browser 

window for 

each recording 

Select this option to open a new browser window each time you start 

recording. The first time you start recording, a message is displayed with 

information about this option. You can disable this message by checking 

the Don’t show this message again checkbox.  
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Field Description 

Simulate 

mobile user 

agent 

Select this option to simulate a mobile web application.  

If you select this option, define the specific user agent (browser type and 

browser version) you wish to simulate. You can click the Change button 

 to edit the user agent definition. See Editing Browser Version 

Definitions (on page 151). 

Configuring the Correlation Options 

Use the Correlation Options tab in the Recording and Script Generation Options dialog 

box to set up the correlation options.  

To configure the correlation options: 

1. Click Recording and Script Generation Options in the Tools tab of the ribbon. 

Or- 

Select Recording and Script Generation Options from the IDE System button. 

The Recording and Script Generation Options dialog box appears (see Figure 107). 

2. Select the Correlation Options tab. 

The Correlation Options tab moves to the front of the dialog box. 
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Figure 113: Correlation Options Tab 

3. Fill in the fields, as described in Table 24. 

4. Click OK. 

Table 24: Correlation Options Tab Fields and Options 

Field Description 

Add correlation 

comments to 

script 

Select this option to instruct WebLOAD to add comments to your Agenda 

in the places where correlation was performed and create a log of all the 

changes that were made to your Agenda’s JavaScript. 

When selected, the following comment is added to your Agenda before a 

command that extracts the dynamic value from a response or that uses a 

parameter instead of a dynamic value in a request:  

//WLCORR – Extracting the dynamic value from the 

response according to Correlation Rule <ID>s 

-Or-  

//WLCORR – Using the Correlation Parameter instead of 

the dynamic value according to Correlation Rule <ID>s 

where <ID> is the correlation rule ID. 
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Field Description 

Preserve user 

changes 

Specify whether to preserve or discard user changes before running 

correlation.  

 When this option is unselected, all manual (user) changes to the 

agenda are discarded before running correlation. This is equivalent to 

performing Script Regeneration prior to running correlation.  

 When this option is selected (default), user changes are preserved 

when correlation is run. If the changes introduced by correlation 

conflict with the changes made by the user, the user is requested to 

resolve the conflict, as described in Resolving Conflicts between Manual 

Changes and Correlation Changes on page 94. 

Correlation 

level 

Specify the correlation level to determine the type of correlation to run 

automatically after recording the Agenda: 

Possible values: 

 Do not run – Do not run correlation after recording the Agenda. 

 Use existing rules – Perform manual correlation after recording the 

Agenda, using the existing rules. 

 Discover rules – Perform automatic correlation after recording the 

Agenda, to discover and suggest new rules. 

 Prompt – After recording the Agenda, a dialog box is displayed 

enabling you to select the type of correlation you wish to perform (Do 

not run, Use existing rules, or Discover rules). 

Logging level Specify the correlation logging level to determine the amount and content 

of the comments that the correlation engine adds to your Agenda’s 

JavaScript.  

Possible values: 

 0 – None. No log messages are added to the JavaScript. 

 1 – Minimal. Fatal, Error, and Warning messages are added to the 

JavaScript. Fatal messages indicate that an unrecoverable error 

occurred, Error messages indicate that a recoverable error occurred, 

and Warning messages indicate that there is a possible error. 

 2 – Medium. In addition to the messages added with the minimal 

logging level, Info messages are added to the JavaScript. Info 

messages provide important information, such as, when a rule finds a 

value or when a correlation hint is found. 

 3 – Full. In addition to the messages added with the medium logging 

level, Debug messages are added to the JavaScript. Debugging 

messages provide detailed information about the Agenda. 

Logging file Specify the location of the correlation log file. The default file is 

correlation.log and the default location is: 
C:\Program Files\Radview\WebLOAD\Log 
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Field Description 

Correlation 

rules file 

Specify the location of the correlation rules XML file. The default file is 

correlationRules.xml and the default location is: 
C:\Program Files\Radview\WebLOAD\Extensions\Correlation 

Edit Rules Open the Correlation Rules Editor. For more information about the 

Correlation Rules Editor, see Configuring the Correlation Rules (on page 96). 

Flex / AMF correlation 

Correlate Flex / 

AMF messages 

Create automatic correlation rules to correlate RPC Flex messages and 

Messaging Flex messages. 

Selecting this option enables correlation of the DSId value. This correlation 

is part of the AMF script generation, which means the correlation is 

performed during recording. 

Auto generate 

DSIds 

If selected, a new DSId is generated during session initialization. The 

generated DSId is used for all AMF requests until the next session 

initialization.  

If not selected, the DSId is retrieved from the session initialization request 

(nil request) and is used for all AMF requests until the next session 

initialization. 

Disable Flex 

correlation 

Disable Flex correlation. 

 

Configuring the Auto-Correlation Options 

Use the Auto Correlation Options tab in the Recording and Script Generation Options 

dialog box to set up the Auto Discovery correlation options.  

To configure the Auto Discovery correlation options: 

1. Click Recording and Script Generation Options in the Tools tab of the ribbon. 

Or- 

Select Recording and Script Generation Options from the IDE System button. 

The Recording and Script Generation Options dialog box appears (see Figure 107). 

2. Select the Auto Correlation Options tab. 

The Auto Correlation Options tab moves to the front of the dialog box. 
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Figure 114: Auto Correlation Options Tab 

3. Fill in the fields, as described in Table 25. 

4. Click OK. 

Table 25: Auto Correlation Options Tab Fields and Options 

Field Description 

Minimum value 

length 

Specify the minimum length of the value to be considered for correlation. 

Shorter values, even if matched by a rule, are ignored. 
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Field Description 

Filter strength Specify the rules to display in the Correlation Review Form, according to 

the rule’s score. Each rule is given a score during auto-discover correlation 

according to an algorithm that calculates the chances of the rule being 

used. Specify the filter strength as follows: 

 Strict (few records) – Display only the rules that are very likely to be 

used in the Agenda. This leads to faster Agenda execution, but also 

has a high risk of missing a necessary rule.  

 Normal (balanced) – Displays rules that are likely to be used in the 

Agenda. This leads to average Agenda execution, includes most (if 

not all) of the necessary rules and displays some rules that are not 

used. 

 Weak (many records) – Display rules that have a chance of being used 

in the Agenda. This leads to slower Agenda execution and displays 

many rules that are not used.  

Value 

delimiters 

Specify the characters to be considered delimiters when searching for a 

dynamic value during correlation. The correlation engine searches for the 

dynamic value in the Agenda, where the value is surrounded by a specific 

delimiter. 

For example, in: 

SessionID=1234&Day 

’&’ is a delimiter, which defines ‘1234’ and ‘Day’ as two separate strings. 

Show 

correlation 

review form 

Specify when to show the Correlation Review form after performing 

correlation. 

Possible values: 

 Never. 

 Always. 

 After Auto-discovery. 

 

Configuring the URL Filtering Options 

Use the URL Filtering tab in the Recording and Script Generation Options dialog box 

to configure which types of URLs the WebLOAD IDE records. 

To configure the URL filtering options: 

1. Click Recording and Script Generation Options in the Tools tab of the ribbon. 

Or- 

Select Recording and Script Generation Options from the IDE System button. 
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The Recording and Script Generation Options dialog box appears (see Figure 107). 

2. Select the URL Filtering tab. 

The URL Filtering tab moves to the front of the dialog box. 

 

Figure 115: URL Filtering Tab 

3. Fill in the fields, as described in Table 26. 

4. Click OK. 

The following table describes the fields in the URL Filtering tab. 

Table 26: URL Filtering Tab Fields and Options 

Field Description 

Excluded URLs List Lists the URLs that WebLOAD IDE does not record. WebLOAD IDE 

ignores all actions involving any URL in this list when it is 

encountered during a Web session. 
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Field Description 

Included URLs List Lists the URLs that WebLOAD IDE records. WebLOAD IDE records 

all actions involving any URL in this list when it is encountered 

during a Web session. 

Edit URLs List Type a URL in this field to add the URL to either the Included URLs 

List or Excluded URLs List. 

Add to Exclude Click to add the URL in the Edit URLs List field to the Excluded 

URLs List. 

Add to Include Click to add the URL in the Edit URLs List field to the Included URLs 

List. 

Remove Click to delete a selected URL from either the Included URLs List or 

the Excluded URLs List. 

Configuring the File Extensions 

Use the File Extension tab in the Recording and Script Generation Options dialog box 

to configure which types of files the WebLOAD IDE records.  

Both the File Extensions and the Content Types tabs (see Configuring the Content Types 

to Record on page 184), enable you to specify the types of data that are accepted and 

recorded by WebLOAD IDE, or not accepted and ignored. On the File Extensions tab, 

you specify which objects should be recorded or ignored, according to their file 

extension, such as “.gif”, “.wav”, or “.txt”.  

In a case where the file extension and content types contradict each other, precedence 

is given to the record filter as opposed to the ignore filter. For example, if the File 

Extensions and Content Types tabs are configured with the following settings: 

 Filter the following file extensions as – Recorded Extensions: gif 

 Filter the following content types as – Ignored Types: image/gif 

A resource with the gif file extension that contains image/gif content is recorded in 

WebLOAD IDE even though the image/gif content type is set to be ignored. 

To configure the file extensions: 

1. Click Recording and Script Generation Options in the Tools tab of the ribbon. 

Or- 

Select Recording and Script Generation Options from the IDE System button. 

The Recording and Script Generation Options dialog box appears (see Figure 107). 

2. Select the File Extensions tab. 

The File Extensions tab moves to the front of the dialog box. 
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Figure 116: File Extensions Tab 

3. Fill in the fields, as described Table 27. 

4. Click OK. 

The following table describes the fields in the File Extensions tab. 

Table 27: File Extensions Tab Fields 

Field Description 

Ignored extensions Lists the file extensions that WebLOAD IDE does not record. 

WebLOAD IDE ignores all actions involving any file extension in this 

list when it is encountered during a Web session. 

Recorded extensions Lists the file extensions that WebLOAD IDE records. WebLOAD IDE 

records all actions involving any file extension in this list when it is 

encountered during a Web session. 

Remove Click this button to delete a selected file extension from both lists. 
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Field Description 

Record unknown 

extensions  

Select this option to record all actions involving any unknown file 

extensions encountered during a Web session. File extensions not 

defined and listed in the Ignored Extensions window are treated as if 

they were included in the Recorded Extensions window. 

Record all extensions Select this option to disregard the settings in the Ignored / Recorded 

Extensions lists. WebLOAD IDE then records all actions involving all 

file extensions encountered during a Web session, including 

unknown file extensions. 

Add new extension Type a new file extension.  

Add Click this button to add the new file extension to the Ignored 

Extensions list. 

Configuring the Content Types to Record 

Use the Content Types tab in the Recording and Script Generation Options dialog box 

to set up which types of Web content the WebLOAD IDE records.  

Both the Content Types and the File Extensions tabs (see Configuring the File Extensions 

on page 182), enable you to specify the types of data that are accepted and recorded by 

WebLOAD IDE, or not accepted and ignored. On the Content Types tab you define 

which objects should be recorded by type, such as “image/gif”, “image/jpeg”, or 

“text/html”. 

In a case where the content types and file extension contradict each other, precedence 

is given to the record filter as opposed to the ignore filter. For example, if the Content 

Types and File Extensions tabs are configured with the following settings: 

 Filter the following content types as – Recorded Types: image/gif 

 Filter the following file extensions as – Ignored Extensions: gif 

A resource with the gif file extension that contains image/gif content is recorded in 

WebLOAD IDE even though the gif file extension is set to be ignored. 

To configure the content types to record: 

1. Click Recording and Script Generation Options in the Tools tab of the ribbon. 

Or- 

Select Recording and Script Generation Options from the IDE System button. 

The Recording and Script Generation Options dialog box appears (see Figure 107). 

2. Select the Content Types tab. 

The Content Types tab moves to the front of the dialog box. 
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Figure 117: Content Types Tab 

3. Fill in the fields, as described Table 28. 

4. Click OK. 

The following table describes the fields in the Content Types tab. 

Table 28: Content Types Tab Fields 

Field Description 

Ignored types Lists the content types that WebLOAD IDE does not record. 

WebLOAD IDE ignores all actions involving any content type in this 

list when it is encountered during a Web session. 

Recorded types Lists the content types that WebLOAD IDE records. WebLOAD IDE 

records all actions involving any content type in this list when it is 

encountered during a Web session. 

Remove Click this button to delete a selected content type from both lists. 
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Field Description 

Record unknown 

types 

Select this option to record all actions involving any unknown 

content types encountered during a Web session. Content types not 

defined and listed in the Ignored Types area are treated as if they 

were included in the Recorded Types area. 

Record all types Select this option to disregard the settings in the Ignored / Recorded 

Types lists. WebLOAD IDE then records all actions involving all 

content types encountered during a Web session, including 

unknown content types. 

Add new content type Type a new content type.  

Add Click this button to add the new content type to the Ignored Types 

list. 

Setting the Proxy Options 

Use the Proxy Options tab in the Recording and Script Generation Options dialog box 

to designate the proxy server at your organization as the application proxy during 

recording sessions or to change the proxy port number for WebLOAD IDE. 

When you record Agendas with the WebLOAD IDE, your browser must be configured 

to use proxy port 9884 (which is the default proxy port). In other words, you must 

record Agendas through proxy port 9884. 

WebLOAD IDE enables you to configure a double proxy configuration, which instructs 

the recorder to use two application proxies, one for regular HTTP traffic and another 

for secure (SSL) traffic. To configure the double proxy, see Configuring a Double Proxy 

(on page 189). 

To set the proxy options: 

1. Click Recording and Script Generation Options in the Tools tab of the ribbon. 

Or- 

Select Recording and Script Generation Options from the IDE System button. 

The Recording and Script Generation Options dialog box appears (see Figure 107). 

2. Select the Proxy Options tab. 

The Proxy Options tab moves to the front of the dialog box. 
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Figure 118: Proxy Options Tab 

3. Fill in the fields, as described in Table 29. 

4. Click OK. 

The following table describes the fields and options on the Proxy Options tab. 

Table 29: Proxy Options Tab Fields and Options 

HTTP Object Description 

Recording proxy options 

Proxy port The port number for the WebLOAD IDE proxy-recorder. The 

default value is 9884. When you record Agendas, your browser 

must use the default value. 

Use transparent proxy Select this option to enable WebLOAD IDE to record from any Web 

client that does not support proxy configurations. When selected, 

the Proxy port field is disabled. For more information, see Recording 

Desktop Web Applications on page 58. 
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HTTP Object Description 

Application proxy options 

Use the following 

definitions for the 

application’s proxy 

server 

Select this option if you use a proxy server to access the Internet. 

When selected, the HTTP proxy/Port, SSL proxy/Port and the Proxy 

authentication area fields are enabled and updated with the current 

settings from your Internet browser. (This is only relevant for 

Internet Explorer and Mozilla Firefox. If you are using a different 

Internet browser, update these fields manually). For additional 

information on determining if your browser is configured with a 

proxy, see Troubleshooting (on page 62). 

HTTP proxy/Port The address and port number of your organization’s proxy, if one 

exists (for example, to access the Internet beyond a company 

firewall). Modifying these fields automatically updates your default 

browser’s proxy settings and restores the original settings when the 

recording process is complete. 

SSL proxy/Port The address and port number of your organization’s Secure proxy, 

if one exists (for example, to access the Internet beyond a company 

firewall). Use these fields in conjunction with the HTTP Proxy/Port 

fields to define a double proxy. Modifying these fields automatically 

updates your default browser’s proxy settings and restores the 

original settings when the recording process is complete. 

Use browser’s settings 

when recording 

Select this option to enable WebLOAD IDE to use your default 

browser’s proxy settings when recording an Agenda. When 

selected, WebLOAD IDE copies your default browser’s proxy 

settings into the HTTP Proxy/Port and SSL Proxy/Port fields. (This 

is only relevant for Internet Explorer and Mozilla Firefox. If you are 

using a different Internet browser, this is irrelevant). 

Proxy authentication 

User name The user name used for proxy authentication purposes. 

Password The password used for proxy authentication purposes. 
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HTTP Object Description 

Proxy exceptions 

Do not use proxy 

server for addresses 

beginning with 

Enter the address of complex addresses you wish to bypass. 

A proxy bypass entry can begin with a protocol type such as 

http:// or https://. If a protocol type is used, the exception 

entry applies only to requests for that protocol. Note that the 

protocol value is not case sensitive. Multiple entries should be 

separated by a semicolon (;). 

Next, enter an Internet address, an IP address, or domain name. If 

no protocol is specified, any request using the address is bypassed. 

If a protocol is specified, requests with the address are bypassed 

only if they are of the indicated protocol type. Both address entries 

and protocol types are not case sensitive. 

This field allows a wildcard character ( * ) to be used in place of zero 

or more characters. 

User Authentication 

User Name The user name used for user authentication purposes. 

Password The password used for user authentication purposes. 

Configuring a Double Proxy 

A double proxy configuration is a way to instruct the recorder to use two application 

proxies: one for non-secure HTTP traffic and one for SSL traffic. When you define only 

an HTTP proxy as the application proxy in the Proxy Options tab in the Recording and 

Script Generation Options dialog box, the recorder uses the same definition for both 

traffic types.  

In order to instruct the recorder to use a separate proxy for secured HTTP traffic, 

define the SSL Proxy and Port values.  

WebLOAD IDE also enables you to set authentication information for accessing the 

proxy. In the SSL proxy configuration, the User Name and Password values (in the 

Proxy Authentication frame) are used for both HTTP and SSL proxies. In order to set 

different authentication information for the SSL proxy, add the following lines to 

wlproxyinclude.js (which can be found in the WebLOAD include directory): 

ProxyObject.RSecondarySSLProxyUserName = “radview” 

ProxyObject.RSecondarySSLProxyPassword=“rad1” 

Finally, using this configuration will generate JavaScript code to indicate to the 

playback engine that it needs to use two proxies: 

wlHttp.UseSameProxyForSSL = false 
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wlHttp.HttpProxy =  

wlHttp.HttpsProxy =  

The engine will fit the relevant proxy to the request. 

Setting the Proxy Certificates 

Use the Proxy Certificates tab in the Recording and Script Generation Options dialog 

box to configure the Server Side and Client Side certificates. 

To set the proxy certificates: 

1. Click Recording and Script Generation Options in the Tools tab of the ribbon. 

Or- 

Select Recording and Script Generation Options from the IDE System button. 

The Recording and Script Generation Options dialog box appears (see Figure 107). 

2. Select the Proxy Certificates tab. 

The Proxy Certificates tab moves to the front of the dialog box. 
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Figure 119: Proxy Certificates Tab 

3. Fill in the fields, as described Table 30. 

4. Click OK. 

The following table describes the fields and options on the Proxy Certificates tab. 

Table 30: Proxy Certificates Tab Options 

Field Description 

Server side certificates  

Certificate file name Browse to the server certificate file that will be used to emulate a 

server certificate for the user client application. Default: The 

certificate supplied with the WebLOAD installation. 

Certificate password Type the password for the supplied certificate file. Default: 

password of the supplied by RadView certificate.  
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Field Description 

Trusted CA file name Browse to a Trusted CA file that is a certificate file with the list of 

trusted certificate authorities.  

Note: We recommend that you use the file supplied with the 

WebLOAD installation. 

Client side certificates 

Certificate file name Browse to the client certificate file that will be used by the proxy 

to connect to Internet sites.  

Certificate password Type the password for the supplied certificate file. 

Setting Security Options 

Use the Security tab in the Recording and Script Generation Options dialog box to 

mask passwords in the agenda. 

There are two kinds of passwords you can mask:  

 Protocol passwords – WebLOAD protocol password fields. These are the various 

possible password fields of the wlHttp object. They include the five following 

fields: 

 ProxyNTPassWord 

 ProxyPassWord 

 HttpsProxyPassWord 

 PassWord 

 NTPassWord 

 Form passwords – Password fields in form data. These can vary, depending on the 

form. You can list the names of the passwords fields whose content you wish to 

encrypt.  

In the JavaScript code, the encrypted password is replaced with a ‘decrypt’ statement 

for the encrypted value, as shown in the following example: 

 

Note that the purpose of the masking operation is to make sure passwords are not 

visible in plain text.  
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To set the password encryption options: 

1. Click Recording and Script Generation Options in the Tools tab of the ribbon. 

Or- 

Select Recording and Script Generation Options from the IDE System button. 

The Recording and Script Generation Options dialog box appears (see Figure 107). 

2. Select the Security tab. 

The Security tab moves to the front of the dialog box. 

  

Figure 120: Security Tab 

3. Fill in the fields, as described Table 30. 

4. Click OK. 

The following table describes the fields and options on the Security tab. 
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Table 31: Security Tab Options 

Field Description 

Protocol Passwords  

Encrypt Protocol 

Passwords 

Select this option to instruct WebLOAD to encrypt all WebLOAD 

protocol passwords. 

Form Passwords  

Encrypt Form Passwords Select this option to instruct WebLOAD to encrypt all form 

passwords specified in the Form Passwords Fields List. 

Form Password Fields 

List 

Lists the form passwords that WebLOAD will encrypt. 

Add new form password 

name 

Type the name of a form password field to add it to the Form 

Passwords Fields List. 

Add Click to add a form password field to the Form Passwords Fields 

List. 

Remove Click to delete a selected password field from the Form 

Passwords Fields List. 

 

Configuring the Settings 

WebLOAD IDE enables you to specify settings for WebLOAD IDE. 

Opening the Settings 

To open the Settings dialog box: 

 Click Settings in the Tools tab of the ribbon. 

Or- 

Select Settings from the IDE System button. 

The Settings dialog box opens. 
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Figure 121: Settings Dialog Box 

The following table describes the options in the Settings dialog box. 

Table 32: Settings Dialog Box Options 

Setting Description 

Playback Set the number of iterations to run when running Agendas with 

WebLOAD IDE (Default:1) and determine when to be prompted to save 

the session file. 

File Locations Define the default file locations during a test session.  

Diff Viewer Define which program is used for comparing recordings to playbacks. The 

default is WinMerge. 

Merge Tool Define which program is used for resolving code conflicts by editing the 

JavaScript code. The default is WinMerge.  

Setting Playback Options 

Set the number of iterations to be run during a test session and whether to prompt to 

save the session file before returning from debug mode to edit mode. 

To set Playback iterations: 

1. In the Settings dialog box (Figure 121), click Playback.  

The Playback Options screen is displayed (see Figure 121). 

2. Specify the number of iterations to run during Agenda playback. The default value 

is 1. 
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3. Select Prompt to save the debugging session file if you wish to be prompted to 

save the session file before switching to edit mode. When this is not selected, you 

are prompted to save the session file only when closing an Agenda or exiting 

WebLOAD IDE. 

4. Click OK. 

Setting File Locations 

Define the default file locations during a test session. 

To set the file locations: 

1. In the Settings dialog box (Figure 121), click File Locations. 

The File Locations screen is displayed. 

 

Figure 122: Settings Dialog Box with File Validation Test 

The Description area at the bottom of the dialog provides a short explanation of 

each file location item. 

The following file locations can be defined: 

 Sessions, Agendas, and Templates: Default storage location for WebLOAD IDE 

session, project, and Agenda files. 

 User Include Files: Default path for user Include files. 

 User Copy Files: Default path for user Copy files. 

 User PostData Files: Default path for user PostData files. 

 User Certificate Files: Default path for user Certificate files. 
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2. Double-click the file location option that you wish to reset, and select a new file 

location. 

3. Click OK. 

Defining the Difference Viewer Application 

Define which application is used for comparing and displaying the differences which 

may exist between a recording and its playback. 

To define the difference viewer application: 

1. In the Settings dialog box (Figure 121), click Diff Viewer. 

The Diff Viewer screen is displayed. 

 

Figure 123: Settings Dialog Box with Diff Viewer Options 

By default, WinMerge is selected. 

2. Optionally, select External and enter the relevant information into the 

corresponding field to specify a different application. Enter the following 

information: 

a. The path to the application’s executable file. (Mandatory.) 

b. % rname – Represents the name for the dialog box which displays the 

recording file. (Optional.) 

c. % pname – Represents the name for the dialog box which displays the 

playback file. (Optional.) 

d. % record – Represents the path of the recording file. (Optional.) 

e. % playback – Represents the path of the playback file. (Optional.) 
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Examples: 

 ExamDiff Pro: 

C:\Program Files\ExamDiff Pro\ExamDiff.exe % record % playback --

left_display_name:% rname --right_display_name:% pname 

 KDiff: 

C:\Program Files\KDiff\kdiff3.exe % record % playback --L1 % rname --L2 % 

pname 

 Araxis 

C:\Program Files\Araxis\compare.exe /max /wait /title1:% rname /title2:% 

pname % record % playback 

3. Click OK. 

Defining the Merge Tool Application 

Define which application is used for resolving conflicts between user changes and 

correlation changes made to the JavaScript code. 

To define the merge tool application: 

1. In the Settings dialog box (Figure 121), click Merge Tool. 

The Merge Tool screen is displayed. 

 

Figure 124: Settings Dialog Box with Merge Tool Options 

By default, WinMerge is selected. WinMerge enables 2-way merging. 
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2. Optionally, select External and enter the relevant information into the 

corresponding field to specify a different application such as Araxis, TortoiseSVN 

which enable 3-way merging. Enter the following information: 

a. %basefile – Represents the path of the base file, before user and correlation 

changes. 

b. %corrfile – Represents the path of the file with the correlation changes. 

c. %userfile – Represents the path of the the file with the user changes. 

d. %outfile – Represents the outcome of the merge file. 

Examples: 

 Perforce Merge: 

C:\Path-To\P4Merge.exe %basefile %corrfile %userfile %outfile 

 or with KDiff3: 

C:\Path-To\kdiff3.exe %basefile %userfile %corrfile -o %outfile 

    --L1 Base --L2 User --L3 Correlation 

 or with Araxis: 

C:\Path-To\compare.exe /max /wait /3 /title1:Correlation /title2:Base 

    /title3:User %corrfile %basefile %userfile %outfile /a2 

 or with WinMerge (2.8 or later): 

C:\Path-To\WinMerge.exe %outfile 

 or with DiffMerge: 

C:\Path-To\DiffMerge.exe -caption=%mname -result=%outfile –merge 

    -nosplash -t1=%yname -t2=%bname -t3=%tname %userfile %basefile 

%corrfile 

3. Click OK. 

Customizing the Quick Access Toolbar 

You can use the Customize Quick Access Toolbar option in the Quick Access toolbar 

to customize the Quick Access toolbar. 
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Configuring the Parameterization Manager 

The Parameterization Manager enables you to edit an agenda containing static values 

and transform it into an agenda that will run multiple variations of the static values.  

When recording an agenda, WebLOAD captures the data that is being sent, including 

login details, user selections, and entered text. When running the agenda under load, 

simulating many users, it is desirable to use variations in the data, so as to simulate the 

application more realistically. To do so, you can replace the static values with 

parameters. 

Parameter values can come from a file, or be automatically generated numbers, strings 

and dates. 

The Parameterization Manager enables you to specify how the agenda should select 

values from the data file. For example: 

 Order considerations – Whether to randomly select values from the data file, or 

use them in the order they appear.  

 Uniqueness considerations – Whether the same value can be used at the same time 

by different virtual clients.  

You can also specify the update policy, which defines when a new value will be read 

or calculated. For example, whether to update the value on each round, or once at the 

beginning of the test. 

Opening the Parameterization Manager 

To open the Parameterization Manager dialog box: 

 Click Parameterization Manager in the Home tab of the ribbon. 

The Parameterization Manager dialog box opens. 
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Figure 125: Parameterization Manager Dialog Box 

Setting Parameters in the Parameterization Manager 

1. In the Parameterization Manager Dialog Box (Figure 125), click Add. 

2. In the Name field, enter a name for the parameter. 

3. In the Type field, select the parameter type:  

 Date/Time – Defines a date/time parameter. For more information see Defining 

a Date/Time Parameter (on page 201). 

 File – Defines a data file parameter. For more information see Defining a Data 

File (on page 204). To create a new data file, see Creating a Data File (on 

page 208). 

 Number – Defines a number parameter. For more information see Defining a 

Number Parameter (on page 208). 

 Random String – Defines a random string parameter. For more information see 

Defining a Random String Parameter (on page 212).  

The parameters definitions are stored with the agenda. You can change the parameters’ 

definition at any time by using the Parameterization Manager again. 

Defining a Date/Time Parameter 

To define a date/time parameter: 

1. In the Parameterization Manager Dialog Box (Figure 125), click Add. The 

Parameterization Manager dialog box opens. 



 

 202  Chapter 9. Configuring the WebLOAD IDE Options 

2. In the Type field, select Date/Time. The fields appropriate for defining a date/time 

parameter appear in the dialog box.  

 

Figure 126: Parameterization Manager – Date/Time Dialog Box 

3. In the Description field, optionally enter a description for the date/time parameter. 

4. Fill in the fields as described in Table 33. 

5. Click OK. 

The following table describes the fields and buttons in the Parameterization Manager – 

Date/Time dialog box. 
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Table 33: Parameterization Manager – Date/Time Dialog Box Options 

Setting Description 

Date/Time 

Format 

 

Sample (current 

time) 

Shows the current time in the format you select in Date/Time format. 

Date/Time 

format 

Various predefined date/time formats. Select the desired format. 

Custom format Enables you to define a custom date/time format using the supported field 

types. The valid field options are: 

 %a – Abbreviated weekday name (such as, Fri). 

 %A – Full weekday name (such as, Friday). 

 %b – Abbreviated month name (such as, Oct). 

 %B – Full month name (such as, October). 

 %c – Standard date and time string (Sun Oct 17 04:41:13 2010). 

 %d – Day of the month (1-31). 

 %H – Hour, in 24-hour format (00-23). 

 %I – Hour, in 12-hour format (1-12). 

 %j – Day of the year (1-366). 

 %m – Month in numerical format (1-12). 

 %M – Minute (0-59). 

 %p –AM/PM. 

 %S – Second (0-59). 

 %U – Week of the year, (0-53), where week 1 has the first Sunday. 

 %w – Weekday in numerical format (0-6), where Sunday is 0. 

 %W – Week of the year, (0-53), where week 1 has the first Monday. 

 %x – Date representation, as preferred in your locale. 

 %X – Time representation, as preferred in your locale. 

 %y – Abbreviated year (0-99). 

 %Y – Full year (such as 2011). 

 %Z – Time zone name. 

 %% – Percent sign. 

In addition, you can enter any kind of separator between fields, including 

spaces, dashes, underscores, slashes, and periods. 
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Setting Description 

Verify Format After entering a custom format, click this button to verify whether the 

format is valid: 

 If it is valid, a sample of the format’s output is displayed in the 

Sample (current time) field. 

 If it is invalid, a popup window appears indicating that you must 

enter a valid value. 

Offset Specifies that the date/time parameter will not consider the current date 

and time but another date and time, in the future or in the past. 

Offset 

parameter by 

Determines by how many days and how much time to offset the current 

date.  

Prior to current 

date 

Specifies a negative offset (prior to the current day and time). 

Update Policy Defines when to update the parameter. 

Update value 

on each Round 

The virtual clients update the parameter once per round. Thus, if the same 

parameter appears again in the same round, it will get the same value. 

Update value 

on each use 

The virtual clients update the parameter’s value each time it is used. 

Update value 

per Virtual 

Client 

The virtual clients update the parameter’s value once at the beginning of 

the test (when running the InitClient function). All usage of the parameter 

by that virtual client will always use the same value. 

Defining a Data File 

 To select a data file: 

1. In the Parameterization Manager Dialog Box (Figure 125), click Add. 

2. In the Type field, select File. The fields appropriate for selecting a data file and 

configuring its settings appear in the dialog box.  
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Figure 127: Parameterization Manager – File Dialog Box 

3. In the Description field, optionally enter a description of the file. 

4. Fill in the fields as described in Table 34. 

5. Click OK. 

The following table describes the fields and buttons in the Parameterization Manager – 

File dialog box. 

Table 34: Parameterization Manager – File Dialog Box Options 

Setting Description 

Select Input File  

File Name Enables selecting the data file. Click  to select a data file. 



 

 206  Chapter 9. Configuring the WebLOAD IDE Options 

Setting Description 

File Delimiter The character separating the fields in each row of the data file. 

Create New 

Data File 

Enables creating a new data file. For information, see Creating a Data File 

(on page 208). 

Select access 

method 

Defines the method for reading the next value/row from the file. 

The predefined methods are the most common and useful methods.  

Use values from 

the file 

Use rows from the file without any specific restrictions. 

This is the recommended method to use when applicable. 

This method corresponds to the following Custom settings: 

Scope – local, Order – random, When Out of Values – cycle. 

For the explanations of Scope, Order and When Out of Values, see the 

explanations of the Custom (Advanced) option. 

Use values, 

ensure that 

virtual clients 

do not use the 

same value at 

the same time 

Use unique rows from the file so that a row cannot be used by two virtual 

clients at the same time. This is useful for example if the value is the login 

name, and the system under test does not allow the same user to be logged 

in twice. 

This method corresponds to the following Custom settings: 

Scope – global unique, Order – random, When Out of Values – cycle. 

For the explanations of Scope, Order and When Out of Values, see the 

explanations of the Custom (Advanced) option. 

Use all values 

once and stop 

the virtual 

clients 

Use each row once. When all rows have been used, the virtual clients will 

be stopped. 

This method corresponds to the following Custom settings: 

Scope – global unique, Order – random, When Out of Values – stop virtual 

client. 

For the explanations of the Scope, Order and When Out of Values 

parameters, see the explanations of the Custom (Advanced) option. 

Custom 

(Advanced) 

Enables selecting any combination of Scope, Order and When Out of 

Value settings. 

Scope Defines the scope (sharing policy) of values. 

 Local – Each virtual client reads rows from its own copy of the pool. 

 Global unique – All virtual clients read a unique row from a global 

pool, which is shared by all virtual clients on all load generators. A 

row cannot be used by two virtual clients at the same time.  

 Global – All virtual clients in the session read rows from the shared 

(global) pool. However, the rows are not necessarily unique – two 

virtual clients may happen to use the same row at the same time.  

Note that if you select Global, there is not much point in enforcing 

order on the values because all virtual clients run at the same time, so 

it is not possible to read the values efficiently in a certain order.  

Therefore, specify Random or Not-ordered in the Order field. 
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Setting Description 

Order Defines the method for reading the next row from the file: 

 Random – Every virtual client gets a random row from the file. All 

available rows have the same probability of being selected at any 

given point. 

 Not Ordered – Every virtual client gets a random row from among 

the rows that have been used less times. Over time, all rows are used 

approximately the same number of times. 

 Ordered – Every virtual client gets the next row from the file 

(sequential order). If necessary, the file is read through many times. 

Select this option only if sequential order is crucial for the application.  

When running more than one virtual client concurrently, the order of 

execution is anyway not defined, therefore this option is discouraged. 

 

Note that specifying Ordered in conjunction with a Global or Global 

Unique Scope and Cycle When Out of Values, has unavoidable 

performance costs. 

When out of 

values 

Defines whether the rows can be used any number of times, or only once. 

 Cycle values – Each row can be used any number of times. 

 Stop virtual client – After each row was used once, stop any virtual 

client that requests another row. An error message is written to the 

monitor log window. 

 Keep last value – After each row was used once, keep re-using the 

last value. 

Update Policy Defines when a parameter is updated, meaning when a new row is read. 

 Update value on each Round – A virtual client reads a new row from 

the file per round. Thus, if the same parameter appears again in the 

same round, it will get the same value. 

 Update value on each use – A virtual client reads a parameter’s row 

each time it is used. 

 Update value per Virtual Client – A virtual clients reads a new row 

from the file when initialized (when running the InitClient function). 

All usage of a parameter by that virtual client will always use the 

same value. 

Show all file 

rows / 

Show first 10 

rows only 

Determines which rows the grid displays. 

Use first row as 

title row 

Uses the first row of the file as the title row. If you select this option, the 

values of the first row are not used as data but as parameter names. For 

further explanations, refer to Inserting User-Defined Parameters in an Agenda 

(on page 214). 
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Creating a Data File 

You can create a new data file. 

To create a data file: 

1. From the Parameterization Manager – File dialog box (Figure 127), click Create 

New Data File. 

The Create Data File dialog box appears. 

 

Figure 128: Create Data File Dialog Box 

2. Select a file delimiter from the drop-down list. 

3. Type the number of rows in the Rows field. The default is 10 rows. 

4. Type the number of columns in the Columns field. The default is 10 columns. 

5. If you did not use the default values, click OK. 

6. In the table, type a value in each cell. 

7. Click OK.  

A Save As dialog box appears. Save the new data file. 

Defining a Number Parameter 

To define a number parameter: 

1. In the Parameterization Manager Dialog Box (Figure 125), click Add. The 

Parameterization Manager dialog box opens. 



  

WebLOAD IDE User's Guide  209  

2. In the Type field, select Number. The fields appropriate for defining a number 

parameter appear in the dialog box.  

 

Figure 129: Parameterization Manager – Number Dialog Box 

3. In the Description field, optionally enter a description of the number parameter. 

4. Fill in the fields as described in Table 35. 

5. Click OK. 

The following table describes the fields and buttons in the Parameterization Manager – 

Number dialog box. 
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Table 35: Parameterization Manager – Number Dialog Box Options 

Setting Description 

Number range  

Min The minimum value for the number range. 

Max The maximum value for the number range. 

Select access 

method 

Defines the method for determining the next number value.  

The predefined methods are the most common and useful methods. 

Random Use random numbers freely. 

This method corresponds to the following Custom settings: 

Scope – local, Order – random, When Out of Values – cycle. 

For the explanations of Scope, Order and When Out of Values, see the 

explanations of the Custom (Advanced) option. 

Random 

Unique, ensures 

that virtual 

clients do not 

use the same 

value at the 

same time 

Use unique numbers. A number cannot be used by two virtual clients at 

the same time. 

This method corresponds to the following Custom settings: 

Scope – global unique, Order – random, When Out of Values – cycle. 

For the explanations of Scope, Order and When Out of Values, see the 

explanations of the Custom (Advanced) option. 

Use all values 

from the range 

once and stop 

the virtual 

clients 

Use each number once. When all numbers in the range have been used, 

the virtual clients will be stopped.  

This method corresponds to the following Custom settings: 

Scope – global unique, Order – random, When Out of Values – stop virtual 

client. 

For the explanations of Scope, Order and When Out of Values, see the 

explanations of the Custom (Advanced) option. 

Local counter, 

each Virtual 

Client takes 

values 

sequentially 

from its own 

pool. 

Each virtual client will pass through the numbers in the range. 

This method corresponds to the following Custom settings: 

Scope – local, Order – ordered, When Out of Values – cycle. 

For the explanations of Scope, Order and When Out of Values, see the 

explanations of the Custom (Advanced) option. 

Global counter, 

all Virtual 

Clients take 

values 

sequentially 

from a shared 

pool 

Use increasing integer values. Each value can be used only once. When the 

whole range is used, the virtual clients are stopped. 

This method corresponds to the following Custom settings: 

Scope – global unique, Order – ordered, When Out of Values – stop virtual 

client. 

For the explanations of Scope, Order and When Out of Values, see the 

explanations of the Custom (Advanced) option. 
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Setting Description 

Custom 

(Advanced) 

Enables selecting any combination of Scope, Order and When Out of 

Value settings. 

Scope Defines the scope (sharing policy) of values. 

 Local – Each virtual client reads values from its own copy of the pool. 

 Global unique – All virtual clients read a unique value from a global 

pool, which is shared by all clients on all load generators. A value 

cannot be used by two virtual clients at the same time.  

 Global – All virtual clients in the session read values from the shared 

(global) pool. However, the values are not necessarily unique – two 

virtual clients may happen to use the same value at the same time.  

Note that if you select Global, there is not much point in enforcing 

order on the values because all virtual client run at the same time, so 

it is not possible to read the values efficiently in a certain order.  

Therefore, specify Random or Not-ordered in the Order field. 

Order Defines the method for determining the next number value: 

 Random – Every virtual client gets a random number value. All 

available values have the same probability of being selected at any 

given point. 

 Not Ordered – Every virtual client gets a random number value from 

among the values that have been used less times. Over time, all rows 

are used approximately the same number of times.  

 Ordered – Every virtual client gets the next number value. If 

necessary, the sequence of numbers is gone through many times. 

Select this option only if sequential order is crucial for the application. 

In general, this option is not recommended 

Note that specifying Ordered in conjunction with a Global or Global 

Unique scope and Cycle When Out of Values, has unavoidable 

performance costs. 

When out of 

values 

Defines whether the values can be used any number of times, or only 

once. 

 Cycle values – Each value can be used any number of times. 

 Stop virtual client – After each value was used once, stop any virtual 

client that requests another value. An error message is written to the 

monitor log window. 

 Keep last value – After each value was used once, keep re-using the 

last value. 
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Setting Description 

Update Policy Defines when a parameter is updated, meaning when a new value is read. 

 Update value on each Round – A virtual client reads a new value per 

round. Thus, if the same parameter appears again in the same round, 

it will get the same value. 

 Update value on each use – A virtual client reads a parameter’s value 

each time it is used. 

 Update value per Virtual Client – A virtual clients reads a new value 

when initialized (when running the InitClient function). All usage of 

a parameter by that virtual client will always use the same value. 

Defining a Random String Parameter 

To define a random string parameter: 

1. In the Parameterization Manager Dialog Box (Figure 125), click Add. The 

Parameterization Manager dialog box opens. 

2. In the Type field, select Random String. The fields appropriate for defining a 

random string parameter appear in the dialog box.  
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Figure 130: Parameterization Manager – Random String Dialog Box 

3. In the Description field, optionally enter a description of the random string 

parameter. 

4. Fill in the fields as described in Table 36. 

5. Click OK. 

The following table describes the fields and buttons in the Parameterization Manager – 

Random String dialog box. 
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Table 36: Parameterization Manager – Random String Dialog Box Options 

Setting Description 

String length  

Min The minimum length of the string, in number of characters. 

Max The maximum length of the string, in number of characters. 

Update Policy Defines when to update the parameter, meaning when the virtual clients 

get a new value for the parameter. 

 Update value on each Round – A virtual clients reads a new value 

per round. Thus, if the same parameter appears again in the same 

round, it will get the same value. 

 Update value on each use – A virtual clients reads a parameter’s 

value each time it is used.  

 Update value per Virtual Client – A virtual clients reads a new value 

when initialized (when running the InitClient function). All usage of 

the parameter by that virtual client will always use the same value. 

 

Note: Using a random string parameter in a script does not provide unique values. If 

you need unique values, or special formatting of the string, create a data file with 

unique values and use File parameterization (see Defining a Data File on page 204). 

Inserting User-Defined Parameters in an Agenda 

WebLOAD IDE enables you to edit parameters having static values and replace the 

static values with a call to a set of specified values. During runtime, the agenda runs 

the parameter using values from the set.  

The first step is to use the Parameterization Manager to define the set of values (see 

Configuring the Parameterization Manager on page 200). The set of values is a type of 

parameter (Number parameter, String parameter, Date/Time parameter or Data File 

parameter). The second step, described in this section, is to replace a static value in the 

agenda with a call to the defined parameter.  

To insert a user-defined parameter in an Agenda: 

1. In the main window, click Open in the File tab of the ribbon, and open the Agenda 

you want to edit. 

2. In the JavaScript View pane, select the static value you want to replace.  

For example, in the line : 

wlHttp.FormData["name"] = "john" 
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select "John". 

3. Right-click and select Insert Variable. 

The Insert Variable menu appears (Figure 54). 

4. Select the parameter you defined in the Parameterization Manager.  

The selected parameter replaces the static value in the Agenda. 

In our example, if you selected Users_firstname.getValue()from the Insert 

Variable menu, the line now shows: 

wlHttp.FormData["name"] = Users_firstname.getValue(); 

Note that if you are using a parameter from a data file, the parameter name reflects 

whether the data file includes a title row.  

 If the data file includes a title row, the parameter name is of type: 

{Parameter name}_{column title}.getValue().  

 If the data file does not include a title row, the column number is used, and the 

parameter name is of type:  
{Parameter name}_Col{column number}.getValue() 

Note: To replace multiple occurrences of a static value, you can use the Edit  Replace 

tool. 

Example of Using User-Defined Parameters in an Agenda 

If the original recorded agenda includes: 

wlHttp.FormData["first_name"] = "John" 

wlHttp.FormData["last_name"] = "Smith" 

wlHttp.FormData["age"] = "47" 

and you wish to replace the static values (John, Smith, 47) with parameters, you can 

define a random number parameter ‘Age’, and a file parameter that calls the ‘Users’ 

data file having columns ‘firstName’ and ‘lastName’. 

Using the Insert Variable menu, modify the agenda as follows: 

wlHttp.FormData["first_name"] = Users_firstName.getValue(); 

wlHttp.FormData["last_name"] = Users_lastName.getValue(); 

wlHttp.FormData["age"] = Age.getValue(); 
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Appendix A 

The WebLOAD IDE Toolbox Set 

This section describes the WebLOAD IDE toolbox set. 

The WebLOAD IDE Toolbox Items 

The following are the WebLOAD IDE Toolbox items: 

Table 37: Toolbox Items 

Toolbox Items 

General 

 Sleep  Message 

 JavaScriptObject  Comment 

 Try   Catch  

Load 

 Begin Transaction  End Transaction 

 Set Timer  Send Timer 

 Synchronization Point  Send Measurement 

 URL Screening   Value Extraction  

 Define Concurrent   Execute Concurrent  

IPP 

 FTP-connect  FTP-upload 

 FTP-download  FTP-disconnect 

 SMTP-send message  POP-retrieve 

 POP-Delete  IMAP-Connect 

 IMAP-Retrieve  IMAP-Delete 

 IMAP-CreateMailbox  IMAP-ListMailboxes 

 IMAP-DeleteMailbox  IMAP-RenameMailbox 
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Toolbox Items 

 IMAP-SubscribeMailbox  IMAP-UnsubscribeMailbox 

 IMAP-ListSubscribedMailbox  IMAP-Search 

 NNTP-Connect  NNTP-GetArticle 

 NNTP-GetArticleCount  NNTP-PostArticle 

 TCP-Connect  TCP-Send 

 TCP-Receive  TCP-Erase 

 TELNET-Connect  TELNET-Receive 

 TELNET-Send  TELNET-Erase 

 UDP-Bind  UDP-Broadcast 

 UDP-Receive  UDP-Send 

 UDP-Erase  LDAP-Bind 

 LDAP-Search  LDAP-UnBind 

Database 

 OpenDB  Oracle OpenDB 

 MySQL OpenDB  Execute Command 

 Fetch Data   DB GetLine  

 Oracle DB GetLine   MySQL DB GetLine 

 DB Load  Oracle DB Load 

 MySQL DB Load   

Verifications 

 WS-SingleNode  WS-MultipleNodes 

 Flex:Verify-Ext  Flex:Extract-Ext 

Multimedia 

 Streaming-Create  Streaming-Play 

 Streaming-Play with range  Streaming-Wait for Media 

and Stop 

 Streaming-Wait for Media 

and Pause 

 Streaming-Close 
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The WebLOAD IDE General Toolbox 

The following table describes the purpose of each of the WebLOAD IDE General 

Toolbox items: 

Table 38: General Toolbox Items 

Agenda Item Purpose 

Sleep Emulates the time it takes users to get from one page to the next 

- includes download time and the time it takes to read the page. 

Message Places an informational or error message in the script. This 

message will appear in the Log window when you play back the 

Agenda. Message objects can also be used to print out the values 

of variables. 

JavaScript Object Enables you to insert JavaScript code directly into the Agenda. 

You can code directly in JavaScript. 

To add a JavaScript Object to the Agenda, drag the JavaScript 

Object icon into the Agenda tree, and then open the object to 

insert JavaScript code. 

Comment Places comments in your Agenda. The comment will appear in 

the JavaScript View pane when viewing the entire Agenda. 

Try…Catch Places Try and Catch statements in your Agenda. You can use 

the Try...Catch statements for structured exception handling. 

Sleep 

Users vary their activity when accessing a Web application, sometimes pausing 

between transactions and occasionally only accessing the server intermittently. The 

time a user waits between performing consecutive actions is known as sleep time. 

When you record an Agenda, WebLOAD IDE automatically records the actual sleep 

time and inserts sleep icons into the Agenda. You can edit the recorded sleep times 

manually, add more sleep statements, and control how WebLOAD is influenced by the 

sleep timers in the Agenda. 

To insert sleep timers: 

1. Drag the Sleep  icon from the General toolbox into the Agenda Tree at the 

desired location. 

The Sleep dialog box opens. 
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Figure 131: Sleep Dialog Box 

2. In the Enter or select pause time field, enter or select the duration of the sleep. The 

default value is 1000 milliseconds. 

The Sleep item appears in the Agenda Tree and the JavaScript code is added to the 

Agenda. To see the new JavaScript code, view the Agenda in JavaScript Editing 

mode. 

Message 

While running a test session, WebLOAD IDE and WebLOAD IDE’s Log windows 

display information about session execution. You can include Message nodes in your 

Agenda, defining points at which to send error and/or notification messages to the Log 

window. 

To insert a message: 

1. Drag the Message  icon from the General toolbox into the Agenda Tree at the 

desired location. 

The Message dialog box opens. 

 

Figure 132: Message Dialog Box 

2. Create a text message by typing the text you want to appear in the message into 

the input text box. 
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Note: When entering a string value to the message, the string must be enclosed in 

quotation marks; for example, “Sample Message”. 

3. To add a global variable to the message text, click the globe icon to the right of the 

input text box and select a global variable from the drop-down list. 

4. Select a severity level for the message from the drop-down list. 

The following severity levels are available: 

 Information message (WLInfoMessage) 

 Minor error message (WLMinorError) 

 Error message (WLError) 

 Severe error message (WLSevereError) 

 Debug message (WLDebugMessage) 

5. Click OK. 

The Message item appears in the Agenda Tree and the JavaScript code is added to 

the Agenda. To see the new JavaScript code, view the Agenda in JavaScript Editing 

mode. 

JavaScriptObject 

JavaScript Objects enable you to insert JavaScript code directly into the Agenda, giving 

you access to advanced functionality not available through the WebLOAD IDE graphic 

interface. For example, working with XML or COM, or retrieving data from a database, 

are all tasks that require some additional programming code. 

To insert a JavaScriptObject: 

1. Drag the JavaScriptObject  icon from the General toolbox into the Agenda Tree 

at the desired location. 

The JavaScriptObject item appears in the Agenda Tree and the WebLOAD IDE 

protocol block is added to the Agenda. 

2. Open the object in JavaScript Editing mode to insert JavaScript code, as described 

in Using the JavaScript Editor (on page 73). 
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Comment 

WebLOAD IDE enables you to add comments to your Agenda to describe an activity 

or provide information about a specific operation. 

To insert a comment: 

1. Drag the Comment  icon from the General toolbox into the Agenda Tree at the 

desired location. 

The Comment dialog box opens. 

 

Figure 133: Comment Dialog Box 

2. Enter the text you want to appear in the comment. 

3. Click OK. 

The Comment item appears in the Agenda Tree and the JavaScript code is added 

to the Agenda. To see the new JavaScript code, view the Agenda in JavaScript 

Editing mode. 

Try / Catch Statements 

You can use the Try…Catch statements for structured exception handling. This enables 

you to execute a particular block of statements if a specified exception occurs while 

your code is running. 

To insert a Try...Catch statement: 

1. Drag the Try  icon from the General toolbox into the Agenda Tree directly before 

the first action you want to include in the Try...Catch block. 

2. Drag the Catch  icon from the General toolbox into the Agenda Tree directly after 

the last action you want to include in the Try...Catch block. 
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The Try and Catch items appear in the Agenda Tree and the JavaScript code is 

added to the Agenda. To see the new JavaScript code, view the Agenda in 

JavaScript Editing mode. 

The WebLOAD IDE Load Toolbox 

The following table describes the purpose of each of the WebLOAD IDE Load Toolbox 

items: 

Table 39: Load Toolbox Items 

Agenda Item Purpose 

Begin 

Transactions 

End 

Transactions 

Adds named transactions to the Agenda to measure the 

performance of logical actions in your Agenda, such as a Login 

process. By inserting named transactions into your Agenda, you 

can take a series of simple actions, define them as a single 

transaction, and set success or failure criteria for the complete 

transaction. 

Set Timer 
  

Send Time 

Timers let you time any operation or group of operations in an 

Agenda and send the time statistics to the WebLOAD Console. 

SynchronizationPo

int 

Create peak server loads that stress your system to the limit by 

deliberately forcing multiple Virtual Clients to perform key 

tasks and execute a given command at precisely the same 

moment in real time. 

SendMeasurement Create a new measurement name and assign a value to the 

measurement available in WebLOAD reports. 

URL Screening Specify the URLs the WebLOAD engine should ignore (not 

fetch). 

ValueExtraction Extract a value from a string using a prefix and suffix. 

DefineConcurrent Define a starting point after which the WebLOAD engine 

collects all Post and Get HTTP requests, but does not execute 

them, until an Execute Concurrent function is run. 

ExecuteConcurrent Defines a starting point after which the WebLOAD engine stops 

collecting and begins executing all the Post and Get HTTP 

requests that were defined since the last Define Concurrent 

function, concurrently (using multithreading). 

Begin and End Transaction 

In addition to the automatic transactions provided by WebLOAD, you can use the 

WebLOAD IDE GUI to easily add named transactions to the Agenda to measure the 
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performance of logical actions in your Agenda, such as a Login process. By inserting 

named transactions into your Agenda, you can take a series of simple actions, define 

them as a transaction, and set success or failure criteria for the transaction. Each 

transaction can be a simple action, such as a query, or a complex action that may 

include several steps. 

To measure transactions, you must mark the beginning and end of the transaction in 

your Agenda. During runtime, WebLOAD measures the time it takes to complete the 

transaction and reports the results in the WebLOAD Integrated reports, Statistics 

reports, and Data Drilling report. 

Note: You can add an unlimited number of transactions into your Agenda, each with a 

different name. 

To mark the beginning of a transaction: 

1. Drag the Begin Transaction  icon from the Load toolbox into the Agenda Tree, 

directly above the first action you want to include in the transaction. 

The Begin Transaction dialog box opens. 

 

Figure 134: Begin Transaction Dialog Box 

2. Enter a logical name for the transaction; for example, Login. 

3. Click OK. 

The Begin Transaction item appears in the Agenda Tree and the JavaScript code is 

added to the Agenda. To see the new JavaScript code, view the Agenda in 

JavaScript Editing mode. 

To mark the end of a transaction: 

1. Drag the End Transaction  icon from the Load toolbox into the Agenda Tree, 

directly after the last action you want included in the Agenda. 

The End Transaction dialog box opens. 
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Figure 135: End Transaction Dialog Box 

2. Select the transaction to end from the Select Opened Transaction drop-down list. 

3. Select a return value for the transaction from Select Return Value drop-down list. 

You can select from the return values provided, or select Custom Function to 

create your own verification function to call when the transaction is complete. 

For information on creating custom functions, see the WebLOAD Scripting Guide. 

4. To set WebLOAD to save the results of all transaction instances, successes and 

failures, for later analysis with Data Drilling, select true in the Save transaction 

information for Data Drilling field. Select false (default) to save only results of 

failed transaction instances that triggered some sort of error flag. 

5. Optionally, enter a text string to specify a possible reason for a transaction failure 

within your transaction verification function in the Failure Reason field. This 

reason will also appear in the Statistics Report. 

6. Click OK. 

The End Transaction item appears in the Agenda Tree and the JavaScript code is 

added to the Agenda. To see the new JavaScript code, view the Agenda in 

JavaScript Editing mode. 

Set and Send Timer 

Timers let you time any operation or group of operations in an Agenda and send the 

time statistics to the WebLOAD Console. For example, you can add a timer to measure 

the amount of time needed to complete a series of user activities on a single Web page. 

You can add timers to an Agenda directly through the WebLOAD IDE. 
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Note: When you set a timer, it is automatically zeroed. 

To mark the beginning of a timer: 

1. Drag the Set Timer  icon from the Load toolbox into the Agenda Tree directly 

before the first action you want to include in the timed task. 

The Set Timer dialog box opens. 

 

Figure 136: Set Timer Dialog Box 

2. Type a name for the timer in the Enter a timer name field. 

3. Click OK. 

The Set Timer item appears in the Agenda Tree and the JavaScript code is added to 

the Agenda. To see the new JavaScript code, view the Agenda in JavaScript Editing 

mode. 

To mark the end of the timer: 

1. Drag the Send Timer  icon from the Load toolbox into the Agenda Tree directly 

after the last action you want included in the timed task. 

The Send Timer dialog box opens.  

 

Figure 137: Send Timer Dialog Box 

2. From the Select Timer drop-down list, to select the timer to end. 
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3. Click OK. 

The Send Timer item appears in the Agenda Tree and the JavaScript code is added 

to the Agenda. To see the new JavaScript code, view the Agenda in JavaScript 

Editing mode. 

Synchronization Point 

During a test session, WebLOAD simulates the random nature of the real world, where 

even with hundreds or thousands of Web site hits, users do not all necessarily execute 

the same commands at precisely the same instant. However, for testing purposes, you 

may wish to create peak server loads that stress your system to the limit by 

deliberately forcing multiple Virtual Clients to perform key tasks and execute a given 

command at precisely the same moment in real time. 

WebLOAD provides Synchronization Points to coordinate the actions of multiple 

Virtual Clients. A Synchronization Point is a meeting place where Virtual Clients wait 

before continuing with an Agenda. When one Virtual Client arrives at a 

Synchronization Point, WebLOAD holds the Client at that point until all the other 

Virtual Clients arrive. When all the Virtual Clients have arrived, they are all released at 

once to perform the next action in the Agenda simultaneously. 

For example, suppose that you want to simulate 500 users, all trying to access a form 

on the same Web page simultaneously. To maximize the impact of this test situation, 

all 500 Virtual Clients must access the form at exactly the same time. Add a 

Synchronization Point before the form entry node to ensure that all the Virtual Clients 

log in simultaneously. 

WebLOAD IDE enables you to define the meeting place where all Virtual Clients wait. 

You can also optionally set the timeout value, the number of milliseconds that 

WebLOAD will wait for all of the Virtual Clients to arrive at the Synchronization Point. 

The timeout is a safety mechanism that prevents an infinite wait if any of the Virtual 

Clients does not arrive at the Synchronization Point for any reason. Once the timeout 

period expires, WebLOAD releases the rest of the Virtual Clients. Setting a timeout 

value is important to ensure that the test session will not ‘hang’ indefinitely in case of 

error. 

To insert a Synchronization Point: 

1. Drag the Synchronization Point  icon from the Load toolbox into the Agenda 

Tree directly before the action you want all Virtual Clients to perform 

simultaneously. 

The Synchronization Point dialog box opens. 
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Figure 138: Synchronization Point Dialog Box 

2. In the Timeout Value field, enter or select a timeout value for the Synchronization 

Point. The default value is 1000 milliseconds. 

The Synchronization Point item appears in the Agenda Tree and the JavaScript 

code is added to the Agenda. To see the new JavaScript code, view the Agenda in 

JavaScript Editing mode. 

During a test session, the SynchronizationPoint() function returns a value to 

WebLOAD. This value indicates whether the function was successful or not. All 

failures are logged and displayed in the WebLOAD and Console Log windows, similar 

to any other WebLOAD test failure.  

Synchronization Point function calls may return one of the following return values: 

 WLSuccess—synchronization succeeded. All Virtual Clients arrived at the 

Synchronization Point and were released together.  

 WLLoadChanged—synchronization failed. A change in the load size was detected 

while Virtual Clients were being held at the Synchronization Point. All Virtual 

clients were released. 

 WLTimeout—synchronization failed. The timeout expired before all Virtual 

Clients arrived at the Synchronization Point. All Virtual Clients were released. 

 WLError—synchronization failed. Invalid timeout value. All Virtual Clients were 

released. 

For a complete explanation and example of the SynchronizationPoint function 

syntax, see WebLOAD Actions, Objects, and Functions, in the WebLOAD JavaScript 

Reference Guide. 
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Send Measurement 

WebLOAD IDE enables you to insert Send Measurement actions into your Agenda to 

create a new measurement name and assign a value to the measurement. During 

runtime the measurement is displayed in the WebLOAD statistics report.  

To create and set the value for a measurement: 

1. Drag the Send Measurement  icon from the Load toolbox into the Agenda Tree 

at the desired location. 

The Send Measurement dialog box opens. 

 

Figure 139: Send Measurement Dialog Box 

2. Type or select a name for the measurement in the Select measurement name field. 

3. Type or select a value for the measurement in the Set measurement value field. 

4. Click OK. 

The Send Measurement item appears in the Agenda Tree and the JavaScript code is 

added to the Agenda. To see the new JavaScript code, view the Agenda in 

JavaScript Editing mode. 

URL Screening 

WebLOAD IDE enables you to add URL screening to an Agenda to define the URLs 

that the WebLOAD protocol engine should ignore during runtime. The ability to 

ignore links on the page being tested is a useful feature. For example, many Web sites 

include links to external sites. If these sites are not relevant to the testing requirements, 

they should be ignored. Other links may be to advertisement sites that charge a fee 

every time the link is accessed. Hitting these links during a typical load test that may 

run hundreds or thousands of iterations would be a tremendous waste, so these links 

should also be ignored. 
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To add URL screening to an Agenda: 

1. Drag the URL Screening  icon, from the Load toolbox, into the Agenda Tree at 

the desired location. 

The URL Screening Building Block parameters dialog box opens. 

 

Figure 140: URL Screening Building Block Parameters Dialog Box 

2. Enter the URLs to ignore, separated by commas, in the Value field. 

3. Click OK. 

The URL Screening Building Block is added to the Agenda Tree. The JavaScript 

code, including the InitAgenda() function, is added to the Agenda. To see the 

new JavaScript code, view the Agenda in JavaScript Editing mode. 

Note: Fields that were not assigned a value in the dialog box are left as empty fields in 

the Agenda code. 

Value Extraction 

WebLOAD IDE enables you to add value extraction to an Agenda to define the 

parameters for the extractValue JavaScript function. 

To add value extraction to an Agenda: 

1. Drag the Value Extraction  icon, from the Load toolbox, into the Agenda Tree at 

the desired location. 
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The Value Extraction Building Block parameters dialog box opens. 

 

Figure 141: Value Extraction Building Block Parameters Dialog Box 

2. In the Prefix field, enter a prefix. 

3. In the Suffix field, enter a suffix. 

4. In the Str field, enter the string that will be searched. 

5. In the retVarName, enter the variable name that will be generated to the Agenda. 

6. Click OK. 

The Value Extraction Building Block is added to the Agenda Tree. The JavaScript 

code is added to the Agenda. To see the new JavaScript code, view the Agenda in 

JavaScript Editing mode. 

Note: Fields that were not assigned a value in the dialog box are left as empty fields in 

the Agenda code. 

Define Concurrent 

WebLOAD IDE enables you to collect Post and Get HTTP requests and simultaneously 

execute them by two or more threads, as defined in the MultiThread Virtual Clients 

number. This is configured in the Browser Parameters tab in WebLOAD Console’s 

Agenda Options dialog box. 

Note: WebLOAD IDE does not perform the Post and Get HTTP requests concurrently.  
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To simultaneously execute Post and Get HTTP requests, you must define where in the 

Agenda to begin collecting the requests and where to stop collecting and begin 

executing them. The HTTP requests are collected until the engine encounters an 

Execute Concurrent function in the Agenda. For more information about the 

Execute Concurrent Building Block, see Execute Concurrent (on page 232). 

These Post and Get HTTP requests are saved in a file which you can access at any time. 

For more information, refer to the WebLOAD JavaScript Reference.  

To start collecting HTTP requests in an Agenda: 

 Drag the Define Concurrent  icon from the Load toolbox into the Agenda Tree 

at the desired location. 

The Define Concurrent Building Block is added to the Agenda Tree. The JavaScript 

code is added to the Agenda. To see the new JavaScript code, view the Agenda in 

JavaScript Editing mode. 

Execute Concurrent 

WebLOAD IDE enables you to simultaneously execute all the Post and Get HTTP 

requests that were defined since the last Define Concurrent function by two or 

more threads, as defined in the MultiThread Virtual Clients number. This is configured 

in the Browser Parameters tab in WebLOAD Console’s Agenda Options dialog box. 

Note: This function can only be inserted in your Agenda after a Define Concurrent 

function. For more information about the Define Concurrent function, see Define 

Concurrent (on page 231). 

When the engine encounters the Execute Concurrent function, it stops collecting 

the HTTP requests in the Agenda and starts their execution.  

To start concurrently executing HTTP requests in an Agenda: 

 Drag the Execute Concurrent  icon from the Load toolbox into the Agenda Tree 

at the desired location. 

The Execute Concurrent Building Block is added to the Agenda Tree. The 

JavaScript code is added to the Agenda. To see the new JavaScript code, view the 

Agenda in JavaScript Editing mode. 

The WebLOAD IDE IPP Toolbox 

Use the WebLOAD IDE IPP Building Blocks to simply and easily add IPP functionality 

to your test session Agenda without having to write numerous lines of code. 

 



  

WebLOAD IDE User's Guide  233  

To add IPP Building Blocks to a test Agenda directly through the WebLOAD IDE 

GUI: 

 Drag the selected IPP icon from the IPP toolbox and drop it into the Agenda Tree 

at the appropriate point. 

WebLOAD IDE automatically adds the appropriate JavaScript code to your test 

session Agenda. 

WebLOAD IDE provides full support for secure sites that utilize the SSL security 

protocol. The same FTP, POP, and SMTP functionality that is available for standard-

security sites is also provided for sites that utilize the SSL security protocol. WebLOAD 

IDE SSL protocol support is virtually transparent for the web site tester. Simply choose 

the appropriate Building Block, such as FTP-Connect, for example. Activate the SSL 

Protocol feature by setting the Boolean SSLFlag property to true. Complete the rest of 

the Building Block properties as described for standard Building Block use. 

Note: The IPP Building Blocks displayed in the IPP toolbox correspond to only a small 

part of the WebLOAD IDE IPP function set. These Building Blocks are provided for the 

most commonly used IPP activities. For a description of the complete set of IPP 

functions supported by WebLOAD IDE, see the WebLOAD Internet Protocols Reference 

in the WebLOAD JavaScript Reference Guide. 

The following IPP dialog boxes are described here: 

Table 40: IPP Dialog Boxes 

IPP Protocol Building Blocks 

FTP 

 

FTP-Connect (on page 236) 

 

FTP-Upload (on page 238) 

 

FTP-Download (on page 240) 

 

FTP-Disconnect (on page 242) 

SMTP 

 

SMTP-Send Message (on page 242) 

 

POP 

 

POP-Retrieve (on page 245) 

 

POP-Delete (on page 246) 

 



 

 234  Appendix A. The WebLOAD IDE Toolbox Set 

IPP Protocol Building Blocks 

IMAP 

 

IMAP-Connect (on page 249) 

 

IMAP-Retrieve (on page 251) 

 

IMAP-Delete (on page 252) 

 

IMAP-CreateMailbox (on 

page 254) 

 

IMAP-ListMailboxes (on page 255) 

 

IMAP-DeleteMailbox (on 

page 255) 

  

IMAP-RenameMailbox (on page 257) 

 

IMAP-SubscribeMailbox (on 

page 258) 

 

IMAP-UnsubscribeMailbox (on page 259) 

 

IMAP-ListSubscribedMailboxes (on 

page 261) 

 

IMAP-Search (on page 261) 

 

NNTP 

 

NNTP-Connect (on page 264) 

 

NNTP-GetArticle (on page 266) 

 

NNTP-GetArticleCount (on page 268)  

 

NNTP-PostArticle (on page 269)) 

TCP 

 

TCP-Connect (on page 271)) 

 

TCP-Send (on page 273)  

 

TCP-Receive (on page 274)  

 

TCP-Erase (on page TCP-Erase)  
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IPP Protocol Building Blocks 

TELNET 

 

TELNET-Connect (on page 275) 

 

TELNET-Receive (on page 277)) 

 

TELNET-Send (on page 279)  

 

TELNET-Erase (on page 280)  

 

UDP 

 

 

 

 

 

 

 

 

UDP-Bind (on page 281)  

 

UDP-Broadcast (on page 283)  

 

UDP-Receive (on page 284)  

 

UDP-Send (on page 285)  

 

UDP-Erase (on page 286)  

 

LDAP 

  

 

 

 

Each IPP icon opens a different dialog box. Enter the required values in the Value field. 

Explanations are provided at the bottom of the dialog box for each parameter as it is 

selected in the dialog box. 

Note: Values that must be enclosed within quotation marks are indicated in the Value 

column by sets of quotation marks. Type the field value within the quotation marks 

that automatically appear in the input-text box that pops-up when the value field is 

selected. Fields that were not assigned a value in the dialog box are left as empty fields 

in the Agenda code. 

Once you have finished defining the new IPP activity, the new action is reflected in the 

Agenda Tree. An IPP icon is added to the Agenda Tree for each IPP activity defined. 

WebLOAD IDE automatically adds the corresponding JavaScript code to your test 

session Agenda. 

To see the complete sequence of JavaScript code for all the IPP Building Blocks that 

have been added to the Agenda tree, click the Agenda root node in the Agenda tree. 
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Note: The JavaScript code for each of the IPP Building Blocks can be found in the IPP 

library files, part of the Include directory under the WebLOAD installation directory. 

Each protocol has its own library file. For example, the SMTP functions refer to the 

wlSMTP.js file. 

FTP 

Dragging an FTP icon into your Agenda Tree opens an FTP Building Block parameters 

dialog box. 

FTP toolbox items include: 

 FTP-Connect: Open an FTP connection. 

 FTP-Upload: Designate a file to be uploaded to a remote host. 

 FTP-Download: Designate a file to be downloaded from a remote host. 

 FTP-Disconnect: Disconnect from a remote host. 

FTP-Connect 

Use the FTP-Connect Building Block to open an FTP connection.  

To enter a value: 

1. Drag the FTP-Connect icon from the IPP toolbox into the Agenda Tree at the 

desired location. 

The FTP-Connect Building Block parameters dialog box opens. 
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Figure 142: FTP-Connect Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area explains that the 

UserName field is used to define the user ID to be used when logging in to the 

specified FTP host. WebLOAD IDE automatically sends the user-specified name 

and password to the FTP host when connecting. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 41. 

4. Click OK. 

The FTP-Connect Building Block is added to the Agenda Tree. The JavaScript code, 

including the InitAgenda()and InitClient() functions, is added to the 

Agenda. To see the new JavaScript code, view the Agenda in JavaScript Editing 

mode. 

In the Agenda, the InitAgenda()function notes that the connection will be 

utilizing SSL security, and therefore includes the WebLOAD IDE FTP/SSL library 

file. The InitClient() function includes a command to define a separate 

FTP/SSL object for each client. Within the main body of the Agenda, an FTP 

connection is opened using the connection name, user name, and password 

specified by the user. 
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The fields in the FTP-Connect Building Block parameters dialog box are described in 

the following table: 

Table 41: FTP Connect Building Block Parameters Dialog Box Fields 

Field Name Description 

FTP Host Specify the name of the FTP host connection. 

Type the FTP Host name into the input-text window that appears when 

you click the small arrow to the right of the Value input area for this field. 

The FTP host is identified either through a DNS number or a full name 

string. A host name string must be enclosed within quotation marks. 

User Name Specify a user ID for the FTP connection. 

Type the user ID into the input-text window that appears when you click 

the small arrow to the right of the Value input area for this field. 

The user name must be enclosed within quotation marks. 

Password Specify a password for authentication during the FTP connection. 

Type the password into the input-text window that appears when you click 

the small arrow to the right of the Value input area for this field. 

The password must be enclosed within quotation marks. 

Secure FTP 

(FTPS) 

Select the appropriate Boolean value to indicate whether the site being 

accessed utilizes the SSL security protocol. 
 

FTP-Upload 

Use the FTP-Upload Building Block to designate a file to be uploaded to a remote host.  

To enter a value: 

1. Drag the FTP-Upload icon from the IPP toolbox into the Agenda Tree at the 

desired location. 

The FTP-Upload Building Block parameters dialog box opens. 
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Figure 143: FTP-Upload Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area explains that the Uploaded 

File field is used to define the name and location for the file to be saved on the 

specified FTP host. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 42. 

Note: If the Agenda will be running for multiple clients or over multiple rounds, use 

global variables to specify a unique file name for each client and/or round, to avoid file 

access conflicts and to make it easier to work with and analyze the files after the test is 

completed. For example: 

“k:\Ftp\files\inputFiles\text_upload_”+ ThreadNum + RoundNum + 

“.txt” 

4. Click OK. 

The FTP-Upload Building Block is added to the Agenda Tree and the JavaScript code is 

added to the Agenda. To see the new JavaScript code, view the Agenda in JavaScript 

Editing mode. 

Note: The WebLOAD IDE global variables ThreadNum and RoundNum are used to 

differentiate between the files uploaded by different clients during different test 

iterations. 

 

 



 

 240  Appendix A. The WebLOAD IDE Toolbox Set 

The fields in the FTP-Upload Building Block parameters dialog box are described in 

the following table: 

Table 42: FTP-Upload Building Block Parameters Dialog Box Fields 

Field Name Description 

File for 

upload 

Specify the name of the file to be uploaded to the specified FTP host. 

Select the appropriate file from the Browser window that appears when 

you click the  button to the right of the Value input area for this field. 

Uploaded file Specify a name and location to save the uploaded file. 

Type the uploaded file name into the input-text window that appears 

when you click the small arrow to the right of the Value input area for 

this field. 

The file name must be enclosed within quotation marks. 
 

FTP-Download 

Use the FTP-Download Building Block to designate a file to be downloaded from a 

remote host.  

To enter a value: 

1. Drag the FTP-Download icon from the IPP toolbox into the Agenda Tree at the 

desired location. 

The FTP-Download Building Block parameters dialog box opens. 

 

Figure 144: FTP-Download Building Block Parameters Dialog Box 
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2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area explains that the File for 

Download field is used to define the name of the file to be downloaded from the 

specified FTP host. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 43. 

Note: If the Agenda will be running for multiple clients or over multiple rounds, use 

global variables to specify a unique file name for each client and/or round, to avoid file 

access conflicts and to make it easier to work with and analyze the files after the test is 

completed. For example: 

“k:\Ftp\files\inputFiles\text_upload_” + ThreadNum + RoundNum + 
“.txt” 

4. Click OK. 

The FTP-Download Building Block is added to the Agenda Tree and the JavaScript 

code is added to the Agenda. To see the new JavaScript code, view the Agenda in 

JavaScript Editing mode. 

In the Agenda, the name of the file to be downloaded is passed as a parameter to 

the ftp.Download() function. The file name to which the downloaded file 

should be saved is assigned as a value to the ftp.Outfile variable. 

The fields in the FTP-Download Building Block parameters dialog box are described in 

the following table: 

Table 43: FTP-Download Building Block Parameters Dialog Box Fields 

Field Name Description 

File for 

download 

Specify the name of the file to be downloaded from the specified FTP host. 

Type the name of the file to be downloaded into the input-text window that 

appears when you click the small arrow to the right of the Value input area 

for this field. The file name must be enclosed within quotation marks. 

Downloaded 

file 

Specify a name and location to save the downloaded file. 

Type the name and location in which to save the downloaded file into the 

input-text window that appears when you click the small arrow to the right 

of the Value input area for this field. The file name must be enclosed within 

quotation marks. 
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FTP-Disconnect 

Use the FTP-Disconnect Building Block to disconnect from a remote host.  

To enter a value: 

 Drag the FTP-Disconnect icon from the IPP toolbox into the Agenda Tree at the 

desired location. 

The FTP-Disconnect Building Block is added to the Agenda Tree. The JavaScript 

code, including the TerminateClient() function, is added to the Agenda. To 

see the new JavaScript code, view the Agenda in JavaScript Editing mode. 

SMTP-Send Message 

Use the SMTP-Send Message Building Block to define an email to be sent.  

To enter a value: 

1. Drag the SMTP-Send Message icon from the IPP toolbox into the Agenda Tree at 

the desired location. 

The SMTP-Send Message Building Block parameters dialog box opens. 

 

Figure 145: SMTP-Send Message Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 
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For example, in the preceding figure, the comment area explains that the Server 

Name Host designates the name of the host to which the email should be sent. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 44. 

4. Click OK. 

The SMTP-Send Message Building Block is added to the Agenda Tree. The 

JavaScript code, including the InitAgenda(), InitClient(), and 

TerminateClient() functions, is added to the Agenda. To see the new 

JavaScript code, view the Agenda in JavaScript Editing mode. 

In the Agenda, the specified SMTP connection is opened, an email message 

constructed from the user input is sent out, and the SMTP connection is closed. 

The fields in the SMTP-Send Message Building Block parameters dialog box are 

described in the following table: 

Table 44: SMTP Send Message Building Block Parameters Dialog Box Fields 

Field Name Description 

Server Name 

Host 

Specify the name of the host to which the email should be sent. 

Type the host name into the input-text window that appears when you click 

the small arrow to the right of the Value input area for this field. 

The file name must be enclosed within quotation marks. 

Note: The host can be designated either with a full text name or 

DNS number. 

User name Specify a user name with which to login to the mail server.  

Type the user ID into the input-text window that appears when you click the 

small arrow to the right of the Value input area for this field.  

The user name must be enclosed within quotation marks. 

Password Specify a password with which to login to the mail server. 

Type the password into the input-text window that appears when you click 

the small arrow to the right of the Value input area for this field. 

The password must be enclosed within quotation marks. 

Type Select which type to use: 

 SMTP 

 ESMTP (SMTP extensions – supports graphics and other attachments.) 
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Field Name Description 

From Specify the name of the person sending the email. 

Type the sender’s name into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. 

The name must be enclosed within quotation marks. 

To Specify the name of the person to whom the email should be sent. 

Type the receiver’s name into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. 

The name must be enclosed within quotation marks. 

Subject Enter a short text line that appears as the subject line for the email being 

sent. 

Type the subject line into the input-text window that appears when you click 

the small arrow to the right of the Value input area for this field. 

The subject text must be enclosed within quotation marks. 

Message Enter the message text of the email being sent. 

Type the message text into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. 

The message text must be enclosed within quotation marks. 

Add 

attachment 

Specify the name of a file to be attached to this email. 

Select the appropriate file from the Browser window that appears when you 

click the  button to the right of the Value input area for this field. 

Secure SMTP 

(SMTPS) 

Select the appropriate Boolean value to indicate whether the site being 

accessed utilizes the SSL security protocol. 
 

POP 

Dragging a POP icon into your Agenda Tree opens a POP Building Block parameters 

dialog box. 

POP toolbox items include: 

 POP-Retrieve: Retrieve all waiting messages. 

 POP-Delete: Delete all messages from a POP mailbox.  
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POP-Retrieve 

Use the POP-Retrieve Building Block to retrieve all waiting messages, optionally 

together with a full set of header properties for each message.  

To enter a value: 

1. Drag the POP-Retrieve icon from the IPP toolbox into the Agenda Tree at the 

desired location. 

The POP-Retrieve Building Block parameters dialog box opens. 

 

Figure 146: POP-Retrieve Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area explains that the Message 

Properties field is a toggle that defines whether or not all the message properties 

should be retrieved. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 45. 

4. Click OK. 

The POP-Retrieve Building Block is added to the Agenda Tree. The JavaScript 

code, including the InitAgenda(), InitClient(), and TerminateClient() 

functions, is added to the Agenda. To see the new JavaScript code, view the 

Agenda in JavaScript Editing mode. 
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In the Agenda, the POP connection is opened using the connection name, user 

name, and password specified by the user. The waiting messages are retrieved and 

the message property values are saved to a local structure. 

The fields in the POP-Retrieve Building Block parameters dialog box are described in 

the following table: 

Table 45: POP-Retrieve Building Block Parameters Dialog Box Fields 

Field Name Description 

Server Name 

Host 

Specify the name of the POP host connection. 

Type the POP Host name into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. 

The host name must be enclosed within quotation marks. 

User Name Specify a user ID for the POP connection. 

Type the user ID into the input-text window that appears when you click the 

small arrow to the right of the Value input area for this field. The user name 

must be enclosed within quotation marks. 

Password Specify a password for authentication during the POP connection. 

Type the password into the input-text window that appears when you click 

the small arrow to the right of the Value input area for this field. 

The password must be enclosed within quotation marks. 

Message 

properties 

A toggle that defines whether or not all the message properties should be 

retrieved. 

Toggle Message Properties on or off depending on whether you select Yes or 

No from the list displayed in the drop-down list box that appears when you 

click the small arrow to the right of the Value input area for this field. 

Secure POP 

(POPS) 

Select the appropriate Boolean value to indicate whether the site being 

accessed utilizes the SSL security protocol. 
 

POP-Delete 

Use the POP-Delete Building Block to delete all messages from a POP mailbox.  

To enter a value: 

1. Drag the POP-Delete icon from the IPP toolbox into the Agenda Tree at the 

desired location. 

The POP-Delete Building Block parameters dialog box opens. 
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Figure 147: POP-Delete Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area explains that the Server 

Name Host field is used to define the name of the mail server. WebLOAD IDE 

automatically sends the user-specified name and password to the server when 

connecting. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 46. 

4. Click OK. 

The POP-Delete Building Block is added to the Agenda Tree. The JavaScript code, 

including the InitAgenda(), InitClient(), and TerminateClient() 

functions, is added to the Agenda. To see the new JavaScript code, view the 

Agenda in JavaScript Editing mode. 

In the Agenda, a POP connection is opened using the host name, user name, and 

password specified by the user. The code then loops through all messages on the 

server, deleting each message and printing a note to the user identifying the 

message that was just deleted. When all messages are deleted, the connection is 

closed. 
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The fields in the POP-Delete Building Block parameters dialog box are described in the 

following table: 

Table 46: POP-Delete Building Block Parameters Dialog Box Fields 

Field Name Description 

Server Name 

Host 

Specify the name of the POP server connection. 

Type the POP host name into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. The 

host name must be enclosed within quotation marks. 

User Name Specify a user ID for the POP connection. 

Type the user ID into the input-text window that appears when you click the 

small arrow to the right of the Value input area for this field. The user name 

must be enclosed within quotation marks. 

Password Specify a password for authentication during the POP connection. 

Type the password into the input-text window that appears when you click 

the small arrow to the right of the Value input area for this field. The 

password must be enclosed within quotation marks. 

Secure POP 

(POPS) 

Select the appropriate Boolean value to indicate whether the site being 

accessed utilizes the SSL security protocol. 
 

IMAP 

Dragging an IMAP icon into your Agenda Tree opens an IMAP Building Block 

parameters dialog box. 

IMAP toolbox items include: 

 IMAP-Connect: Start an IMAP session. 

 IMAP-Retrieve: Retrieve all waiting messages.  

 IMAP-Delete: Delete messages from an IMAP mailbox. 

 IMAP-CreateMailbox: Create a new IMAP mailbox. 

 IMAP-ListMailboxes: Generate a complete list of all IMAP mailboxes accessed 

through the current IMAP server.  

 IMAP-DeleteMailbox: Delete an IMAP mailbox. 

 IMAP-RenameMailbox: Rename an IMAP mailbox. 

 IMAP-SubscribeMailbox: Subscribe to an IMAP mailbox. 

 IMAP-UnsubscribeMailbox: Unsubscribe from an IMAP mailbox. 

 IMAP-ListSubscribeMailboxes: Generate a complete list of all subscribed IMAP 

mailboxes accessed through the current IMAP server 
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 IMAP-Search: Search for a specific email item within an IMAP mailbox. 

IMAP-Connect 

Use the IMAP-Connect Building Block to start an IMAP session. When you connect, 

you are connecting to a specific mailbox within the host, as specified by your User ID. 

To enter a value: 

1. Drag the IMAP-Connect icon from the IPP toolbox into the Agenda Tree at the 

desired location. 

The IMAP-Connect Building Block parameters dialog box opens. 

 

Figure 148: IMAP-Connect Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area explains that the IMAP 

Server field is used to define the IMAP Server Name or IP to be used when logging 

in to the specified IMAP server. WebLOAD IDE automatically sends the user-

specified name and password to the IMAP server when connecting. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 47. 
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4. Click OK. 

The IMAP-Connect Building Block is added to the Agenda Tree. The JavaScript 

code, including the InitAgenda(), InitClient(), and TerminateClient() 

functions, is added to the Agenda. To see the new JavaScript code, view the 

Agenda in JavaScript Editing mode. 

In the Agenda, an IMAP connection is opened using the connection name, local 

host name, user name, and password specified by the user. 

The fields in the IMAP-Connect Building Block parameters dialog box are described in 

the following table: 

Table 47: IMAP-Connect Building Block Parameters Dialog Box Fields 

Field Name Description 

User Name Specify an NT user ID for the IMAP connection. 

Type the user ID into the input-text window that appears when you click the 

small arrow to the right of the Value input area for this field. The user name 

must be enclosed within quotation marks. 

Password Specify an NT password for authentication during the IMAP connection. 

Type the password into the input-text window that appears when you click 

the small arrow to the right of the Value input area for this field. The 

password must be enclosed within quotation marks. 

IMAP Server Specify the IMAP server name or IP number. 

Type the IMAP server name into the input-text window that appears when 

you click the small arrow to the right of the Value input area for this field. 

The IMAP host is identified either through an IP number or a full name 

string. A server name string must be enclosed within quotation marks. 

LocalHost Specify the name of the local host. 

Type the local host name into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. The 

local host is identified either through a DNS number or a full name string. A 

host name string must be enclosed within quotation marks. 
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IMAP-Retrieve 

Use the IMAP-Retrieve Building Block to retrieve all waiting messages, optionally 

together with a full set of header properties for each message.  

To enter a value: 

1. Drag the IMAP-Retrieve icon from the IPP toolbox into the Agenda Tree at the 

desired location. 

The IMAP-Retrieve Building Block parameters dialog box opens. 

 

Figure 149: IMAP-Retrieve Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area explains that the Items List 

field contains a list of mailbox items to be retrieved. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 48. 

4. Click OK. 

The IMAP-Retrieve Building Block is added to the Agenda Tree and the JavaScript 

code is added to the Agenda. To see the new JavaScript code, view the Agenda in 

JavaScript Editing mode. 

In the Agenda, the specified message is retrieved from the specified mailbox and 

the message property values are saved to a local structure. A comment embedded 

in the code describes the message attributes stored in the imap JavaScript object. 
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The fields in the IMAP-Retrieve Building Block parameters dialog box are described in 

the following table: 

Table 48: IMAP-Retrieve Building Block Parameters Dialog Box Fields 

Field Name Description 

MailBox Specify the name of the mailbox from which messages should be retrieved. 

Type the mailbox name into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. The 

mailbox name must be enclosed within quotation marks. 

Items List Specify the messages to be retrieved. 

Type the message numbers into the input-text window that appears when 

you click the small arrow to the right of the Value input area for this field. 

The message numbers must be enclosed within quotation marks. You may 

specify a single message number, or you may specify a range, separated by a 

colon. For example, 1:10 returns messages one through ten. If you do not 

specify a message ID, the next message is returned. 

 

IMAP-Delete 

Use the IMAP-Delete Building Block to delete messages from an IMAP mailbox. 

To enter a value: 

1. Drag the IMAP-Delete icon from the IPP toolbox into the Agenda Tree at the 

desired location. 

The IMAP-Delete Building Block parameters dialog box opens. 
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Figure 150: IMAP-Delete Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area explains that the Items List 

field contains a list of mailbox items to be deleted. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 49. 

4. Click OK. 

The IMAP-Delete Building Block is added to the Agenda Tree and the JavaScript 

code is added to the Agenda. To see the new JavaScript code, view the Agenda in 

JavaScript Editing mode. 

In the Agenda, the messages specified by the user are deleted from the mail box 

specified by the user. 

The fields in the IMAP-Delete Building Block parameters dialog box are described in 

the following table: 

Table 49: IMAP-Delete Building Block Parameters Dialog Box Fields 

Field Name Description 

MailBox Specify the name of the mailbox from which messages should be deleted. 

Type the mailbox name into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. The 

mailbox name must be enclosed within quotation marks. 
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Field Name Description 

Items List Specify the messages to be deleted. 

Type the message numbers into the input-text window that appears when 

you click the small arrow to the right of the Value input area for this field. 

The message numbers must be enclosed within quotation marks. You may 

specify a single message number, or you may specify a range, separated by a 

colon. For example, 1:10 deletes messages one through ten. If you do not 

specify a message ID, the current message is deleted. 
 

IMAP-CreateMailbox 

Use the IMAP-CreateMailbox Building Block to create a new IMAP mailbox. 

To enter a value: 

1. Drag the IMAP-CreateMailbox icon from the IPP toolbox into the Agenda Tree at 

the desired location. 

The IMAP-CreateMailbox Building Block parameters dialog box opens. 

 

Figure 151: IMAP-CreateMailbox Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area explains that the MailBox 

field contains the name of the mail box to be created. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 50. 
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4. Click OK. 

The IMAP-CreateMailbox Building Block is added to the Agenda Tree and the 

JavaScript code is added to the Agenda. To see the new JavaScript code, view the 

Agenda in JavaScript Editing mode. 

In the Agenda, a new mailbox is created using the name specified by the user. 

The field in the IMAP-CreateMailbox Building Block parameters dialog box is 

described in the following table: 

Table 50: IMAP-CreateMailbox Building Block Parameters Dialog Box Field 

Field Name Description 

MailBox Specify the name of the mailbox to be created. 

Type the mailbox name into the input-text window that appears when 

you click the small arrow to the right of the Value input area for this 

field. The mailbox name must be enclosed within quotation marks. 

IMAP-ListMailboxes 

Use the IMAP-ListMailboxes Building Block to generate a complete list of all IMAP 

mailboxes accessed through the current IMAP server. 

To generate the list of IMAP mailboxes: 

 Drag the IMAP-ListMailboxes icon from the IPP toolbox into the Agenda Tree at 

the desired location. 

The IMAP-ListMailboxes Building Block is added to the Agenda Tree and the 

JavaScript code is added to the Agenda. To see the new JavaScript code, view the 

Agenda in JavaScript Editing mode. 

 

IMAP-DeleteMailbox 

Use the IMAP-DeleteMailbox Building Block to delete an IMAP mailbox.  

To delete an IMAP mailbox: 

1. Drag the IMAP-DeleteMailbox icon from the IPP toolbox into the Agenda Tree at 

the desired location. 

The IMAP-DeleteMailbox Building Block parameters dialog box opens. 
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Figure 152: IMAP-DeleteMailbox Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area explains that the MailBox 

field contains the name of the mail box to be deleted. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 51. 

4. Click OK. 

The IMAP-DeleteMailbox Building Block is added to the Agenda Tree and the 

JavaScript code is added to the Agenda. To see the new JavaScript code, view the 

Agenda in JavaScript Editing mode. 

In the Agenda, the mailbox specified by the user is deleted. 

The field in the IMAP-DeleteMailbox Building Block parameters dialog box is 

described in the following table: 

Table 51: IMAP-DeleteMailbox Building Block Parameters Dialog Box Field 

Field Name Description 

MailBox Specify the name of the mailbox to be deleted. 

Type the mailbox name into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. The 

mailbox name must be enclosed within quotation marks. 
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IMAP-RenameMailbox 

Use the IMAP-RenameMailbox Building Block to rename an IMAP mailbox. 

To rename an IMAP mailbox: 

1. Drag the IMAP-RenameMailbox icon from the IPP toolbox into the Agenda Tree 

at the desired location. 

The IMAP-RenameMailbox Building Block parameters dialog box opens. 

 

Figure 153: IMAP-RenameMailbox Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area contains the name of the 

old mail box.  

3. Enter the appropriate field value into the Value column next to the field name, as 

described in Table 52. 

4. Click OK. 

The IMAP-RenameMailbox Building Block is added to the Agenda Tree and the 

JavaScript code is added to the Agenda. To see the new JavaScript code, view the 

Agenda in JavaScript Editing mode. 

In the Agenda, the mailbox is renamed using the name specified by the user. 
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The fields in the IMAP-RenameMailbox Building Block parameters dialog box are 

described in the following table: 

Table 52: IMAP-RenameMailbox Building Block Parameters Dialog Box Field 

Field Name Description 

Old MailBox 

name 

Specify the name of the mailbox to be renamed. 

Type the old mailbox name into the input-text window that appears 

when you click the small arrow to the right of the Value input area for 

this field. The mailbox name must be enclosed within quotation marks. 

New Mailbox 

name 

Specify the new name of the mailbox. 

Type the new mailbox name into the input-text window that appears 

when you click the small arrow to the right of the Value input area for 

this field. The mailbox name must be enclosed within quotation marks. 

IMAP-SubscribeMailbox 

Use the IMAP-SubscribeMailbox Building Block to subscribe to an IMAP mailbox. 

To subscribe to an IMAP mailbox: 

1. Drag the IMAP-SubscribeMailbox icon from the IPP toolbox into the Agenda Tree 

at the desired location. 

The IMAP-SubscribeMailbox Building Block parameters dialog box opens. 

 

Figure 154: IMA-SubscribeMailbox Building Block Parameters Dialog Box 
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2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area contains the name of the 

mail box. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 53. 

4. Click OK. 

The IMAP-SubscribeMailbox Building Block is added to the Agenda Tree and the 

JavaScript code is added to the Agenda. To see the new JavaScript code, view the 

Agenda in JavaScript Editing mode. 

In the Agenda, the mailbox is renamed using the name specified by the user. 

The field in the IMAP-SubscribeMailbox Building Block parameters dialog box is 

described in the following table: 

Table 53: IMAP-SubscribeMailbox Building Block Parameters Dialog Box Field 

Field Name Description 

MailBox name Specify the name of the mailbox to which to subscribe. 

Type the mailbox name into the input-text window that appears when 

you click the small arrow to the right of the Value input area for this 

field. The mailbox name must be enclosed within quotation marks. 

IMAP-UnsubscribeMailbox 

Use the IMAP-UnsubscribeMailbox Building Block to unsubscribe from an IMAP 

mailbox. 

To unsubscribe from an IMAP mailbox: 

1. Drag the IMAP-UnsubscribeMailbox icon from the IPP toolbox into the Agenda 

Tree at the desired location. 

The IMAP-UnsubscribeMailbox Building Block parameters dialog box opens. 
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Figure 155: IMA-UnsubscribeMailbox Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area contains the name of the 

mail box. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 53. 

4. Click OK. 

The IMAP-UnsubscribeMailbox Building Block is added to the Agenda Tree and 

the JavaScript code is added to the Agenda. To see the new JavaScript code, view 

the Agenda in JavaScript Editing mode. 

In the Agenda, the mailbox is renamed using the name specified by the user. 

The field in the IMAP-UnsubscribeMailbox Building Block parameters dialog box is 

described in the following table: 

Table 54: IMAP-UnsubscribeMailbox Building Block Parameters Dialog Box Field 

Field Name Description 

MailBox name Specify the name of the mailbox from which to unsubscribe. 

Type the mailbox name into the input-text window that appears when 

you click the small arrow to the right of the Value input area for this 

field. The mailbox name must be enclosed within quotation marks. 
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IMAP-ListSubscribedMailboxes 

Use the IMAP-ListSubscribedMailboxes Building Block to generate a complete list of 

all subscribed IMAP mailboxes. 

To generate the list of subscribed IMAP mailboxes: 

 Drag the IMAP-ListSubscribedMailboxes icon from the IPP toolbox into the 

Agenda Tree at the desired location. 

The IMAP-ListSubscribedMailboxes Building Block is added to the Agenda Tree 

and the JavaScript code is added to the Agenda. To see the new JavaScript code, 

view the Agenda in JavaScript Editing mode. 

 

IMAP-Search 

Use the IMAP-Search Building Block to search for a specific email item within an 

IMAP mailbox. 

To search for a specific email item in an IMAP mailbox: 

1. Drag the IMAP-Search icon from the IPP toolbox into the Agenda Tree at the 

desired location. 

The IMAP-Search Building Block parameters dialog box opens. 

 

Figure 156: IMAP-Search Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 
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For example, in the preceding figure, the comment area explains that the MailBox 

field contains the name of the mail box to be searched. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 55. 

4. Click OK. 

The IMAP-Search Building Block is added to the Agenda Tree and the JavaScript 

code is added to the Agenda. To see the new JavaScript code, view the Agenda in 

JavaScript Editing mode. 

In the Agenda, the mailbox specified by the user is searched for all mail items 

containing the string “timesheet”. 

The fields in the IMAP-Search Building Block parameters dialog box are described in 

the following table: 

Table 55: IMAP-Search Building Block Parameters Dialog Box Fields 

Field Name Description 

MailBox Specify the name of the mailbox to be searched. 

Type the mailbox name into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. The 

mailbox name must be enclosed within quotation marks. 

Search String Specify the search criteria for the current mailbox search. Valid search 

criteria include: 

ALL - All messages in the mailbox - this is the default initial key for 

AND-ing. 

ANSWERED - Messages with the \\Answered flag set. 

BCC - Messages that contain the specified string in the envelope 

structure’s BCC field. 

BEFORE - Messages whose internal date is earlier than the specified date. 

BODY - Messages that contain the specified string in the body of the 

message. 

CC - Messages that contain the specified string in the envelope structure’s 

CC field. 

DELETED - Messages with the \\Deleted flag set. 

DRAFT - Messages with the \\Draft flag set. 

FLAGGED - Messages with the \\Flagged flag set. 

FROM - Messages that contain the specified string in the envelope 

structure’s FROM field. 
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Field Name Description 

HEADER - Messages that have a header with the specified field-name and 

that contains the specified string in the field-body. 

KEYWORD - Messages with the specified keyword set. 

LARGER - Messages with a size larger than the specified number of octets. 

NEW Messages that have the \\Recent flag set but not the \\Seen flag. 

This is functionally equivalent to “(RECENT UNSEEN)”. 

NOT - Messages that do not match the specified search key. 

OLD - Messages that do not have the \\Recent flag set. This is 

functionally equivalent to “NOT RECENT” (as opposed to “NOT NEW”). 

ON - Messages whose internal date is within the specified date. 

OR - Messages that match either search key. 

RECENT - Messages that have the \\Recent flag set. 

SEEN - Messages that have the \\Seen flag set. 

SENTBEFORE - Messages whose Date: header is earlier than the specified 

date. 

SENTON - Messages whose Date: header is within the specified date. 

SENTSINCE - Messages whose Date: header is within or later than the 

specified date. 

SINCE - Messages whose internal date is within or later than the specified 

date. 

SMALLER - Messages with an RFC822.SIZE smaller than the specified 

number of octets. 

SUBJECT - Messages that contain the specified string in the envelope 

structure’s SUBJECT field. 

TEXT - Messages that contain the specified string in the header or body of 

the message. 

TO - Messages that contain the specified string in the envelope structure’s 

TO field. 

UID - Messages with unique identifiers corresponding to the specified 

unique identifier set. 

UNANSWERED - Messages that do not have the \\Answered flag set. 

UNDELETED - Messages that do not have the \\Deleted flag set. 

UNDRAFT - Messages that do not have the \\Draft flag set. 

UNFLAGGED - Messages that do not have the \\Flagged flag set. 

UNKEYWORD - Messages that do not have the specified keyword set. 

UNSEEN - Messages that do not have the \\Seen flag set. 
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Field Name Description 

This Building Block returns a string containing the IDs of messages that 

meet the search criteria if successful, an exception if unsuccessful. 
 

NNTP 

Dragging an NNTP icon into your Agenda Tree opens an NNTP Building Block 

parameters dialog box. 

NNTP toolbox items include: 

 NNTP-Connect: Start an NNTP session. 

 NNTP-GetArticle: Retrieve articles from the specified news group from the NNTP 

server.  

 NNTP-GetArticleCount: Retrieve the number of articles in the specified news 

group from the NNTP server. 

 NNTP-PostArticle: Post articles to the specified news group. 

NNTP-Connect 

Use the NNTP-Connect Building Block to start an NNTP session. When you connect, 

you are connecting to a specific.  

To enter a value: 

1. Drag the NNTP-Connect icon from the IPP toolbox into the Agenda Tree at the 

desired location. 

The NNTP-Connect Building Block parameters dialog box opens. 
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Figure 157: NNTP-Connect Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area explains that the Server 

Host Name field is used to define the NNTP Server Name or IP to be used when 

logging in to the specified NNTP server. WebLOAD IDE automatically sends the 

user-specified name and password to the NNTP server when connecting. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 56. 

4. Click OK. 

The NNTP-Connect Building Block is added to the Agenda Tree. The JavaScript 

code, including the InitAgenda(), InitClient(), and TerminateClient() 

functions, is added to the Agenda. To see the new JavaScript code, view the 

Agenda in JavaScript Editing mode. 

In the Agenda, an NNTP connection is opened using the server name, user name, 

and password specified by the user. 
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The fields in the NNTP-Connect Building Block parameters dialog box are described in 

the following table: 

Table 56: NNTP-Connect Building Block Parameters Dialog Box Fields 

Field Name Description 

Server Host 

Name 

Specify the NNTP server name or IP number. 

Type the NNTP server name into the input-text window that appears when 

you click the small arrow to the right of the Value input area for this field. 

The NNTP host is identified either through an IP number or a full name 

string. A server name string must be enclosed within quotation marks. 

User Name Specify an NT user ID for the NNTP connection. 

Type the user ID into the input-text window that appears when you click the 

small arrow to the right of the Value input area for this field. The user name 

must be enclosed within quotation marks. 

Password Specify an NT password for authentication during the NNTP connection. 

Type the password into the input-text window that appears when you click 

the small arrow to the right of the Value input area for this field. The 

password must be enclosed within quotation marks. 
 

NNTP-GetArticle 

Use the NNTP-GetArticle Building Block to retrieve articles from the specified news 

group from the NNTP server.  

To enter a value: 

1. Drag the NNTP-GetArticle icon from the IPP toolbox into the Agenda Tree at the 

desired location. 

The NNTP-GetArticle Building Block parameters dialog box opens. 



  

WebLOAD IDE User's Guide  267  

 

Figure 158:NNTP-GetArticle Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area explains that the Article ID 

field contains the ID number of the news article to be retrieved. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 57. 

4. Click OK. 

The NNTP-GetArticle Building Block is added to the Agenda Tree and the 

JavaScript code is added to the Agenda. To see the new JavaScript code, view the 

Agenda in JavaScript Editing mode. 

In the Agenda, the specified article is retrieved from the specified news group. 

The fields in the NNTP-GetArticle Building Block parameters dialog box are described 

in the following table: 

Table 57: NNTP-GetArticle Building Block Parameters Dialog Box Fields 

Field Name Description 

Group Name Specify the name of the news group from which articles should be retrieved. 

Type the news group name into the input-text window that appears when 

you click the small arrow to the right of the Value input area for this field. 

The news group name must be enclosed within quotation marks. 

Article ID Specify the ID number of the article to be retrieved. 

Type the ID number into the input-text window that appears when you click 

the small arrow to the right of the Value input area for this field. 
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NNTP-GetArticleCount 

Use the NNTP-GetArticleCount Building Block to retrieve the number of articles in the 

specified news group from the NNTP server.  

To enter a value: 

1. Drag the NNTP-GetArticleCount icon from the IPP toolbox into the Agenda Tree 

at the desired location. 

The NNTP-GetArticleCount Building Block parameters dialog box opens. 

 

Figure 159: NNTP-GetArticleCount Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area explains that the Group 

Name field contains the name of the news group whose articles are to be counted. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 58. 

4. Click OK. 

The NNTP-GetArticleCount Building Block is added to the Agenda Tree and the 

JavaScript code is added to the Agenda. To see the new JavaScript code, view the 

Agenda in JavaScript Editing mode. 

In the Agenda, the number of articles appearing in the specified news group is 

returned. 
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The field in the NNTP-GetArticleCount Building Block parameters dialog box is 

described in the following table: 

Table 58: NTTP-GetArticleCount Building Block Parameters Dialog Box Field 

Field Name Description 

Group Name Specify the name of the news group from which articles should be counted. 

Type the news group name into the input-text window that appears when 

you click the small arrow to the right of the Value input area for this field. 

The news group name must be enclosed within quotation marks. 
 

NNTP-PostArticle 

Use the NNTP-PostArticle Building Block to post articles to the specified news group. 

To enter a value: 

1. Drag the NNTP-PostArticle icon from the IPP toolbox into the Agenda Tree at the 

desired location. 

The NNTP-PostArticle Building Block parameters dialog box opens. 

 

Figure 160: NNTP-PostArticle Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area explains that the From 

field contains the name of the person sending the news article to be posted on the 

news group. 
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3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 59. 

4. Click OK. 

The NNTP-PostArticle Building Block is added to the Agenda Tree and the 

JavaScript code is added to the Agenda. To see the new JavaScript code, view the 

Agenda in JavaScript Editing mode. 

In the Agenda, the article text is posted to the specified news group. 

The fields in the NNTP-PostArticle Building Block parameters dialog box are described 

in the following table: 

Table 59: NNTP-PostArticle Building Block Parameters Dialog Box Fields 

Field Name Description 

From Specify the name of the person sending the email. 

Type the sender’s name into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. 

The name must be enclosed within quotation marks. 

Subject Enter a short text line that appears as the subject line for the email being 

sent. 

Type the subject line into the input-text window that appears when you click 

the small arrow to the right of the Value input area for this field. 

The subject text must be enclosed within quotation marks. 

Organization Specify the name of the organization to which the recipient belongs.  

To Specify the name of the person to whom the email should be sent. 

Type the receiver’s name into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. 

The name must be enclosed within quotation marks. 

ReplyTo  Specify the name of the person to whom the recipient should reply. 

Type the name into the input-text window that appears when you click the 

small arrow to the right of the Value input area for this field. 

The name must be enclosed within quotation marks. 

Article Text Enter the message text of the email being sent. 

Type the message text into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. 

The message text must be enclosed within quotation marks. 
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TCP 

Dragging a TCP icon into your Agenda Tree opens a TCP Building Block parameters 

dialog box. 

TCP toolbox items include: 

 TCP-Connect: Open a TCP connection. 

 TCP-Send: Send a TCP request.  

 TCP-Receive: Return all responses from the TCP host since the last TCP-Send 

action.  

 TCP-Erase: Clear the contents of the TCP document object.  

TCP-Connect 

Use the TCP-Connect Building Block to open a TCP connection.  

To enter a value: 

1. Drag the TCP-Connect icon from the IPP toolbox into the Agenda Tree at the 

desired location. 

The TCP-Connect Building Block parameters dialog box opens. 

 

Figure 161: TCP-Connect Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 
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For example, in the preceding figure, the comment area explains that the 

Connection Timeout field is used to set the amount of time the system will wait for 

a TCP connection to be established before timing out. Time is defined in 

milliseconds. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 60. 

4. Click OK. 

The TCP-Connect Building Block is added to the Agenda Tree. The JavaScript 

code, including the InitAgenda(), InitClient(), and TerminateClient() 

functions, is added to the Agenda. To see the new JavaScript code, view the 

Agenda in JavaScript Editing mode. 

In the Agenda, a TCP connection is opened using the host names specified by the 

user. 

The fields in the TCP-Connect Building Block parameters dialog box are described in 

the following table: 

Table 60: TCP-Connect Building Block Parameters Dialog Box Fields 

Field Name Description 

Host Name Specify the name of the TCP destination host. 

Type the TCP Host name into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. The 

TCP host is identified either through a DNS number or a full name string. A 

host name string must be enclosed within quotation marks. 

Port Specify the port to which you are connecting. 

Type the port number into the input field. If you do not specify a value, the 

default TCP port is used. 

Connection 

Timeout 

Specify the amount of time the system will wait for a TCP connection to be 

established before timing out. 

Type the timeout value in the input field. Time is defined in milliseconds. 

Outfile Specify the name of the file into which the TCP output stream should be 

stored. 

Type the Outfile name into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. The 

file name string must be enclosed within quotation marks. 
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Field Name Description 

LocalHost Specify the name of the local host. 

Type the local host name into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. The 

local host is identified either through a DNS number or a full name string. A 

host name string must be enclosed within quotation marks. 

TCP-Send 

Use the TCP-Send Building Block to send a TCP request.  

To enter a value: 

1. Drag the TCP-Send icon from the IPP toolbox into the Agenda Tree at the desired 

location. 

The TCP-Send Building Block parameters dialog box opens. 

 

Figure 162: TCP-Send Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area explains that the Send 

String designates the text string to be sent. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 61. 

4. Click OK. 
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The TCP-Send Building Block is added to the Agenda Tree and the JavaScript code 

is added to the Agenda. To see the new JavaScript code, view the Agenda in 

JavaScript Editing mode. 

The fields in the TCP-Send Building Block parameters dialog box are described in the 

following table: 

Table 61: TCP-Send Building Block Parameters Dialog Box Fields 

Field Name Description 

Next Prompt Specify a distinctive text string to be identified in the next string received 

from the host. If used, this string must appear in all communications 

received from the TCP host. 

Type the prompt string into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. The 

string must be enclosed within quotation marks. 

Next Size Specify the size, in bytes, of the expected data. If used, this size specification 

limits the length of all communications received from the TCP host. 

Type the size value in the input area for this field. 

Send String Enter the text being sent to the TCP host. 

Type the string text into the input-text window that appears when you click 

the small arrow to the right of the Value input area for this field. The 

message text must be enclosed within quotation marks. 

TCP-Receive 

Use the TCP-Receive Building Block to return all responses from the TCP host since the 

last TCP-Send action. A TCP-Receive action returns to the Agenda when the 

NextPrompt, NextSize, or Timeout conditions set with a previous TCP-Send action are 

met. If more than one of these properties is specified, the method returns to the 

Agenda when the first one is met. Subsequent uses of TCP-Receive find the next 

instance of the limiting property, returning additional information from the buffer. The 

content returned depends upon which of the three limiting properties triggered the 

return. 

To enter a value: 

 Drag the TCP-Receive icon from the IPP toolbox into the Agenda Tree at the 

desired location. 

The TCP-Receive Building Block is added to the Agenda Tree and the JavaScript 

code is added to the Agenda. To see the new JavaScript code, view the Agenda in 

JavaScript Editing mode. 
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TCP-Erase 

Use the TCP-Erase Building Block to clear the contents of the TCP document object. 

To enter a value: 

 Drag the TCP-Erase icon from the IPP toolbox into the Agenda Tree at the desired 

location. 

The TCP-Erase Building Block is added to the Agenda Tree and the JavaScript code 

is added to the Agenda. To see the new JavaScript code, view the Agenda in 

JavaScript Editing mode. 

TELNET 

Dragging a TELNET icon into your Agenda Tree opens a TELNET Building Block 

parameters dialog box. 

TELNET toolbox items include: 

 TELNET-Connect: Open a TELNET connection.  

 TELNET-Receive: Receive a TELNET communication.  

 TELNET-Send: Send a TELNET communication.  

 TELNET-Erase: Clear the contents of the TELNET document object.  

TELNET-Connect 

Use the TELNET-Connect Building Block to open a TELNET connection. 

To enter a value: 

1. Drag the TELNET-Connect icon from the IPP toolbox into the Agenda Tree at the 

desired location. 

The TELNET-Connect Building Block parameters dialog box opens. 
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Figure 163: TELNET-Connect Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area explains that the Local 

Host field is used to define the name of the local host for this TELNET session. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 62. 

4. Click OK. 

The TELNET-Connect Building Block is added to the Agenda Tree. The JavaScript 

code, including the InitAgenda(), InitClient(), and TerminateClient() 

functions, is added to the Agenda. To see the new JavaScript code, view the 

Agenda in JavaScript Editing mode. 

In the Agenda, a TELNET connection is opened using the host names specified by 

the user. 
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The fields in the TELNET-Connect Building Block parameters dialog box are described 

in the following table: 

Table 62: TELNET-Connect Building Block Parameters Dialog Box Fields 

Field Name Description 

Host Name Specify the name of the TELNET destination host. 

Type the TELNET Host name into the input-text window that appears when 

you click the small arrow to the right of the Value input area for this field. 

The TELNET host is identified either through a DNS number or a full name 

string. A host name string must be enclosed within quotation marks. 

Connection 

Timeout 

Specify the amount of time the system will wait for a TELNET connection to 

be established before timing out. 

Type the timeout value in the input field. Time is defined in milliseconds. 

Outfile Specify the name of the file into which the TELNET output stream should be 

stored. 

Type the Outfile name into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. The 

file name string must be enclosed within quotation marks. 

LocalHost Specify the name of the local host. 

Type the local host name into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. The 

local host is identified either through a DNS number or a full name string. A 

host name string must be enclosed within quotation marks. 

TELNET-Receive 

Use the TELNET-Receive Building Block to receive a TELNET communication. 

To enter a value: 

1. Drag the TELNET-Receive icon from the IPP toolbox into the Agenda Tree at the 

desired location. 

The TELNET-Receive Building Block parameters dialog box opens. 
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Figure 164: TELNET-Receive Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area explains that the 

NextPrompt String designates the text string that must be found and identified in 

the next communication received via TELNET. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 63. 

4. Click OK. 

The TELNET-Receive Building Block is added to the Agenda Tree and the 

JavaScript code is added to the Agenda. To see the new JavaScript code, view the 

Agenda in JavaScript Editing mode. 

The fields in the TELNET-Receive Building Block parameters dialog box are described 

in the following table: 

Table 63: TELNET-Receive Building Block Parameters Dialog Box Fields 

Field Name Description 

NextPrompt 

String 

Specify a distinctive text string to be identified in the next string received 

from the host. If used, this string must appear in all communications 

received from the TELNET host. 

Type the prompt string into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. The 

string must be enclosed within quotation marks. 
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TELNET-Send 

Use the TELNET-Send Building Block to send a TELNET communication. 

To enter a value: 

1. Drag the TELNET-Send icon from the IPP toolbox into the Agenda Tree at the 

desired location. 

The TELNET-Send Building Block parameters dialog box opens. 

 

Figure 165: TELNET-Send Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area explains that the Send 

String designates the text string to be sent. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 64. 

4. Click OK. 

The TELNET-Send Building Block is added to the Agenda Tree and the JavaScript 

code is added to the Agenda. To see the new JavaScript code, view the Agenda in 

JavaScript Editing mode. 
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The field in the TELNET-Send Building Block parameters dialog box is described in the 

following table: 

Table 64: TELNET-Send Building Block Parameters Dialog Box Field 

Field Name Description 

Send String Enter the text being sent to the TELNET host. 

Type the string text into the input-text window that appears when you click 

the small arrow to the right of the Value input area for this field. The 

message text must be enclosed within quotation marks. 

TELNET-Erase 

Use the TELNET-Erase Building Block to clear the contents of the TELNET document 

object.  

To enter a value: 

 Drag the TELNET-Erase icon from the IPP toolbox into the Agenda Tree at the 

desired location. 

The TELNET-Erase Building Block is added to the Agenda Tree and the JavaScript 

code is added to the Agenda. To see the new JavaScript code, view the Agenda in 

JavaScript Editing mode. 

UDP 

Dragging a UDP icon into your Agenda tree opens a UDP Building Block parameters 

dialog box. 

UDP toolbox items include: 

 UDP-Bind: Create a connection to a UDP port.  

 UDP-Broadcast: Broadcast data to the local net.  

 UDP-Receive: Return all responses from the host since the last UDP-Send action.  

 UDP-Send: Send a UDP communication.  

 UDP-Erase: Clear the contents of the UDP document object.  
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UDP-Bind 

Use the UDP-Bind Building Block to create a connection to a UDP port. 

To enter a value: 

1. Drag the UDP-Bind icon from the IPP toolbox into the Agenda Tree at the desired 

location. 

The UDP-Bind Building Block parameters dialog box opens. 

 

Figure 166: UDP-Bind Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area explains that the InBuffer 

Size field is used to define the amount of space allocated to the incoming data 

buffer for this UDP session. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 65. 

4. Click OK. 

The UDP-Bind Building Block is added to the Agenda Tree. The JavaScript code, 

including the InitAgenda(), InitClient(), and TerminateClient() 

functions, is added to the Agenda. To see the new JavaScript code, view the 

Agenda in JavaScript Editing mode. 

In the Agenda, the InitAgenda() function includes commands to include the 

WebLOAD IDE JIPP and UDP library files. The InitClient() function includes 
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a command to define a separate UDP object for each client. Within the main body 

of the Agenda, a UDP connection is opened using the connection parameters 

specified by the user. The TerminateClient() function automatically closes 

the connection and deletes all objects created for clients during test sessions. 

The fields in the UDP-Bind Building Block parameters dialog box are described in the 

following table: 

Table 65: UDP-Bind Building Block Parameters Dialog Box Fields 

Field Name Description 

LocalHost Specify the name of the local host. 

Type the local host name into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. The 

local host is identified either through a DNS number or a full name string. A 

host name string must be enclosed within quotation marks. 

Connection 

Timeout 

Specify the amount of time the system will wait for a UDP connection to be 

established before timing out. 

Type the timeout value in the input field. Time is defined in milliseconds. 

Outfile Specify the name of the file into which the UDP output stream should be 

stored. 

Type the Outfile name into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. The 

file name string must be enclosed within quotation marks. 

Requested 

Packets 

Specify the number of requested packets per UDP communication. 

Type the number of requested packets per communication for this session in 

the Value input area. The default value is 100. 

InBuffer Size Specify the amount of space allocated to the incoming data buffer for this 

UDP session. 

Type the input buffer size for this session in the Value input area. The 

default value is 300. 

OutBuffer 

Size 

Specify the amount of space allocated to the outgoing data buffer for this 

UDP session. 

Type the output buffer size for this session in the Value input area. The 

default value is 300. 

MaxDatagram 

Size 

Specify the maximum datagram size, in bytes, for this UDP session. 

Type the maximum datagram size for this session in the Value input area. 

The default value is 200. 
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UDP-Broadcast 

Use the UDP-Broadcast Building Block to broadcast data to the local net. 

To enter a value: 

1. Drag the UDP-Broadcast icon from the IPP toolbox into the Agenda Tree at the 

desired location. 

The UDP-Broadcast Building Block parameters dialog box opens. 

 

Figure 167: UDP-Broadcast Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area explains that the Broadcast 

String field is used to define the string to be broadcast. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 66. 

4. Click OK. 

The UDP-Broadcast Building Block is added to the Agenda Tree and the JavaScript 

code is added to the Agenda. To see the new JavaScript code, view the Agenda in 

JavaScript Editing mode. 

In the Agenda, the string defined by the user is broadcast via the specified port. 
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The fields in the UDP-Broadcast Building Block parameters dialog box are described in 

the following table: 

Table 66: UDP-Broadcast Building Block Parameters Dialog Box Fields 

Field Name Description 

Number of 

Responses 

Specify the number of responses the testing machine waits for before 

proceeding. Use this property to make sure that all network hosts have 

responded. To specify an unlimited number of responses, specify a Number 

of Responses value of zero. 

Type the timeout value in the input field. 

Port Specify the port to which you are connecting. 

Type the port number into the input field. If you do not specify a value, the 

default TCP port is used. 

Broadcast 

String 

Enter the text to be broadcast on the net. 

Type the string text into the input-text window that appears when you click 

the small arrow to the right of the Value input area for this field. The text 

must be enclosed within quotation marks. 

UDP-Receive 

Use the UDP-Receive Building Block to return all responses from the host since the last 

UDP-Send action. A UDP-Receive action is completed when either the 

RequestedPackets or Timeout conditions set when the UDP connection was first 

established is met. Subsequent uses of UDP-Receive find the next instance of the 

limiting property, returning additional information from the buffer. 

To enter a value: 

 Drag the UDP-Receive icon from the IPP toolbox into the Agenda Tree at the 

desired location. 

The UDP-Receive Building Block is added to the Agenda Tree and the JavaScript 

code is added to the Agenda. To see the new JavaScript code, view the Agenda in 

JavaScript Editing mode. 
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UDP-Send 

Use the UDP-Send Building Block to send a UDP communication.  

To enter a value: 

1. Drag the UDP-Send icon from the IPP toolbox into the Agenda Tree at the desired 

location. 

The UDP-Send Building Block parameters dialog box opens. 

 

Figure 168: UDP-Send Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area explains that the Send 

String designates the text string to be sent. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 67. 

4. Click OK. 

The UDP-Send Building Block is added to the Agenda Tree and the JavaScript code 

is added to the Agenda. To see the new JavaScript code, view the Agenda in 

JavaScript Editing mode. 



 

 286  Appendix A. The WebLOAD IDE Toolbox Set 

The fields in the UDP-Send Building Block parameters dialog box are described in the 

following table: 

Table 67: UDP-Send Building Block Parameters Dialog Box Fields 

Field Name Description 

Destination 

Host 

Specify the name of the destination host. 

Type the destination host name into the input-text window that appears 

when you click the small arrow to the right of the Value input area for this 

field. The destination host is identified either through a DNS number or a 

full name string. A host name string must be enclosed within quotation 

marks. 

Port Specify the port to which you are connecting. 

Type the port number into the input field. If you do not specify a value, the 

default port is used. 

Send String Enter the text being sent to the specified host. 

Type the string text into the input-text window that appears when you click 

the small arrow to the right of the Value input area for this field. The 

message text must be enclosed within quotation marks. 

UDP-Erase 

Use the UDP-Erase Building Block to clear the contents of the UDP document object. 

To enter a value: 

 Drag the UDP-Erase icon from the IPP toolbox into the Agenda Tree at the desired 

location. 

The UDP-Erase Building Block is added to the Agenda Tree and the JavaScript 

code is added to the Agenda. To see the new JavaScript code, view the Agenda in 

JavaScript Editing mode. 

The WebLOAD IDE Database Toolbox 

The WebLOAD IDE Database Toolbox includes a complete set of database Building 

Blocks. Use the WebLOAD IDE database Building Blocks to simply and easily add 

database activities to your test session Agenda. 

To add database Building Blocks to a test Agenda directly through WebLOAD IDE: 

 Drag the selected database Building Block from the Database toolbox and drop it 

into the Agenda Tree at the appropriate point. 
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The following are the database Building Blocks available in WebLOAD IDE: 

 

 

Each database Building Block opens a different dialog box. Enter the required values in 

the Value field. Explanations are provided at the bottom of the dialog box for each 

parameter as it is selected in the dialog box. 

Note: The values that appear in the Wizard’s Value area are the default values for each 

field. In most cases, the default value for string variables is an empty string, indicated 

in the Value area by a set of empty quotation marks. If you are entering your own 

value for a string field, the new string must also be enclosed within quotation marks. 

Fields that were not assigned a value in the dialog box are left as empty fields in the 

Agenda code. 

Once you have finished defining the new database Building Block, the new activity is 

reflected in the Agenda Tree. A database Building Block is added to the Agenda Tree 

for each database Building Block defined. WebLOAD IDE automatically adds the 

corresponding JavaScript code to your test session Agenda. 

To see the complete sequence of JavaScript code for all the Database Building Blocks 

that have been added to the Agenda tree, click the Agenda root node in the Agenda 

tree and select the JavaScript View tab. 

Notes: The JavaScript code for each of the Database Building Blocks can be found in 

the DBBuildingBlocks.js library file, which is part of the Include directory 

under the WebLOAD installation directory. The JavaScript code that implements these 

Database Building Blocks is automatically inserted to the appropriate locations within 

the Agenda script. Code lines may be added to the initialization phase (within the 

InitAgenda() function), in the main body of the Agenda, or to the termination phase 

(within the TerminateAgenda() function). 
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The JavaScript code for that object can be edited, as described in Using the JavaScript 

Editor (on page 73). 

The field descriptions in this section assume a basic familiarity with database 

terminology. To take full advantage of the Database Building Blocks, testers must 

understand how to work with ADO objects and have a basic knowledge of SQL 

command syntax. WebLOAD IDE automatically inserts into the test session Agenda 

the appropriate JavaScript code to implement the database commands that the tester 

specifies. However, it is the tester’s responsibility to specify valid database commands. 

OpenDB 

Use the OpenDB Building Block to open and close a specified database. 

To enter a value: 

1. Drag the OpenDB icon from the Database toolbox into the Agenda Tree at the 

desired location. 

The OpenDB Building Block parameters dialog box opens. 

 

Figure 169: OpenDB Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area explains that the Database 

Type field is used to specify the type of database to be opened. 
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3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 68. 

Note: The Database toolbox is currently available only for database activities through 

ADO under a Windows operating system. 

4. Click OK. 

The OpenDB Building Block is added to the Agenda Tree. The JavaScript code, 

including the InitAgenda(), InitClient(), and TerminateClient() 

functions, is added to the Agenda. To see the new JavaScript code, view the Agenda in 

JavaScript Editing mode. 

Note: The OpenDB Building Block automatically adds the JavaScript code required to 

both open and close the specified database. No “CloseDB” Building Block is necessary. 

The fields in the OpenDB Building Block parameters dialog box are described in the 

following table: 

Table 68: OpenDB Building Block Parameters Dialog Box Fields 

Field Name Description 

Database type Specify the type of database to be opened. 

Select the appropriate value from the drop-down list that appears when 

you click the Value input area for this field. 

The options include MS-Access and SQL Server databases. 

Server name (SQL 

Server) 

Specify the name of the machine where the database is running. 

Type the appropriate server name into the input-text window that 

appears when you click the small arrow to the right of the Value input 

area for this field. 

Relevant for SQL Server databases only. 

Database name 

(SQL Server) 

Specify the name of the database on the SQL server. 

Type the appropriate database name into the input-text window that 

appears when you click the small arrow to the right of the Value input 

area for this field. 

Relevant for SQL Server databases only. 

User name (SQL 

Server) 

Specify a user ID for authentication against the database. 

Type the user ID into the input-text window that appears when you click 

the small arrow to the right of the Value input area for this field. 

Relevant for SQL Server databases only. 
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Field Name Description 

Password (SQL 

Server) 

Specify a password for authentication against the database. 

Type the password into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. 

Relevant for SQL Server databases only. 

File name (MDB 

File) 

Specify the full path for an MDB file. 

Select the appropriate file from the Browser window that appears when 

you click  to the right of the Value input area for this field. 

Relevant for MDB databases only. 

Connection name Specify the name of the connection variable. 

Type the connection name into the input-text window that appears when 

you click the small arrow to the right of the Value input area for this 

field. This connection name variable is used throughout the Agenda file 

to access and work with this database. 

Oracle OpenDB 

Use the Oracle OpenDB Building Block to open and close an Oracle database. 

Note: For specific pre-requisites regarding the Oracle Open DB Building Blocks, refer 

to the WebLOAD Installation Guide. 

Note: To use the Oracle OpenDB Building Block you must first install the Oracle 

Client. The Oracle Client must be installed on the same machine as the IDE. 

To enter a value: 

1. Drag the Oracle OpenDB icon from the Database toolbox into the Agenda Tree at 

the desired location. 

The OpenDB Building Block parameters dialog box opens. 
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Figure 170: Oracle OpenDB Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area explains that the Database 

Type field is used to specify the type of database to be opened. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 69. 

Note: The Database toolbox is currently available only for database activities through 

ADO under a Windows operating system. 

4. Click OK. 

The Oracle OpenDB Building Block is added to the Agenda Tree. The JavaScript code, 

including the InitAgenda(), InitClient(), and TerminateClient() functions, 

is added to the Agenda. To see the new JavaScript code, view the Agenda in JavaScript 

Editing mode. 

Note: The Oracle OpenDB Building Block automatically adds the JavaScript code 

required to both open and close the specified database. No “CloseDB” Building Block is 

necessary. 
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The fields in the Oracle OpenDB Building Block parameters dialog box are described in 

the following table: 

Table 69: Oracle OpenDB Building Block Parameters Dialog Box Fields 

Field Name Description 

Database name Specify the name of the database on the Oracle server. 

Type the appropriate database name into the input-text window that 

appears when you click the small arrow to the right of the Value input 

area for this field. 

Relevant for Oracle Server databases only. 

User name Specify a user ID for authentication against the database. 

Type the user ID into the input-text window that appears when you click 

the small arrow to the right of the Value input area for this field. 

Relevant for Oracle Server databases only. 

Password Specify a password for authentication against the database. 

Type the password into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. 

Relevant for Oracle Server databases only. 

Connection name Specify the name of the connection variable. 

Type the connection name into the input-text window that appears when 

you click the small arrow to the right of the Value input area for this 

field. This connection name variable is used throughout the Agenda file 

to access and work with this database. 

MySQL OpenDB 

Use the MySQL OpenDB Building Block to open and close a MySQL database.  

Note: Before connecting to the MySQL database, verify that the MySQL 

connector/ODBC 3.5.1 Driver is installed on your computer. In addition, verify that the 

MySQL port (3306) is open on the local/remote firewall and that the MySQL database 

has the right grant permission for the user and IP address from which you are 

connecting. 

To enter a value: 

1. Drag the MySQL OpenDB icon from the Database toolbox into the Agenda Tree at 

the desired location. 

The MySQLOpenDB Building Block parameters dialog box opens. 
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Figure 171: MySQL OpenDB Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 70. 

4. Click OK.  

The MySQL Open DB Building Block is added to the Agenda Tree. The JavaScript 

code, including the InitAgenda(), InitClient(), and TerminateClient() 

functions, is added to the Agenda. To see the new JavaScript code, view the 

Agenda in JavaScript Editing mode. 

The fields in the MySQL OpenDB Building Block parameters dialog box are described 

in the following table: 

Table 70: MySQL OpenDB Building Block Parameters Dialog Box Fields 

Field Name Description 

Server name (MySQL 

Server) 

Specify the name of the MySQL Database server. 

Database name Specify the name of the database on the MySQL Database server. 

Type the appropriate database name into the input-text window 

that appears when you click the small arrow to the right of the 

Value input area for this field. 
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Field Name Description 

User name Specify a user ID for authentication against the database. 

Type the user ID into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this 

field. 

Password Specify a password for authentication against the database. 

Type the password into the input-text window that appears when 

you click the small arrow to the right of the Value input area for this 

field. 

Connection name The connection to use to open the database. 

Execute Command 

Use the Execute Command Building Block to add simple database commands to your 

test session Agenda. The database is identified using the Connection Name variable 

defined through the Oracle OpenDB and OpenDB Building Blocks. The Execute 

Command Building Block is used for database commands that do not involve getting a 

return value, such as Insert, Update, and Delete.  

To enter a value: 

1. Drag the Execute Command icon from the Database toolbox into the Agenda Tree 

at the desired location. 

The Execute Command Building Block parameters dialog box opens. 

 

Figure 172: Execute Command Building Block Parameters Dialog Box 
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2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, the comment area in the preceding figure explains that the 

SQL/Command Expression field is used to enter the command to be executed. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 71. 

For example, to enter a text string, type the complete text into the input-text 

window that appears when you click the small arrow to the right of the Value 

input area for the field, as illustrated in the preceding figure. 

 

Figure 173: Input Text Window 

4. Click OK. 

The Execute Command Building Block is added to the Agenda Tree and the 

JavaScript code is added to the Agenda. To see the new JavaScript code, view the 

Agenda in JavaScript Editing mode. 

Note: The database connection is identified with the variable defined in the OpenDB 

and Oracle OpenDB Building Block parameters dialog boxes. 
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The fields in the Execute Command Building Block parameters dialog box are 

described in the following table: 

Table 71: Execute Command Building Block Parameters Dialog Box Fields 

Field Name Description 

Connection name Specify the name of the connection variable. 

Type the connection name into the input-text window that appears when 

you click the small arrow to the right of the Value input area for this 

field. 

The connection name variable must match the name of a database 

connection that was previously opened with the OpenDB Building Block. 

The same connection name is used throughout the Agenda file to access 

and work with this database. 

SQL/command 

expression 

Specify the SQL command to be executed. 

Type the complete command into the input-text window that appears 

when you click the small arrow to the right of the Value input area for 

this field. 

Fetch Data 

Use the Fetch Data Building Block to add database commands that return data values 

to the Agenda. The database is identified using the Connection Name variable defined 

through the OpenDB and Oracle OpenDB Building Blocks.  

To enter a value: 

1. Drag the Fetch Data icon from the Database toolbox into the Agenda Tree at the 

desired location. 

The Fetch Data Building Block parameters dialog box opens. 
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Figure 174: Fetch Data Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

For example, in the preceding figure, the comment area explains that the Cursor 

Type field is used to define the level of access and visibility requested for this 

database Building Block. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 72. 

For example, to select a value from a pre-defined list, select the Cursor Type choice 

from the list of options displayed in the drop-down list box that appears when you 

click the small arrow to the right of the Value input area for this field. 

4. Click OK. 

The Fetch Data Building Block is added to the Agenda Tree. The JavaScript code, 

including the TerminateClient() function, is added to the Agenda. To see the 

new JavaScript code, view the Agenda in JavaScript Editing mode. 
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The fields in the Fetch Data Building Block parameters dialog box are described in the 

following table: 

Table 72: Fetch Data Building Block Parameters Dialog Box Fields 

Field Name Description 

Connection name Specify the name of the connection variable. 

Type the connection name into the input-text window that appears when 

you click the small arrow to the right of the Value input area for this 

field. 

The connection name variable must match the name of a database 

connection that was previously opened with the OpenDB Building Block. 

The same connection name is used throughout the Agenda file to access 

and work with this database. By default, the connection name defined in 

the most recent OpenDB Building Block appears in this field. 

RecordSet name Specify the name of the database RecordSet variable. 

Type the RecordSet name into the input-text window that appears when 

you click the small arrow to the right of the Value input area for this 

field. 

The same RecordSet name is used throughout the Agenda file to access 

and work with records from this database. 

SQL expression Specify the SQL command to be executed. 

Type the complete command into the input-text window that appears 

when you click the small arrow to the right of the Value input area for 

this field. 

Cursor type Specify the level of access and visibility requested for this database 

Building Block. 

Select the Cursor Type choice from the list of options displayed in the 

drop-down list box that appears when you click the small arrow to the 

right of the Value input area for this field. 

DB GetLine 

When running large load tests, the user input is usually read automatically from an 

input file. To read many rows of input data from a simple text file, WebLOAD uses the 

GetLine() I/O command. To read large amounts of input data from an MS-Access or 

SQL Server database, WebLOAD uses the equivalent DB GetLine database Building 

Block. 

The DB GetLine Building Block reads complete records, one by one, from a specified 

database table. The database table is exported into a temporary file, from which the 

records are read, one record per line.  
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To enter a value: 

1. Drag the DB GetLine icon from the Database toolbox into the Agenda Tree at the 

desired location. 

The DB GetLine Building Block parameters dialog box opens. 

 

Figure 175: DB GetLine Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 73. 

4. Click OK. 

The DB GetLine Building Block is added to the Agenda Tree. The JavaScript code, 

including the InitAgenda() and TerminateClient() functions, is added to 

the Agenda. To see the new JavaScript code, view the Agenda in JavaScript Editing 

mode. 
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The fields in the DB GetLine Building Block parameters dialog box are described in the 

following table: 

Table 73: DB GetLine Building Block Parameters Dialog Box Fields 

Field Name Description 

Database type Specify the type of database to be opened. 

Select the appropriate value from the drop-down list that appears when 

you click the Value input area for this field. 

The options include MS-Access and SQL Server databases. 

Server name 

(SQL Server) 

Specify the name of the machine where the database is running. 

Type the appropriate server name into the input-text window that appears 

when you click the small arrow to the right of the Value input area for this 

field. 

Relevant for SQL Server databases only. 

Database name 

(SQL Server) 

Specify the name of the database on the SQL server. 

Type the appropriate database name into the input-text window that 

appears when you click the small arrow to the right of the Value input 

area for this field. 

Relevant for SQL Server databases only. 

User name (SQL 

Server) 

Specify a user ID for authentication against the database. 

Type the user ID into the input-text window that appears when you click 

the small arrow to the right of the Value input area for this field. 

Relevant for SQL Server databases only. 

Password (SQL 

Server) 

Specify a password for authentication against the database. 

Type the password into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. 

Relevant for SQL Server databases only. 

File name (MDB 

File) 

Specify the full path for an MDB file. 

Select the appropriate file from the Browser window that appears when 

you click the  button to the right of the Value input area for this field. 

Relevant for MDB databases only. 
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Field Name Description 

SQL expression Specify the SQL command to be executed. 

Type the complete command into the input-text window that appears 

when you click the small arrow to the right of the Value input area for this 

field. 

Note: To take full advantage of the Database Building Blocks, 

testers must understand how to work with ADO objects and 

have a basic knowledge of SQL command syntax. WebLOAD IDE 

automatically inserts into the test session Agenda the appropriate 

JavaScript code to implement specified database commands. 

However, it is the tester who must specify the database commands to 

be inserted. WebLOAD IDE cannot correct a tester’s SQL syntax 

errors. 

Temporary file 

name 

Name to use for the temporary file that will contain the output data from 

the SQL statement. 

This temporary file will serve as an input file to the test session Agenda. 

Data from this file is read line by line, where each data record is a separate 

line. 

The delimiter 

character 

between the 

fields 

Delimiter character that separates between the fields in each record. 

This delimiter character must not appear as valid character within any of 

the data fields. The default delimiter character is a pound sign (#). 

Type in a different character as needed. 

Max number of 

records 

Specifies the maximum number of records to read from the database. 

Number of 

records per 

Generator 

Specifies the maximum number of records to be read from the database by 

each generator. 

This field is intended for instances of testing by a network of generators. 

Multiple generators do not merge or share data. Database access is 

synchronized between generators, similar to WebLOAD IDE’s 

synchronization of Global Parameters.  

Each generator is allowed access to a specific number of records, enabling 

all the generators to work with the database in parallel. Record access is 

divided evenly between generators. The total number of records allocated 

to all generators must be equal to the Maximum Number of Records field 

value. For example, 1000 records may be divided between 10 Load 

Generators, with 100 records allocated per generator. 
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Oracle DB GetLine 

When running large load tests, the user input is usually read automatically from an 

input file. To read many rows of input data from a simple text file, WebLOAD uses the 

Oracle GetLine() I/O command. To read large amounts of input data from an Oracle 

database, WebLOAD uses the equivalent Oracle DBGetLine database Building Block. 

The Oracle DB GetLine Building Block reads complete records, one by one, from a 

specified database table. The database table is exported into a temporary file, from 

which the records are read, one record per line.  

Note: To use the Oracle DB GetLine Building Block you must first install the Oracle 

Client. The Oracle Client must be installed on the same machine as the IDE.  

To enter a value: 

1. Drag the Oracle DB GetLine icon from the Database toolbox into the Agenda Tree 

at the desired location. 

The Oracle DB GetLine Building Block parameters dialog box opens. 

 

Figure 176: Oracle DB GetLine Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 74. 

 



  

WebLOAD IDE User's Guide  303  

4. Click OK.  

The Oracle DB GetLine Building Block is added to the Agenda Tree. The JavaScript 

code, including the InitAgenda() and TerminateClient() functions, is 

added to the Agenda. To see the new JavaScript code, view the Agenda in 

JavaScript Editing mode. 

The fields in the Oracle DB GetLine Building Block parameters dialog box are 

described in the following table: 

Table 74: Oracle DB GetLine Building Block Parameters Dialog Box Fields 

Field Name Description 

Database name Specify the name of the database on the Oracle Database server. 

Type the appropriate database name into the input-text window that 

appears when you click the small arrow to the right of the Value input 

area for this field. 

User name Specify a user ID for authentication against the database. 

Type the user ID into the input-text window that appears when you click 

the small arrow to the right of the Value input area for this field. 

Password Specify a password for authentication against the database. 

Type the password into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. 

SQL expression Specify the SQL command to be executed. Type the complete command 

into the input-text window that appears when you click the small arrow to 

the right of the Value input area for this field. 

Note: To take full advantage of the Database Building Blocks, testers 

must understand how to work with ADO objects and have a basic 

knowledge of SQL command syntax. WebLOAD IDE automatically 

inserts into the test session Agenda the appropriate JavaScript code 

to implement specified database commands. However, it is the tester 

who must specify the database commands to be inserted. WebLOAD 

IDE cannot correct a tester’s SQL syntax errors. 

Temporary file 

name 

Name to use for the temporary file that will contain the output data from 

the SQL statement. 

This temporary file will serve as an input file to the test session Agenda. 

Data from this file is read line by line, where each data record is a separate 

line. 

The delimiter 

character 

between the 

fields 

Delimiter character that separates between the fields in each record. 

This delimiter character must not appear as valid character within any of 

the data fields. The default delimiter character is a pound sign (#). 

Type in a different character as needed. 
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Field Name Description 

Max number of 

records 

Specifies the maximum number of records to read from the database. 

Number of 

records per 

Generator 

Specifies the maximum number of records to be read from the database by 

each generator. 

This field is intended for instances of testing by a network of generators. 

Multiple generators do not merge or share data. Database access is 

synchronized between generators, similar to WebLOAD IDE’s 

synchronization of Global Parameters.  

Each generator is allowed access to a specific number of records, allowing 

all the generators to work with the database in parallel. Record access is 

divided evenly between generators. The total number of records allocated 

to all generators must be equal to the Maximum Number of Records field 

value. For example, 1000 records may be divided between 10 Load 

Generators, with 100 records allocated per generator. 

MySQL DB GetLine 

When running large load tests, the user input is usually read automatically from an 

input file. To read many rows of input data from a simple text file, WebLOAD uses the 

MySQL GetLine() I/O command. To read large amounts of input data from a 

MySQL database, WebLOAD uses the equivalent MySQL DBGetLine database 

Building Block. 

The MySQL DB GetLine Building Block reads complete records, one by one, from a 

specified database table. The database table is exported into a temporary file, from 

which the records are read, one record per line.  

Note: Before connecting to the MySQL database, verify that the MySQL 

connector/ODBC 3.5.1 Driver is installed on your computer. In addition, verify that the 

MySQL port (3306) is open on the local/remote firewall and that the MySQL database 

has the right grant permission for the user and IP address from which you are 

connecting. 

To enter a value: 

1. Drag the MySQL DB GetLine icon from the Database toolbox into the Agenda 

Tree at the desired location. 

The MySQL DB GetLine Building Block parameters dialog box opens. 
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Figure 177: MySQL DB GetLine Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 75. 

4. Click OK.  

The MySQL DB GetLine Building Block is added to the Agenda Tree. The 

JavaScript code, including the InitAgenda(), InitClient(), and 

TerminateClient() functions, is added to the Agenda. To see the new 

JavaScript code, view the Agenda in JavaScript Editing mode. 

The fields in the MySQL DB GetLine Building Block parameters dialog box are 

described in the following table: 

Table 75: MySQL DB GetLine Building Block Parameters Dialog Box Fields 

Field Name Description 

Server name 

(MySQL Server) 

Specify the name of the MySQL Database server. 

Database name Specify the name of the database on the MySQL Database server. 

Type the appropriate database name into the input-text window that 

appears when you click the small arrow to the right of the Value input 

area for this field. 
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Field Name Description 

User name Specify a user ID for authentication against the database. 

Type the user ID into the input-text window that appears when you click 

the small arrow to the right of the Value input area for this field. 

Password Specify a password for authentication against the database. 

Type the password into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. 

SQL expression Specify the SQL command to be executed. Type the complete command 

into the input-text window that appears when you click the small arrow to 

the right of the Value input area for this field. 

Note: To take full advantage of the Database Building Blocks, testers 

must understand how to work with ADO objects and have a basic 

knowledge of SQL command syntax. WebLOAD IDE automatically 

inserts into the test session Agenda the appropriate JavaScript code 

to implement specified database commands. However, it is the tester 

who must specify the database commands to be inserted. WebLOAD 

IDE cannot correct a tester’s SQL syntax errors. 

Temporary file 

name 

Name to use for the temporary file that will contain the output data from 

the SQL statement. 

This temporary file will serve as an input file to the test session Agenda. 

Data from this file is read line by line, where each data record is a separate 

line. 

The delimiter 

character 

between the 

fields 

Delimiter character that separates between the fields in each record. 

This delimiter character must not appear as valid character within any of 

the data fields. The default delimiter character is a pound sign (#). 

Type in a different character as needed. 

Max number of 

records 

Specifies the maximum number of records to read from the database. 

Number of 

records per 

Generator 

Specifies the maximum number of records to be read from the database by 

each generator. 

This field is intended for instances of testing by a network of generators. 

Multiple generators do not merge or share data. Database access is 

synchronized between generators, similar to WebLOAD IDE’s 

synchronization of Global Parameters.  

Each generator is allowed access to a specific number of records, allowing 

all the generators to work with the database in parallel. Record access is 

divided evenly between generators. The total number of records allocated 

to all generators must be equal to the Maximum Number of Records field 

value. For example, 1000 records may be divided between 10 Load 

Generators, with 100 records allocated per generator. 
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DB Load 

Use the DB Load Building Block to generate a load test for the specified database. The 

load is generated by executing multiple iterations of database commands read from an 

input file. Load testing though the WebLOAD testing suite is usually scheduled only 

after functional testing is completed with WebLOAD IDE. 

To enter a value: 

1. Drag the DB Load icon from the Database toolbox into the Agenda Tree at the 

desired location. 

The DB Load Building Block parameters dialog box opens. 

 

Figure 178: DB Load Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 76. 

4. Click OK.  

The DB Load Building Block is added to the Agenda Tree. The JavaScript code, 

including the InitAgenda(), InitClient(), and TerminateClient() 

functions, is added to the Agenda. To see the new JavaScript code, view the 

Agenda in JavaScript Editing mode. 
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The fields in the DB Load Building Block parameters dialog box are described in the 

following table: 

Table 76: DB Load Building Block Parameters Dialog Box Fields 

Field Name Description 

Database type Specify the type of database to be opened. 

Select the appropriate value from the drop-down list that appears 

when you click the Value input area for this field. 

The options include MS-Access and SQL Server databases. 

Server name (SQL 

Server) 

Specify the name of the machine where the database is running. 

Type the appropriate server name into the input-text window that 

appears when you click the small arrow to the right of the Value input 

area for this field. 

Relevant for SQL Server databases only. 

Database name 

(SQL Server) 

Specify the name of the database on the SQL server. 

Type the appropriate database name into the input-text window that 

appears when you click the small arrow to the right of the Value input 

area for this field. 

Relevant for SQL Server databases only. 

User name (SQL 

Server) 

Specify a user ID for authentication against the database. 

Type the user ID into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. 

Relevant for SQL Server databases only. 

Password (SQL 

Server) 

Specify a password for authentication against the database. 

Type the password into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. 

Relevant for SQL Server databases only. 

File name (MDB 

file) 

Specify the full path for an MDB file. 

Select the appropriate file from the Browser window that appears 

when you click  to the right of the Value input area for this field. 

Relevant for MDB databases only. 
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Field Name Description 

Input File Name Name of the input file that contains a set of SQL commands and 

transactions to be completed during this load test. Select the 

appropriate file from the Browser window that appears when you 

click  to the right of the Value input area for this field. Relevant for 

MDB databases only. 

A typical SQL command input file may look like the following: 

Select1#select * from john_emp 

Select2#select * from john_emp where name=‘john’ 

Select3#select * from john_emp where name=‘john’ or 

age > 10 

Update#update john_emp set age = 20 where 

name=‘john’ 

Insert#insert into john_emp values (99, ‘zzz’, 2) 

Delete#delete from john_emp where id=99 

The input file consists of rows of SQL commands. As with all load 

testing, the commands in the input file are executed in sequence, with 

WebLOAD looping through the file repeatedly until the test is 

completed. Each SQL command line in the input file is preceded by a 

name identifying the transaction in which the command will be 

located. A pound sign (#) separates the transaction name field from the 

SQL command field in each row. 

Each SQL command is defined as a distinct HTTP transaction, 

enclosed in the Agenda body within a 

BeginTransaction()/EndTransaction() set and identified by 

the transaction name. These transactions, like all transactions, are 

tracked automatically by the built-in WebLOAD timers and counters. 

Statistics on the performance of each transaction appear in the 

WebLOAD output reports, with each transaction identified in the 

report by name. 

Delimiter character 

between fields 

Delimiter character that separates between the fields in each record. 

This delimiter character must not appear as valid character within any 

of the data fields. The default delimiter character is a pound sign (#). 

Type in a different character as needed. 

SQL/command to 

reset DB 

Specify an SQL command to be executed at the end of a testing round 

to reset the database. 

This field is reserved for any “cleanup” commands that may be 

required in order to continue using the database for multiple 

iterations. 

Type the complete command into the input-text window that appears 

when you click the small arrow to the right of the Value input area for 

this field. 
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Oracle DB Load 

Use the Oracle DB Load Building Block to generate a load test for the specified Oracle 

database. The load is generated by executing multiple iterations of database commands 

read from an input file. Load testing though the WebLOAD testing suite is usually 

scheduled only after functional testing is completed with WebLOAD IDE.  

Note: To use the Oracle DB Load Building Block you must first install the Oracle 

Client. The Oracle Client must be installed on the same machine as the IDE.  

To enter a value: 

1. Drag the Oracle DB Load icon from the Database toolbox into the Agenda Tree at 

the desired location. 

The Oracle DB Load Building Block parameters dialog box opens. 

 

Figure 179: Oracle DB Load Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described in Table 77. 

4. Click OK.  

The Oracle DB Load Building Block is added to the Agenda Tree. The JavaScript 

code, including the InitAgenda(), InitClient(), and TerminateClient() 

functions, is added to the Agenda. To see the new JavaScript code, view the 

Agenda in JavaScript Editing mode. 
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The fields in the Oracle DB Load Building Block parameters dialog box are described in 

the following table: 

Table 77: Oracle DB Load Building Block Parameters Dialog Box Fields 

Field Name Description 

Database name Specify the name of the database on the Oracle Database server. 

Type the appropriate database name into the input-text window that 

appears when you click the small arrow to the right of the Value input 

area for this field. 

User name Specify a user ID for authentication against the database. 

Type the user ID into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. 

Password Specify a password for authentication against the database. 

Type the password into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this field. 

Input File Name Name of the input file that contains a set of SQL commands and 

transactions to be completed during this load test. Select the 

appropriate file from the Browser window that appears when you 

click the  button to the right of the Value input area for this field. 

Relevant for MDB databases only. 

A typical SQL command input file may look like the following: 

Select1#select * from john_emp 

Select2#select * from john_emp where name=‘john’ 

Select3#select * from john_emp where name=‘john’ or 

age > 10 

Update#update john_emp set age = 20 where 

name=‘john’ 

Insert#insert into john_emp values (99, ‘zzz’, 2) 

Delete#delete from john_emp where id=99 

The input file consists of rows of SQL commands. As with all load 

testing, the commands in the input file are executed in sequence, with 

WebLOAD looping through the file repeatedly until the test is 

completed. Each SQL command line in the input file is preceded by a 

name identifying the transaction in which the command will be 

located. A pound sign (#) separates the transaction name field from the 

SQL command field in each row. 
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Field Name Description 

Input File Name 

(continued) 

Each SQL command is defined as a distinct HTTP transaction, 

enclosed in the Agenda body within a 

BeginTransaction()/EndTransaction() set and identified by 

the transaction name. These transactions, like all transactions, are 

tracked automatically by the built-in WebLOAD timers and counters. 

Statistics on the performance of each transaction appear in the 

WebLOAD output reports, with each transaction identified in the 

report by name. 

Delimiter character 

between fields 

Delimiter character that separates between the fields in each record. 

This delimiter character must not appear as valid character within any 

of the data fields. The default delimiter character is a pound sign (#). 

Type in a different character as needed. 

SQL/command to 

reset DB 

Specify an SQL command to be executed at the end of a testing round 

to reset the database. 

This field is reserved for any “cleanup” commands that may be 

required in order to continue using the database for multiple 

iterations. 

Type the complete command into the input-text window that appears 

when you click the small arrow to the right of the Value input area for 

this field. 

MySQL DB Load 

Use the MySQL DB Load Building Block to generate a load test for the specified 

MySQL database. The load is generated by executing multiple iterations of database 

commands read from an input file. Load testing though the WebLOAD testing suite is 

usually scheduled only after functional testing is completed with WebLOAD IDE.  

Note: Before connecting to the MySQL database, verify that the MySQL 

connector/ODBC 3.5.1 Driver is installed on your computer. In addition, verify that the 

MySQL port (3306) is open on the local/remote firewall and that the MySQL database 

has the right grant permission for the user and IP address from which you are 

connecting. 

To enter a value: 

1. Drag the MySQL DB Load icon from the Database toolbox into the Agenda Tree at 

the desired location. 

The MySQL DB Load Building Block parameters dialog box opens. 
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Figure 180: MySQL DB Load Building Block Parameters Dialog Box 

2. Click the name of an input field in the left-hand column to see an explanation of 

that field in the comment area at the bottom of the dialog box. 

3. Enter the appropriate field value into the Value column next to the field name, as 

described Table 78. 

4. Click OK.  

The MySQL DB Load Building Block is added to the Agenda Tree. The JavaScript 

code, including the InitAgenda(), InitClient(), and TerminateClient() 

functions, is added to the Agenda. To see the new JavaScript code, view the 

Agenda in JavaScript Editing mode. 

The fields in the MySQL DB Load Building Block parameters dialog box are described 

in the following table: 

Table 78: MySQL DB Load Building Block Parameters Dialog Box Fields 

Field Name Description 

Server name (MySQL 

server) 

Specify the name of the MySQL Database server. 

Database name Specify the name of the database on the MySQL Database server. 

Type the appropriate database name into the input-text window 

that appears when you click the small arrow to the right of the 

Value input area for this field. 
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Field Name Description 

User name Specify a user ID for authentication against the database. 

Type the user ID into the input-text window that appears when you 

click the small arrow to the right of the Value input area for this 

field. 

Password Specify a password for authentication against the database. 

Type the password into the input-text window that appears when 

you click the small arrow to the right of the Value input area for this 

field. 

Input File Name Name of the input file that contains a set of SQL commands and 

transactions to be completed during this load test. Select the 

appropriate file from the Browser window that appears when you 

click the  button to the right of the Value input area for this field. 

Relevant for MDB databases only. 

A typical SQL command input file may look like the following: 

Select1#select * from john_emp 

Select2#select * from john_emp where name=‘john’ 

Select3#select * from john_emp where name=‘john’ 

or age > 10 

Update#update john_emp set age = 20 where 

name=‘john’ 

Insert#insert into john_emp values (99, ‘zzz’, 2) 

Delete#delete from john_emp where id=99 

The input file consists of rows of SQL commands. As with all load 

testing, the commands in the input file are executed in sequence, 

with WebLOAD looping through the file repeatedly until the test is 

completed. Each SQL command line in the input file is preceded by 

a name identifying the transaction in which the command will be 

located. A pound sign (#) separates the transaction name field from 

the SQL command field in each row. 

Each SQL command is defined as a distinct HTTP transaction, 

enclosed in the Agenda body within a 

BeginTransaction()/EndTransaction() set and identified 

by the transaction name. These transactions, like all transactions, are 

tracked automatically by the built-in WebLOAD timers and 

counters. Statistics on the performance of each transaction appear in 

the WebLOAD output reports, with each transaction identified in 

the report by name. 

Delimiter character 

between fields 

Delimiter character that separates between the fields in each record. 

This delimiter character must not appear as valid character within 

any of the data fields. The default delimiter character is a pound 

sign (#). 

Type in a different character as needed. 
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Field Name Description 

SQL/command to reset 

DB 

Specify an SQL command to be executed at the end of a testing 

round to reset the database. 

This field is reserved for any “cleanup” commands that may be 

required in order to continue using the database for multiple 

iterations. 

Type the complete command into the input-text window that 

appears when you click the small arrow to the right of the Value 

input area for this field. 

 

The WebLOAD IDE Verifications Toolbox 

The following table describes the purpose of each of the WebLOAD IDE Verifications 

Toolbox items: 

Table 79: Verifications Toolbox Items 

Agenda Item Purpose 

WS-Single Verifies the value of the first element returned by the query to the 

Web service (WS). 

WS-Multiple Verifies the value of every element returned by the query to the Web 

service (WS). 

Flex:Verify-Ext Verifies data in the AMF data response.  

Flex:Extract-Ext Extracts data from AMF data response 

 

To add Verifications Building Blocks to a test Agenda directly through the 

WebLOAD IDE: 

 Drag the selected verification Building Block from the Verifications toolbox and 

drop it into the Agenda Tree immediately after the node that represents the 

response you wish to verify. 

Each Verifications Building Block opens a different dialog box. Enter the required 

values in the Value fields. Explanations are provided at the bottom of the dialog box 

for each parameter as it is selected in the dialog box. 
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Note: The values that appear in the dialog box Value area are the default values for 

each field. In most cases, the default value for string variables is an empty string, 

indicated in the Value area by a set of empty quotation marks. If you are entering your 

own value for a string field, the new string must also be enclosed within quotation 

marks. Fields that were not assigned a value in the dialog box are left as empty fields 

in the Agenda code. 

A Verifications node is added to the Agenda Tree for each Verifications Building Block 

defined. WebLOAD IDE automatically adds the corresponding JavaScript code to your 

test session Agenda. 

WS-Single 

The WS-Single Building Block enables you to automatically generate a verification 

function of the value of the first element in a Web service’s response, in your Agenda. 

During playback, the results of the verification process (failure or success) are 

displayed in the Log View window. 

If the verification succeeds, a Debug message is written to the Log View (with the 

element name and actual value) and the function returns WLSuccess. If the verification 

fails, a Warning message is displayed and the function returns WLMinorError. 

To insert a WS-Single Building Block: 

1. Drag the WS-Single icon from the Verifications toolbox into the Agenda Tree 

immediately after the node that represents the response you wish to verify. 

The WS-Single Node Building Block parameters dialog box opens. 

 

Figure 181: WS-Single Node Building Block Parameters Dialog Box 
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2. Edit the dialog box fields according to the following table. 

Table 80: WS-Single Node Building Block Parameters Dialog Box Fields 

Field Name Description 

XML Node Path The XPath query string of the object to be verified. 

XML Node Value The desired response of the verification. 

Return Value The return value in case of failure. 

3. Click OK. 

The WS-Single node is added to the Agenda Tree. The JavaScript code, including 

the InitAgenda()function, is added to the Agenda. To see the new JavaScript 

code, view the Agenda in JavaScript Editing mode.  

For example: 

function InitAgenda() 

{ 

//Start generation for Building Block WS - Single Node 

 

IncludeFile("wlXmlVerification.js", WLExecuteScript); 

wlGlobals.SaveSource = true; 

xmlDom  = InitXML(); 

 

//End generation for Building Block WS - Single Node 

} 

/***** WLIDE - WS - Single Node - ID:2 *****/ 

 

VerifyXMLNode(document.wlSource, “//Result”, “2”) 

 

// END WLIDE 

 

Note: After the verification function is created in the Agenda, you can duplicate it 

several times within the Agenda to verify different response values.  
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WS-Multiple 

The WS-Multiple Building Block enables you to automatically generate a verification 

function of the values of every element in a Web service’s response, in your Agenda. 

During playback, the result of the verification process (failure or success) is displayed 

in the Log View window. 

If the verification succeeds, a Debug message is written to the Log View (with the 

element name and actual value) and the function returns WLSuccess. If the verification 

fails, a Warning message is displayed and the function returns WLMinorError. 

To insert a WS-Multiple Building Block: 

1. Drag the WS-Multiple icon from the Verifications toolbox into the Agenda Tree 

immediately after the node that represents the response you wish to verify. 

The WS-Multiple Nodes Building Block parameters dialog box opens. 

 

Figure 182: WS-Multiple Nodes Building Block Parameters Dialog Box 

2. Edit the dialog box fields according to the following table. 

Table 81: WS-Multiple Nodes Building Block Parameters Dialog Box Fields 

Field Name Description 

XML Node Path The XPath query string of the object to be verified. 

XML Node Value The desired response of the verification. 

Return Value Select the return value in case of failure. 
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3. Click OK. 

The WS-Multiple node is added to the Agenda Tree. The JavaScript code, 

including the InitAgenda()function, is added to the Agenda. To see the new 

JavaScript code, view the Agenda in JavaScript Editing mode.  

For example: 

function InitAgenda(){ 

//Start generation for Building Block WS - Multiple 

Nodes 

 

IncludeFile("wlXmlVerification.js", WLExecuteScript); 

wlGlobals.SaveSource = true; 

xmlDom  = InitXML(); 

 

//End generation for Building Block WS - Multiple Nodes 

} 

/***** WLIDE - WS - Multiple Nodes - ID:3 *****/ 

 

VerifyXMLNodes(document.wlSource, ”//Result”, “5”) 

 

// END WLIDE 

 

Note: After the verification function is created in the Agenda, you can duplicate it 

several times within the Agenda to verify different response values. 

Flex:Verify-Ext 

The Flex:Verify-Ext Building Block enables you to automatically generate a verification 

function of the data in the AMF data response, in your Agenda. During playback, the 

results of the verification process (failure or success) are displayed in the Log View 

window. 

If the verification succeeds, a Debug message is written to the Log View (with the 

element name and actual value) and the function returns WLSuccess. If the verification 

fails, a Warning message is displayed and the function returns WLMinorError. 

To insert a Flex:Verify-Ext Building Block: 

1. Drag the Flex:Verify-Ext icon from the Verifications toolbox into the Agenda Tree 

immediately after the node that represents the AMF data response you wish to 

verify. 
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The Flex:Verify-Ext Building Block parameters dialog box opens. 

 

Figure 183: Flex:Verify-Ext Building Block Parameters Dialog Box 

2. Edit the dialog box fields according to the following table. 

Table 82: Flex:Verify-Ext Building Block Parameters Dialog Box Fields 

Field Name Description 

AMF Response Parameter Name The path to the relevant AMF response element. 

AMF Response Parameter Value The value of the AMF response's parameter. 

Severity Select the return value in case of failure. 

3. Click OK. 

The Flex:Verify-Ext node is added to the Agenda Tree. The JavaScript code, 

including the InitAgenda()function, is added to the Agenda. To see the new 

JavaScript code, view the Agenda in JavaScript Editing mode.  

For example: 

function InitAgenda() 

{ 

 

//Start generation for Building Block Flex:Verify-Ext 

 

 IncludeFile("amfVerification.js"); 
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//End generation for Building Block Flex:Verify-Ext 

} 

/***** WLIDE - Flex:Verify-Ext - ID:11 *****/ 

 

AMFResponse = new 

Packages.com.radview.amf.WLAmfMessage(getAmfDataAsJsStri

ng()); 

VerifyAMFExt(AMFResponse,"ActionMessage.bodies(0).data.b

ody(1).category", "AMF test3", WLMinorError) 

 

// END WLIDE 

 

Note: After the verification function is created in the Agenda, you can duplicate it 

several times within the Agenda to verify different response values. 

Flex:Extract-Ext 

The Flex:Extract-Ext Building Block enables you to automatically extract data from an 

AMF data response, in your Agenda. During playback, the extracted data is displayed 

in the Log View window. 

If the extraction succeeds, a Debug message is written to the Log View (with the 

element name and actual value). If the extraction fails, the function returns NULL and 

a warning message is displayed. 

To insert a Flex:Extract -Ext Building Block: 

1. Drag the Flex: Extract-Ext icon from the Verifications toolbox into the Agenda Tree 

immediately after the node that represents the AMF data response from which you 

wish to extract data. 
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The Flex:Extract-Ext Building Block parameters dialog box opens. 

 

Figure 184: Flex:Extract-Ext Building Block Parameters Dialog Box 

2. Edit the dialog box fields according to the following table. 

Table 83: Flex:Extract-Ext Building Block Parameters Dialog Box Fields 

Field Name Description 

AMF Response Parameter Name The path to the relevant AMF response element. 

Parameter Name The name of the parameter to assign. 

3. Click OK. 

The Flex:Extract-Ext node is added to the Agenda Tree. The JavaScript code, 

including the InitAgenda()function, is added to the Agenda. To see the new 

JavaScript code, view the Agenda in JavaScript Editing mode.  

For example: 

retVal = 

extractAMFValueExt("ActionMessage.bodies(0).data.body(1)

.category"); 

 

Note: After the extraction function is created in the Agenda, you can duplicate it 

several times within the Agenda to extract data from different AMF data 

responses. 
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Appendix B 

WebLOAD IDE File Types 

The following is a list of files associated with a WebLOAD IDE project.  

Table 84: WebLOAD IDE Project Files 

WebLOAD IDE Extension WebLOAD IDE File Type 

.WLP Files WebLOAD IDE Project Files 

.WLS Files WebLOAD IDE Session Files 

.WLA Files Actual Repository Files 

.WLE Files Expected Repository Files 

.LOG Files Saved Log Window Files 
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Appendix C 

Launching WebLOAD IDE Testing 
through the Command Line 
Interface 

This section provides instructions and examples for using Command Line Interface 

(CLI) to launch WebLOAD IDE testing. 

Running WebLOAD IDE Testing through the CLI 

You can also initiate WebLOAD IDE testing directly through the CLI. You can enter the 

WebLOAD IDE launch command into a batch file or into an external script and 

WebLOAD IDE will run directly, without user intervention, using the parameters 

specified.  

To run WebLOAD IDE testing through the CLI: 

Enter the webloadIDE.exe command together with a series of optional parameters 

(described below) into your external script to automatically launch a WebLOAD IDE 

test. When your script runs, the executable file will invoke WebLOAD IDE and run the 

specified test according to the specified parameters. 

Syntax 

Use the following syntax to define the parameters for running a WebLOAD IDE test 

through a Command Line Interface: 

webloadide.exe [<flags>][<project or session name to open>] 

[<session name to save to>][<Number of rounds to run>] 

To run more than one session, append all relevant parameters at the end of the syntax. 

See examples 2 and 3 in Examples (on page 326). 
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Parameters 

When running a test invoked by the executable, you can specify the following 

parameters: 

Table 85: Parameters for Test Invoked by the Executable 

Parameter Description 

Flags /a - auto run 

Automatically run the WebLOAD IDE test without waiting 

for user input. If this flag is not specified, WebLOAD IDE is 

opened with the specified project / session but the test is not 

automatically run. The system waits for user input. 

Project or session name to 

open 

The name of the .wlp file or .wls file (Project file or Session 

file) to run. 

Session name to save to The name of the .wls file containing the test data. This file 

will be saved in the current directory unless otherwise 

specified. 

Number of rounds to run The number of iterations to run during runtime. The default 

value is 1. 

 

Parameters are all optional. If no parameters are entered, the executable launches 

WebLOAD IDE and does not run a test. If the autorun flag </a> flag is not set, the 

< Session name to save to >, and the < Number of rounds to run > parameters are 

ignored. 

Examples 

Example 1: 

webloadide.exe test1.wlp 

This command opens WebLOAD IDE with the test1 project file and waits for user 

input.  

Example 2: 

webloadide.exe /a test1.wlp test2.wlp 3 

This command: 

 Opens WebLOAD IDE and automatically runs a test using the test1.wlp project 

file. 

 Runs the project for three iterations. 
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 Saves the test results in the WebLOAD IDE session file test1.wls, which 

includes all of the test data and results. 

Example 3: 

webloadide.exe /a test1.wlp test1.wls 3 /a test2.wlp test2.wls 2 

This command: 

 Opens WebLOAD IDE and automatically runs a test using the test1.wlp project 

file. 

 Runs the project test1.wlp for three iterations. 

 Saves the test results in the WebLOAD IDE session file test1.wls, which 

includes all of the test data and results. 

 Opens the WebLOAD IDE project file test2.wlp. 

 Runs the project test2.wlp for two iterations. 

 Saves the test results in the WebLOAD IDE session file test2.wls, which 

includes all of the test data and results. 
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Appendix D 

 Converting Certificate Files 

WebLOAD IDE supports the use of SSL Client Certificates. WebLOAD IDE requires 

that the certificate file be in *.pem format. If the certificate file is in *.pfx or *.p12 

format, use the Certificate Conversion Wizard application to convert the file to *.pem 

format. 

Note: You can use your web browser to export certificates to *.pfx or *.p12 format. 

To convert certificate files: 

1. Select Start  Programs  RadView  WebLOAD  Utilities  Certificate 

Conversion Wizard. The Certificate Conversion Wizard appears. 

 

Figure 185: Certificate Conversion Wizard 

2. In the Certificate file to convert field, enter the path and file name of a certificate 

file to convert. 

-Or 

Click  and browse to the file. 

3. In the Password for input file field, enter the password for the certificate file. 

Note: If you do not know the password, contact your IT manager. 
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4. In the Save converted file as field, enter a path and file name for the converted 

certificate file. 

-Or 

Click  to open a standard Windows® Save As window. 

5. In the Password for output file field, enter a password for the converted certificate. 

Note: It is recommended that you use the same password as the one used for the 

original certificate file. 

6. In the Confirm password field, enter the password that you entered in the 

Password for output file field. 

7. Click Convert. The file is converted. 
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Appendix E 

Recording Mobile Applications 

WebLOAD enables recording mobile applications in two ways: 

 Native Mobile Recording – recording traffic from an actual mobile device. This 

works for both mobile web applications and native mobile applications. 

 Simulate mobile in browser – records mobile web applications in the desktop by 

simulating a mobile browser. Does not require a mobile device, but only works for 

mobile web applications. 

In addition, you can playback a recording as if it were a recording from a mobile 

application. This is performed in the WebLOAD Console using the Current Project 

Options window. In the Browser Type tab, specify the mobile application in the 

Browser Parameters section. The browser type you select overrides the settings that 

were defined during the recording, and plays back the recording according to the new 

settings.  

Native Mobile Recording 

To record traffic from an actual mobile device: 

1. Start native mobile recording, as follows: 

a. In WebLOAD IDE, click Start Recording in the Home tab of the ribbon. The 

Recording dialog appears. 
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Figure 186: Selecting Native Mobile Recording 

b. In the Open Browser drop-down list, select Native Mobile Recording. 

c. Click OK. 

2. Set up the mobile device proxy, as follows: 

a. Connect the mobile device to a Wireless network that can access your 

WebLOAD machine. 

b. Configure the device’s wireless proxy settings to go through the WebLOAD 

machine, on the noted port.  

This step depends on the device OS type and version. For example, see Setting 

Proxy Settings in iPhone (on page 333) and Setting Proxy Settings in Android (on 

page 336). 

3. Perform actions in your mobile device application or web browser; the HTTP 

requests will be recorded in the Agenda test script. 

4. Stop recording, as follows: 

a. In WebLOAD IDE, click Stop Recording.  

b. In the mobile device, change the Proxy settings back to off. 

 

Note: You may need to open you firewall to accept connections to proxynator.exe, on 

port 9884. 

Note: To record secure traffic (HTTPS), the root certificate needs to be imported to the 

phone. For example, see Recording HTTPS Traffic on iPhone (on page 335) and 

Recording HTTPS traffic on Android (4.0 and above) (on page 336). 
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Note: When not recording, the mobile device will not be able to access the network 

(because the proxy is not available) – to use the network normally, revert the HTTP 

Proxy setting back to Off. 

Setting Proxy Settings in iPhone 

To set iPhone proxy settings: 

1. Open Settings, and access the Wi-Fi network settings: 

  

Figure 187: Accessing Wi-Fi iPhone Settings 
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2. Select edit current Wi-Fi Network settings: 

 

Figure 188: Edit Current Wi-Fi iPhone Settings 

3. Scroll down the HTTP Proxy section. Change proxy to Manual and set the Server 

and Port to point to the WebLOAD machines. 

The default port for the proxy-recorder is 9884. You may need to use the machine’s 

IP-address instead of name. 

  

Figure 189: Setting Wi-Fi iPhone Settings 
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Recording HTTPS Traffic on iPhone 

In order to record HTTPS traffic, the WebLOAD root certificate needs to be trusted by 

the phone. To import the root certificate: 

1. Locate the root certificate, in: 

c:\Program Files\RadView\WebLOAD\bin\Certificates\root.pem 

2. Open the root.pem file on the phone. This can be done by sending the file via 

e-mail, or accessing the file from a web-server. 

3. Click Install. 

  

Figure 190: Installing the Root CA 

4. A warning will appear; click Install. 

The certificate should now be trusted 

 

5. After recording is completed, the certificate may be removed. To remove the 

certificate, select the following: 

Settings > General > Profile ‘RadView Root CA’ > Remove. 
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Setting Proxy Settings in Android 

To set Android proxy settings: 

1. Using the menu button, select Settings. 

2. Select Wireless & networks. 

3. Select Wi-Fi settings. 

4. Switch on and connect to your designated Wi-Fi network. 

5. Once connected, press the Menu button again and select Advanced. 

6. Set Proxy to the WebLOAD machine IP-address, and Port to 9884. 

  

Figure 191: Proxy Settings in Android – Two Examples 

Recording HTTPS traffic on Android (4.0 and above) 

In order to record HTTPS traffic, the WebLOAD root certificate needs to be trusted by 

the phone. To import the root certificate: 

1. Locate the root certificate, in: 

c:\Program Files\RadView\WebLOAD\bin\Certificates\root.pem 
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2. Copy locally, as root.crt. 

3. Copy root.crt from your computer to the root of your device's internal storage (that 

is, not in a folder). 

4. From a Home or All Apps screen, tap the Settings icon. 

5. Go to Personal > Security > Credential storage > Install from storage. 

Simulating a Mobile in a Browser 

In Simulate mode, the recording is done using the desktop browser, identified to the 

server as a mobile user agent. 

To simulate a mobile: 

1. In WebLOAD IDE, click Start Recording. 

  

Figure 192: Simulating a Mobile 

2. Check the Identify As checkbox. 

3. Select the Browser family and Version. 

4. Click OK. 

 

Note: This approach is only applicable to some mobile web-sites, which rely on server-

side mobile detection 

Note: Some mobile sites may not render as expected in the desktop browser. 
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Note: For best results, use a Chrome browser.
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Appendix F 

Glossary 

Glossary Term Description 

AAT An older, obsolete WebLOAD utility that was used for 

recording web session activities as a JavaScript file. It is 

replaced by WebLOAD IDE. 

Aborted Rounds The number of times the Virtual Clients started to run 

an Agenda but did not complete the Agenda, during the 

last reporting interval. This might be due to a session 

being stopped either automatically or manually by the 

user. 

Agenda Specification of the sequence of HTTP protocol calls sent 

by Virtual Clients to the SUT (System Under Test). 

Agendas are written in JavaScript. You can either write 

Agendas as a text file or generate them automatically 

using the WebLOAD IDE. 

Application Being Tested (ABT) See SUT. 

Attempted Connections The total number of times the Virtual Clients attempted 

to connect to the SUT during the last reporting interval. 

Automatic Transaction counters If you have Automatic Transactions enabled, WebLOAD 

creates three counters for each GET and POST statement 

in the Agenda: 

  The total number of times it occurred  

 The number of times it succeeded  

 The number of times it failed during the last 

reporting interval. 

Average For timers, average is the total amount of time counted 

by the timer (not the elapsed time) divided by the Count 

(that is, the total number of readings). For example, the 

average for Transaction Time is the amount of time it 

took to complete all the successful transactions, divided 

by the number of successful transactions (the Count). 
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Glossary Term Description 

Built-in Timer A timer measures the time required to perform a given 

task. WebLOAD supports both programmed timers and 

built-in timers. ROUND TIME is a built-in timer. The 

ROUND TIME is the time needed for one complete 

execution of an Agenda. 

Connect Time The time it takes for a Virtual Client to connect to the 

System Under Test (the SUT), in seconds. In other 

words, the time it takes from the beginning of the HTTP 

request to the TCP/IP connection. 

The value posted in the Current Value column is the 

average time it took a Virtual Client to connect to the 

SUT during the last reporting interval. 

If the Persistent Connection option is enabled, there may 

not be a value for Connect Time because the HTTP 

connection remains open between successive HTTP 

requests. 

Connection Speed (Bits Per 

Second) 

The number of bits transmitted back and forth between 

the Virtual Clients and the System Under Test (SUT), 

divided by the time it took to transmit those bits, in 

seconds. 

You can set the Virtual Clients to emulate a particular 

connection speed during the test, either by using the 

Variable Connection Speed settings, or by coding the 

connection speed in the Agenda. 

If a connection speed is specified for the test, WebLOAD 

reports it in the Statistics Report. 

The value posted in the Current Value column is the 

number (sum) of bits passed per second during the last 

reporting interval. It should match, very closely, the 

connection speed you specified for the test. 
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Glossary Term Description 

Console The WebLOAD component that manages the test 

session. 

The Console performs the following: 

 Configures Load Session hosts and Agendas 

 Schedules Load Session Agendas 

 Configures Goal–Oriented test sessions 

 Monitors the application's performance under the 

generated load 

 Manages the Load Session as it is running, allowing 

you to pause, stop, and continue Load Session 

components as needed 

 Displays the current performance of the SUT 

 Provides a final performance reports for Probing 

Clients and Virtual Clients 

 Manages exporting of performance reports 

Count (For timers only.) The total number of readings (the 

number of times the item being timed has occurred) for 

the timed statistic since the beginning of the test. For 

example, for Transaction Time, Count shows the 

number of transactions that have been completed. 

Current Slice The value posted for this reporting interval in the 

Statistics Report main window. 

Current Slice Average For per time unit statistics and counters, average is the 

total of all of the current values for the last reporting 

interval, divided by the number of readings.  

For timers, average is the total amount of time counted 

by the timer (not the elapsed time), divided by the 

Count (that is, the total number of readings for the last 

reporting interval). For example, the average for 

Transaction Time is the amount of time it took to 

complete all the successful transactions in the last 

reporting interval, divided by the number of successful 

transactions (the Current Slice Count). 

Current Slice Count (For timers only.) The total number of readings (the 

number of times the item being timed has occurred) for 

the timed statistic for the last reporting interval. For 

example, for Transaction Time, Current Slice Count 

shows the number of transactions that have been 

completed over the last reporting interval. 

Current Slice Max The highest value reported for this statistic over the last 

reporting interval. 
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Glossary Term Description 

Current Slice Min The lowest value reported for this statistic over the last 

reporting interval. 

Current Slice Standard Deviation The average amount the measurement for this statistic 

varies from the average over the last reporting interval. 

Current Slice Sum The aggregate or total value for this statistic in this 

Agenda over the last reporting interval. 

DNS Lookup Time The time it takes to resolve the host name and convert it 

to an IP address by calling the DNS server. 

Failed Connections The total number of times the Virtual Clients tried to 

connect to the SUT but were unsuccessful, during the 

last reporting interval.  

This number is always less than or equal to the number 

of failed hits because hits can fail for reasons other than 

a failed connection. 

Failed Hits  The total number of times the Virtual Clients made an 

HTTP request but did not receive the correct HTTP 

response from the SUT during the last reporting 

interval. Note that each request for each gif, jpeg, 

html file, etc., is a single hit. 

Failed Hits Per Second The number of times the Virtual Clients did not obtain 

the correct HTTP response, divided by the elapsed time, 

in seconds.  

The value posted in the Current Value column is the 

number (sum) of unsuccessful HTTP requests per 

second during the last reporting interval. 

Failed Pages Per Second The number of times the Virtual Clients did not obtain 

the correct response to an upper level request, divided 

by the elapsed time, in seconds.  

The value posted in the Current Value column is the 

number (sum) of unsuccessful requests per second 

during the last reporting interval. 

Failed Rounds The total number of times the Virtual Clients started but 

did not complete the Agenda during the last reporting 

interval. 

Failed Rounds Per Second The number of times the Virtual Clients started but did 

not complete an iteration of the Agenda, divided by the 

elapsed time, in seconds. The value posted in the 

Current Value column is the number (sum) of failed 

iterations of the Agenda per second during the last 

reporting interval. 
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Glossary Term Description 

First Byte The time it takes a Virtual Client to receive the first byte 

of data. 

Gallery See Templates Gallery. 

Goal–Oriented Test A WebLOAD component enabling you to define the 

performance goals required, and view the status of your 

application when it is operating under this performance 

goal. WebLOAD provides a Goal–Oriented Test Wizard 

for configuring these performance goals. WebLOAD 

automatically accelerates the number of Virtual Clients 

accessing your website until you meet your performance 

goal. 

Note: The Goal-Oriented Test Wizard was 

previously called the Cruise Control 

Wizard. 

Goal–Oriented Test Wizard See Goal–Oriented Test. 

Hit Time The time it takes to complete a successful HTTP request, 

in seconds. Each request for each gif, jpeg, html file, 

etc., is a single hit. The time of a hit is the sum of the 

Connect Time, Send Time, Response Time, and Process 

Time. 

The value posted in the Current Value column is the 

average time it took to make an HTTP request and 

process its response during the last reporting interval. 

Hits The total number of times the Virtual Clients made 

HTTP requests to the System Under Test (SUT) during 

the last reporting interval.  

For example, a Get statement for a URL retrieves a page. 

The page can include any number of graphics and 

contents files. Each request for each gif, jpeg, html 

file, etc., is a single hit. 

Hits Per Second The number of times the Virtual Clients made an HTTP 

request, divided by the elapsed time, in seconds. Each 

request for each gif, jpeg, html file, etc. is a single hit. 

The value posted in the Current Value column is the 

number (sum) of HTTP requests per second during the 

last reporting interval. 
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Glossary Term Description 

Host A computer connected via a network, participating in a 

test session. Each Host in a test session has assigned 

tasks. A host can act as either a Load Machine or a 

Probing Client Machine. All hosts participating in a test 

session must be accessible to the Console over a 

network. Therefore they must run TestTalk, the network 

agent. 

HTTP Response Status WebLOAD creates a row in the Statistics Report for each 

kind of HTTP status code it receives as an HTTP 

response from the SUT (redirection codes, success codes, 

server error codes, or client error codes).  

The value posted is the number of times the Virtual 

Clients received that status code during the last 

reporting interval. 

Integrated Report A single configurable report that can integrate both 

standard performance data, and data from the NT 

Performance Monitor. This report gives you a more 

complete picture of the performance of your application. 

The data to be monitored and the data to be displayed in 

the report are both configurable in the Console. 

Internet Productivity Pack (IPP) Provides a set of protocol implementations enabling you 

to load-test your application using these protocols. 

Java and ActiveX counters You can add function calls to your Agendas that enable 

you to instantiate and call methods and properties in 

Java and ActiveX components (see the WebLOAD 

Scripting Guide). If there are ActiveX or Java function 

calls in the Agenda that you are running, WebLOAD 

reports three counters for them in the Statistics Report: 

 The total number of times it occurred  

 The number of times it succeeded  

 The number of times it failed during the last 

reporting interval. 

The row heading in the Statistics Report is the name of 

the function call.  
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Java and ActiveX timers You can add function calls to your Agendas that enable 

you to instantiate and call methods and properties in 

Java and ActiveX components (see the WebLOAD 

Scripting Guide). If there are ActiveX or Java function 

calls in the Agenda you are running, WebLOAD reports 

timers for them in the Statistics Report. 

The timer value is the average amount of time it took to 

complete the function call, in seconds, during the last 

reporting interval. 

The row heading in the Statistics Report is the name of 

the function call. 

Load Generator The component of the Load Machine that generates 

Virtual Clients. Load Generators have the task of 

bombarding the System Under Test with HTTP protocol 

call requests as defined in the Agenda. WebLOAD 

assesses the application's performance by measuring the 

response time experienced by the Virtual Clients. The 

number of Virtual Clients at any given moment is 

determined by the user. 

Load Generator Machine See Load Machine. 

Load Machine A host that runs Load Generators. Load Generators 

bombard the application under test with a large load, to 

enable complete scalability and integrity testing. 

Load Session A Load Session includes both the complete Load 

Template and the results obtained while running that 

Load Session. A Load Template consists of information 

about the hosts and Agendas participating in the current 

Load Session. The Load Template will also include 

scheduling information. The complete Load Template is 

illustrated in the Session Tree. Storing a Load Template 

saves you time when repeatedly running WebLOAD 

with the same, or even a similar network configuration, 

since you don't have to recreate your Load Template 

from scratch each time you want to start working. 

Storing Load Session results can be useful when you 

want to examine results from multiple test sessions or 

for analyzing test session results. 

Load Size The number of Virtual Clients running during the last 

reporting interval. 
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Load Template A Load Template contains the complete Load Session 

definition, without the test results. A Load Template 

includes information about the participating hosts and 

the Agendas used in the current Load Session. The 

definition also includes scheduling information and the 

configuration of the Server Monitor and Integrated 

Reports. The complete Load Template is illustrated in 

the Session Tree. Storing a Load Template saves you 

time when repeatedly running WebLOAD with the 

same, or even a similar network configuration, since you 

do not have to recreate your Load Template from 

scratch each time you rerun a test. 

Page Time The time it takes to complete a successful upper level 

request, in seconds. The Page Time is the sum of the 

Connection Time, Send Time, Response Time, and 

Process Time for all the hits on a page. 

The value posted in the Current Value column is the 

average time it took the Virtual Clients to make an 

upper level request and process its response during the 

last reporting interval. 

Pages The total number of times the Virtual Client made upper 

level requests, both successful and unsuccessful, during 

the last reporting interval. 

Pages Per Second The number of times the Virtual Clients made upper 

level requests divided by the elapsed time, in seconds. 

The value posted in the Current Value column is the 

number (sum) of requests per second during the last 

reporting interval. 

Per Time Unit statistics Ratios that calculate an average value for an action or 

process. For example: Transactions Per Second, Rounds 

Per Second. 

Portfolio A Portfolio of reports enables you to generate a single, 

inclusive report that contains all the charts generated by 

the templates included in the portfolio. 

Probing Client A software program which "bombards" the SUT as a 

single Virtual Client, to further measure the 

performance of the SUT. WebLOAD generates exact 

values for Probing Client performance. 

Probing Client Machines Hosts running Probing Client software simulating one 

Virtual Client, and running at the same time as Load 

Machines. 

Probing Client software See Probing Client. 
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Process Time The time it takes WebLOAD to parse an HTTP response 

from the SUT and then populate the document-object 

model (DOM), in seconds. 

The value posted in the Current Value column is the 

average time it took WebLOAD to parse an HTTP 

response during the last reporting interval. 

Receive Time The elapsed time between receiving the first byte and 

the last byte. 

Report Portfolio See Portfolio. 

Resource Manager Distributes and circulates WebLOAD testing resources 

(Virtual Clients and Probing Clients) amongst users on a 

"need to use" basis. The Resource Manager is packaged 

with a maximum number of Virtual Clients, Probing 

Clients and Connected Workstation ports, as defined by 

the WebLOAD package. 

With the Resource Manager, every WebLOAD Console 

can operate in Standalone Workstation mode or 

Connected Workstation mode. 

Response Data Size The size, in bytes, of all the HTTP responses sent by the 

SUT during the last reporting interval.  

WebLOAD uses this value to calculate Throughput 

(bytes per second). 

Response Time The time it takes the SUT to send the object of an HTTP 

request back to a Virtual Client, in seconds. In other 

words, the time from the end of the HTTP request until 

the Virtual Client has received the complete item it 

requested. 

The value posted in the Current Value column is the 

average time it took the SUT to respond to an HTTP 

request during the last reporting interval. 

Responses The number of times the SUT responded to an HTTP 

request during the last reporting interval. 

This number should match the number of successful 

hits. 

Round Time The time it takes one Virtual Client to finish one 

complete iteration of an Agenda, in seconds.  

The value posted in the Current Value column is the 

average time it took the Virtual Clients to finish one 

complete iteration of the Agenda during the last 

reporting interval. 
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Rounds The total number of times the Virtual Clients attempted 

to run the Agenda during the last reporting interval. 

Rounds Per Second The number of times the Virtual Clients attempted to 

run the Agenda, divided by the elapsed time, in 

seconds.  

The value posted in the Current Value column is the 

number (sum) of attempts (both successful and 

unsuccessful) per second during the last reporting 

interval. 

Send Time The time it takes the Virtual Client to write an HTTP 

request to the SUT, in seconds.  

The value posted in the Current Value column is the 

average time it took the Virtual Clients to write a request 

to the SUT during the last reporting interval. 

Server Performance 

Measurements 

If you selected Performance Monitor statistics for the 

report, WebLOAD creates a row for them and reports 

their values in the Statistics Report. 

For definitions of the statistics, see the Server Monitor 

Definition dialog box. 

Be selective when choosing server performance 

measurements , otherwise the system resources required 

to manage the data might affect the Console. 

Session Tree A graphic representation of a Load Template and status. 

It illustrates the different components of a test session, 

including Load Machines and Probing Clients, the 

Agendas that they execute, and their status. 

Single Client See Probing Client. 

Standard Deviation The average amount the measurement varies from the 

average since the beginning of the test. 

Successful Connections The total number of times the Virtual Clients were able 

to successfully connect to the SUT during the last 

reporting interval.  

This number is always less than or equal to the number 

of successful hits because several hits might use the 

same HTTP connection if the Persistent Connection 

option is enabled. 

Successful Hits The total number of times the Virtual Clients made an 

HTTP request and received the correct HTTP response 

from the SUT during the last reporting interval. Each 

request for each gif, jpeg, html file, etc., is a single hit. 
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Successful Hits Per Second The number of times the Virtual Clients obtained the 

correct HTTP response to their HTTP requests divided 

by the elapsed time, in seconds. 

The value posted in the Current Value column is the 

number (sum) of successful HTTP requests per second 

during the last reporting interval. 

Successful Pages Per Second The value posted in the Current Value column is the 

number (sum) of successful requests per second during 

the last reporting interval. 

Successful Rounds The total number of times the Virtual Clients completed 

one iteration of the Agenda during the last reporting 

interval. 

Successful Rounds Per Second The number of times the Virtual Clients completed an 

entire iteration of the Agenda, divided by the elapsed 

time, in seconds.  

The value posted in the Current Value column is the 

number (sum) of successful iterations of the Agenda per 

second during the last reporting interval. 

SUT The system running the Web application currently 

under test. The SUT (System Under Test) is accessed by 

clients through its URL address. The SUT can reside on 

any machine or on multiple machines, anywhere on the 

global Internet or your local intranet. 

Template See Load Template. 

Templates Gallery The Templates Gallery is a single entity that contains 

predefined templates, user-defined templates, and 

portfolios. 

Test Program See Test Script. 

Test Script The Agenda. This defines the test scenario used in your 

Load Session. Agendas are written in JavaScript. 

Test Template See Load Template.  

TestTalk The network agent. This program enables 

communication between the Console and the host 

computers participating in the test. 

Throttle Control A WebLOAD component that enables you to 

dynamically change the Load Size while a test session is 

in progress. 
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Throughput (Bytes Per Second) The average number of bytes per second transmitted 

from the SUT to the Virtual Clients running the Agenda 

during the last reporting interval. In other words, this is 

the amount of the Response Data Size, divided by the 

number of seconds in the reporting interval. 

Time to First Byte The time that elapsed since a request was sent until the 

Virtual Client received the first byte of data. 

User-defined Automatic Data 

Collection 

If you have Automatic Data Collection enabled, 

WebLOAD creates three counters for each GET and 

POST statement in the Agenda: 

 The total number of times the Get and Post 

statements occurred  

 The number of times the statements succeeded 

 The number of times the statements failed during 

the last reporting interval. 

User-defined counters Your own counters that you can add to Agendas using 

the SendCounter() and the 

SendMeasurement() functions (see the WebLOAD 

Scripting Guide). If there is a user-defined counter in the 

Agenda that you are running, WebLOAD reports the 

counter’s values in the Statistics Report. 

The row heading is the name (argument) of the counter. 

That is, the row heading is the string in parenthesis in 

the SendCounter() or SendMeasurement() function 

call. 

The value reported is the number of times the counter 

was incremented during the last reporting interval. 

User-defined timer Timers that you can add to Agendas to keep track of the 

amount of time it takes to complete specific actions (see 

the WebLOAD Scripting Guide). If there are any timers in 

the Agendas that you are running, WebLOAD reports 

their values in the Statistics Report.  

The row heading is the name (argument) of the timer. 

That is, the row heading is the string in parenthesis in 

the SetTimer() function call. The timer represents the 

time it takes to complete all the actions between the 

SetTimer() call and its corresponding SendTimer() 

call, in seconds.  

The value posted is the average time it took a Virtual 

Client to complete the actions between the pair of timer 

calls, in seconds, during the last reporting interval. 
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User-defined Transaction 

counters 

Transaction functions that you can add to Agendas for 

functional tests (see the WebLOAD Scripting Guide). If 

there is a user-defined transaction function in the 

Agenda that you are running, WebLOAD reports three 

counters for it in the Statistics Report: 

 The total number of times the transaction occurred 

 The number of times a transaction succeeded 

 The number of times a transaction failed during the 

last reporting interval. 

The row heading is the name (argument) of the 

transaction. That is, the row heading is the string in 

parenthesis in the BeginTransaction() function call. 

User-defined Transactions timers A timer for user-defined transaction functions. If there is 

a user-defined transaction function in the Agenda that 

you are running, WebLOAD reports a timer for it in the 

Statistics Report. 

The row heading is the name (argument) of the user-

defined transaction. That is, the row heading is the 

string in parenthesis in the BeginTransaction() 

function call. 

The timer represents the average time it took to 

complete all the actions between the 

BeginTransaction() call and its corresponding 

EndTransaction() call, in seconds, during the last 

reporting interval. 

Virtual Client Artificial entities run by Load Generators. Each such 

entity is a perfect simulation of a real client accessing the 

System Under Test (SUT) through a Web browser. 

Virtual Clients generate HTTP calls that access the SUT. 

The Load Generators that run Virtual Clients can reside 

anywhere on the Internet or on your local intranet. 

Agendas are executed by all the Virtual Clients in 

parallel, achieving simultaneous access to the SUT. The 

size of the load on your SUT is determined by the 

number of Virtual Clients being generated. You may 

define as many Virtual Clients as needed, up to the 

maximum supported by your WebLOAD “package.” 

WebLOAD Analytics WebLOAD Analytics enables you to analyze data, and 

create custom, informative reports after running a 

WebLOAD test session. 

WebLOAD Console See Console. 
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WebLOAD Integrated 

Development Environment (IDE) 

An easy-to-use tool for recording, creating, and 

authoring protocol Agendas for the WebLOAD 

environment. 

WebLOAD Load Template See Load Template. 

WebLoad Session See Load Session. 

WebLOAD Wizard A WebLOAD Wizard that steps you through the 

configuration process. Each screen of the WebLOAD 

Wizard contains text explaining the configuration 

process. The WebLOAD Wizard enables you to create a 

basic Load Template. After using the demo, you can use 

the Console ribbon to add functionality not available 

through the WebLOAD Wizard. 

WebRM See Resource Manager. 
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